This document is provided to customers who have purchased SCIEX equipment to use in the operation of such SCIEX equipment. This document is copyright protected and any reproduction of this document or any part of this document is strictly prohibited, except as SCIEX may authorize in writing.

Software that may be described in this document is furnished under a license agreement. It is against the law to copy, modify, or distribute the software on any medium, except as specifically allowed in the license agreement. Furthermore, the license agreement may prohibit the software from being disassembled, reverse engineered, or decompiled for any purpose. Warranties are as stated therein.

Portions of this document may make reference to other manufacturers and/or their products, which may contain parts whose names are registered as trademarks and/or function as trademarks of their respective owners. Any such use is intended only to designate those manufacturers’ products as supplied by SCIEX for incorporation into its equipment and does not imply any right and/or license to use or permit others to use such manufacturers’ and/or their product names as trademarks.

SCIEX warranties are limited to those express warranties provided at the time of sale or license of its products and are SCIEX’s sole and exclusive representations, warranties, and obligations. SCIEX makes no other warranty of any kind whatsoever, expressed or implied, including without limitation, warranties of merchantability or fitness for a particular purpose, whether arising from a statute or otherwise in law or from a course of dealing or usage of trade, all of which are expressly disclaimed, and assumes no responsibility or contingent liability, including indirect or consequential damages, for any use by the purchaser or for any adverse circumstances arising therefrom.

For research use only. Not for use in diagnostic procedures.

AB Sciex is doing business as SCIEX.

The trademarks mentioned herein are the property of AB Sciex Pte. Ltd. or their respective owners.

AB SCIEX™ is being used under license.

© 2015 AB SCIEX
Contents

Chapter 1 Operational Precautions and Limitations...............................................................8
  General Safety Information.....................................................................................................8
  Regulatory Compliance...........................................................................................................8
    Australia and New Zealand..................................................................................................8
    Canada................................................................................................................................9
    Europe...............................................................................................................................9
    United States.....................................................................................................................9
    International....................................................................................................................10
  Electrical Precautions..........................................................................................................10
    AC Mains Supply...............................................................................................................10
    Protective Earth Conductor...............................................................................................11
  Chemical Precautions..........................................................................................................11
  System Safe Fluids...............................................................................................................12
  Ventilation Precautions.......................................................................................................13
  Environmental Precautions.................................................................................................14
    Decommissioning and Disposal..........................................................................................15
  Qualified Personnel.............................................................................................................15
  Equipment Use and Modification.......................................................................................16
  Contact Us..........................................................................................................................17
  Technical Support...............................................................................................................17
  Related Documentation.....................................................................................................17

Chapter 2 Hazard Symbols...................................................................................................18
  Occupational Health and Safety Symbols...........................................................................18
  Symbols, Indicators, and Labels: Packaging........................................................................20
  Symbols, Indicators, and Labels: Mass Spectrometer.........................................................22
  Documentation Symbols and Conventions.........................................................................23

Chapter 3 Principles of Operation......................................................................................24
  System Overview................................................................................................................24
    Hardware Overview...........................................................................................................25
    Theory of Operation—Hardware......................................................................................28
    Analyst Software Overview.............................................................................................30
    Theory of Operation—Analyst Software...........................................................................38

Chapter 4 Operating Instructions — Sample Workflows..................................................41

Chapter 5 Operating Instructions—Hardware ....................................................................44
  Start Up the System............................................................................................................44
  Reset the Mass Spectrometer.............................................................................................46
  Shut Down the System.......................................................................................................46
## Contents

Plumb the Mass Spectrometer ................................................................. 47  
Adjust the Integrated Syringe Pump Position ........................................... 47  
Plumb the Diverter Valve in Injector Mode ............................................. 50  
Plumb the Diverter Valve in Diverter Mode ............................................ 52

**Chapter 6 Operating Instructions — Hardware Profiles and Projects** ........................................ 54  
Hardware Profiles ................................................................................ 54  
Create a Hardware Profile ...................................................................... 54  
Add Devices to a Hardware Profile ....................................................... 58  
Troubleshoot Hardware Profile Activation ........................................... 59
Projects and Subprojects .................................................................... 60  
Create Projects and Subprojects ......................................................... 60  
Create Subprojects ............................................................................. 61  
Copy Subprojects ................................................................................ 61  
Switch Between Projects and Subprojects ......................................... 61  
Installed Project Folders ...................................................................... 62  
Back Up the API Instrument Folder ...................................................... 63  
Recover the API Instrument Folder ....................................................... 63

**Chapter 7 Operating Instructions — Tune and Calibrate** ........................................... 64  
Optimize the Mass Spectrometer ........................................................... 64  
About the Verifying or Adjusting Performance Dialog .......................... 65  
Results Summary ............................................................................. 65

**Chapter 8 Operating Instructions — Automatic Optimization** ........................................... 67  
About Automatic Optimization ............................................................... 67  
Types of Sample Introduction ................................................................ 68  
Automatically Optimize for an Analyte Using Infusion ....................... 68  
Confirm the Presence of Compounds .................................................... 68  
Perform Automatic MS and MS/MS Optimization Using Infusion with a  
Precursor Ion and an Unknown Product Ion ........................................ 71  
Check the Optimization Results ............................................................ 73  
Automatically Optimize for an Analyte Using FIA ............................... 74

**Chapter 9 Operating Instructions — Acquisition Methods** ............................................... 81  
Create an Acquisition Method Using the Acquisition Method Editor ...... 81  
Configure the Syringe Pump ................................................................. 82  
Add an Experiment ............................................................................... 82  
Add a Period ....................................................................................... 82  
Copy an Experiment into a Period ....................................................... 82  
Copy an Experiment within a Period .................................................... 83  
Scan Techniques .............................................................................. 83  
Quadrupole-Mode Scan Types ............................................................. 83  
LIT-Mode Scan Types ......................................................................... 84  
About Spectral Data Acquisition .......................................................... 85

**Chapter 10 Operating Instructions — Batches** ......................................................... 86  
Set Queue Options ............................................................................... 86  
Add Sets and Samples to a Batch ........................................................ 87  
Submit a Sample or Set of Samples ...................................................... 90  
Change Sample Order ....................................................................... 91
Chapter 11 Operating Instructions — Analyze and Process Quantitative Data

Quantitative Analysis
  Quantitation Methods
  About Results Tables
  Quantitation Methods and Results Tables
  Create a Method Using the Quantitation Method Editor
  Create a Results Table Using the Quantitation Wizard
  Create a Standard Query
  Results Table Right-click Menu
  Peak Review and Manual Integration of Peaks
    Review Peaks
    Manually Integrate Peaks
    Peak Review Right-Click Menu
  Calibration Curves
    View Calibration Curves
    Overlay Calibration Curves
    Calibration Curve Right-Click Menu
  Sample Statistics
    View the Statistics for Standards and QCs
    Compare Results Between Batches

Chapter 12 Operating Instructions — Analyze and Process Data

Open Data Files
  Navigate Between Samples in a Data File
  Show Experimental Conditions
  Show Data in Tables
  Show ADC Data
  Show Basic Quantitative Data
  Chromatograms
  Show TICs from a Spectrum
  Show a Spectrum from a TIC
  About Generating XICs
    Generate an XIC Using a Selected Range
    Generate an XIC Using the Maximum Peak
    Generate an XIC Using Base Peak Masses
Contents

Extract Ion by Selecting Masses...........................................................................................................................................125
Generate BPCs..........................................................................................................................................................................126
Generate XWCs..........................................................................................................................................................................127
Generate DAD Data.................................................................................................................................................................127
Generate TWCs..........................................................................................................................................................................128
Adjust the Threshold..............................................................................................................................................................128
Chromatogram Panes.............................................................................................................................................................129
Spectra Panes........................................................................................................................................................................130
Data Processing.....................................................................................................................................................................130
Graphs...................................................................................................................................................................................131
Manage Data........................................................................................................................................................................131
Zoom In on the Y-axis..........................................................................................................................................................133
Zoom In on the X-axis..........................................................................................................................................................133

Chapter 13 Reporter Software..............................................................................................................................................134
Reporter User Interface..........................................................................................................................................................135
Generate Reports.....................................................................................................................................................................137

Chapter 14 Service and Maintenance Information..............................................................................................................138
Recommended Maintenance Schedule.......................................................................................................................................138
Clean the Surfaces................................................................................................................................................................140
Clean the Front-End.............................................................................................................................................................140
Symptoms of Contamination................................................................................................................................................140
Required Materials.............................................................................................................................................................141
Best Practices...................................................................................................................................................................142
Prepare the Mass Spectrometer........................................................................................................................................143
Clean the Curtain Plate.......................................................................................................................................................144
Clean the Front of the Orifice Plate........................................................................................................................................145
Put the Mass Spectrometer Back in Service........................................................................................................................145
Empty the Source Exhaust Drain Bottle..................................................................................................................................145
Storage and Handling........................................................................................................................................................148

Chapter 15 Mass Spectrometer Troubleshooting................................................................................................................149

Appendix A Operating Instructions — Manual Optimization...................................................................................................150
About Manual Compound Optimization................................................................................................................................151
About Scan Types...............................................................................................................................................................151
Manually Optimize an Analyte...............................................................................................................................................151
  Confirm the Presence of Compounds................................................................................................................................152
  Optimize MS-Specific Parameters..................................................................................................................................153
  Determine the Product Ions for Optimization....................................................................................................................155
  Optimize Collision Cell Exit Potential for each Product Ion............................................................................................156
Manually Optimize the Ion Source and Gas Parameters.......................................................................................................157
  Prepare the Ion Source....................................................................................................................................................157
  Optimize the Ion Source Parameters................................................................................................................................157

Appendix B 6500 and 6500+ Series System Parameters ......................................................................................................159

Appendix C Calibration Ions and Solutions..........................................................................................................................163

Appendix D Toolbar Icons....................................................................................................................................................165
Contents

Revision History......................................................................................................................................173
Index........................................................................................................................................................174
Operational Precautions and Limitations

Note: Before operating the system, carefully read all the sections of this guide.

This section contains general safety-related information and provides regulatory compliance information. It also describes potential hazards and associated warnings for the system and the precautions that should be taken to minimize the hazards.

In addition to this section, refer to Hazard Symbols on page 18 for information about the symbols and conventions used in the laboratory environment, on the system, and in this documentation. Refer to the Site Planning Guide for site requirements, including AC mains supply, source exhaust, ventilation, compressed air, nitrogen, and roughing pump requirements.

General Safety Information

To prevent personal injury or system damage, read, understand, and obey all of the safety precautions, warnings in this document, and labels on the mass spectrometer. These labels are shown with internationally recognized symbols. Failure to heed these warnings could result in serious injury.

This safety information is intended to supplement federal, state, provincial, and local environmental health and safety (EHS) regulations. The information provided covers system-related safety with regard to the operation of the mass spectrometer. It does not cover every safety procedure that should be practised. Ultimately, the user and the organization are responsible for compliance with federal, state, provincial, and local EHS regulations and for maintaining a safe laboratory environment.

Refer to the appropriate laboratory reference material and standard operating procedures.

Regulatory Compliance

This system complies with the regulations and standards listed in this section. Refer to the Declaration of Conformity included with the system and the individual system components for dated references. Applicable labels have been affixed to the system.

Australia and New Zealand

- Electromagnetic Compatibility (EMC): Radio Communications Act 1992 as implemented in these standards:
  - Electromagnetic Interference—AS/NZS CISPR 11/ EN 55011/ CISPR 11 (Class A)
• **Safety**: AS/NZ 61010-1 and IEC 61010-2-061

**Canada**

• **Electromagnetic Interference (EMI)**: CAN/CSAA CISPR11. This ISM device complies with Canadian ICES-001.

• **Safety**: CAN/CSA C22.2 No. 61010-1 and CAN/CSA C22.2 No 61010-2-061

**Europe**

• **Electromagnetic Compatibility (EMC)**: Electromagnetic Compatibility directive 2004/108/EC as implemented in these standards:
  • EN 61326-1
  • EN 55011 (Class A)

• **Safety**: Low Voltage Directives 2006/95/EC as implemented in these standards:
  • EN 61010-1
  • EN 61010-2-061

• **Waste Electrical and Electronic Equipment (WEEE)**: Waste Electrical and Electronic Equipment 2012/96/EEC, as implemented in EN 40519

• **Packaging and Packaging Waste (PPW)**: Packaging and Packaging Waste Directive 94/62/EC

**United States**

• **Radio Emissions Interference Regulations**: 47 CFR 15 as implemented in this standard: FCC Part 15 (Class A)

• **Safety**: Occupational Safety and Health Regulations, 29 CFR 1910, as implemented by the following standards:
  • UL 61010-1
  • IEC 61010-2-061
International

• Electromagnetic Compatibility (EMC):
  • IEC 61326-1
  • IEC CISPR 11 (Class A)
  • IEC 61000-3-2
  • IEC 61000-3-3

• Safety:
  • IEC 61010-1
  • IEC 61010-2-061

Electrical Precautions

WARNING! Electrical Shock Hazard. Do not remove the covers. Removing the covers might cause injury or malfunctioning of the system. The covers need not be removed for routine maintenance, inspection, or adjustment. Contact the SCIEX FSE for repairs that require the covers to be removed.

For information on system electrical specifications, refer to the Site Planning Guide.

AC Mains Supply

WARNING! Electrical Shock Hazard. Use only qualified personnel for the installation of all electrical supplies and fixtures, and make sure that all installations adhere to local regulations and safety standards.

WARNING! Electrical Shock Hazard. Make sure that the system can be disconnected from the AC mains supply outlet in an emergency. Do not block the AC mains supply outlet.

CAUTION: Potential System Damage. Do not unpack the mass spectrometer crate or computer boxes. The FSE will unpack and help move the mass spectrometer at the time of the installation.

An external line transformer is not needed for the mass spectrometer, optional bench, or roughing pump. Connect the system to a compatible AC mains supply as instructed in this guide.
Protective Earth Conductor

The mains supply must include a correctly installed protective earth conductor. The protective earth conductor must be installed or checked by a qualified electrician before the system is connected.

**WARNING!** Electrical Shock Hazard. Do not intentionally interrupt the protective earth conductor. Any interruption of the protective earth conductor will create an electrical shock hazard.

**WARNING!** Electrical Shock Hazard: Make sure that a protective earth (grounding cable) is connected between the sample loop and an appropriate grounding point at the mass spectrometer ion source. This supplementary grounding will reinforce the safety configuration specified by SCIEX.

Chemical Precautions

**WARNING!** Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Determine whether mass spectrometer decontamination is required prior to cleaning or maintenance. The customer must decontaminate the system prior to cleaning or maintenance if radioactive materials, biological agents, or toxic chemicals have been used with a mass spectrometer.

**WARNING!** Environmental Hazard. Do not dispose of system components in municipal waste. Follow local regulations when disposing of components.

**WARNING!** Biohazard, Toxic Chemical Hazard. Connect the drain tubing to the mass spectrometer and the source exhaust drain bottle properly, to prevent leaks.

**CAUTION: Potential System Damage.** Do not submerge the end of the drain tubing in the waste liquid in the waste container.

- Determine which chemicals have been used in the system prior to service and regular maintenance. Refer to Safety Data Sheets for the health and safety precautions that must be followed with chemicals.
- Work in a well-ventilated area.
Operational Precautions and Limitations

- Always wear assigned personal protective equipment, including powder-free neoprene or nitrile gloves, safety glasses, and a laboratory coat.
- Follow required electrical safe work practices.
- Avoid ignition sources when working with flammable materials, such as isopropanol, methanol, and other flammable solvents.
- Take care in the use and disposal of any chemicals. Potential risk of personal injury if proper procedures for handling and disposing of chemicals are not followed.
- Avoid skin contact with chemicals during cleaning, and wash hands after use.
- Comply with all local regulations for the storage, handling, and disposal of biohazardous, toxic, or radioactive materials.
- (Recommended) Use secondary containment trays beneath the roughing pump, the solvent bottles, and the waste collection container to capture potential chemical spills.

System Safe Fluids

The following fluids can safely be used with the system. Refer to Required Materials on page 141 for information about safe cleaning solutions.

**CAUTION: Potential System Damage. Do not use any other fluid until confirmation is received from SCIEX that it will not present a hazard. This is not an exhaustive list.**

- **Organic Solvents**
  - MS-grade acetonitrile; up to 100%
  - MS-grade methanol; up to 100%
  - Isopropanol; up to 100%
  - HPLC-grade or higher water; up to 100%
  - Tetrahydrofuran; up to 100%
  - Toluene and other aromatic solvents; up to 100%
  - Hexanes; up to 100%

- **Buffers**
  - Ammonium Acetate; less than 1%
  - Ammonium Formate; less than 1%
  - Phosphate; less than 1%
• Acids and Bases
  • Formic Acid; less than 1%
  • Acetic Acid; less than 1%
  • Trifluoroacetic Acid; (TFA) less than 1%
  • Heptafluorobutyric Acid; (HFBA) less than 1%
  • Ammonia/Ammonium Hydroxide; less than 1%
  • Phosphoric Acid; less than 1%
  • Trimethylamine; less than 1%
  • Triethylamine; less than 1%

Ventilation Precautions

The venting of fumes and disposal of waste must comply with all federal, state, provincial, and local health and safety regulations. Use the system indoors in a laboratory that complies with the environmental conditions recommended in the Site Planning Guide for the system.

The mass spectrometer ion source exhaust system and roughing pump must be vented to a dedicated laboratory fume hood or an external exhaust system, as recommended in the Site Planning Guide.

WARNING! Fire Hazard. Make sure that the source exhaust system is connected and functioning to prevent flammable vapor from accumulating in the ion source.

WARNING! Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Take care to vent exhaust gases to a dedicated laboratory fume hood or exhaust system, and make sure that the vent tubing is secured with clamps.

WARNING! Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Be sure to use the system in a well-ventilated laboratory environment in compliance with local regulations and with appropriate air exchange for the work performed.
WARNING! Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Do not operate the mass spectrometer if the source exhaust drain and roughing pump exhaust hoses are not properly connected to the laboratory ventilation system. Perform a regular check of the exhaust tubing to make sure that there are no leaks. The use of mass spectrometers without proper system ventilation might constitute a health hazard, and might result in serious injury.

WARNING! Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Use the ion source only if you have knowledge of and training in the proper use, containment, and evacuation of toxic or injurious materials used with the ion source.

WARNING! Puncture Hazard, Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Discontinue use of the ion source if the ion source window is cracked or broken and contact an SCIEX Field Service Employee. Any toxic or injurious materials introduced into the equipment will be present in the ion source and exhaust output. Dispose of sharps following established laboratory safety procedures.

Environmental Precautions

Use qualified personnel for the installation of electrical mains, heating, ventilation, and plumbing supplies and fixtures. Make sure that all the installations comply with local bylaws and biohazard regulations. For more information about the required environmental conditions for the system, refer to the Site Planning Guide.

DANGER! Explosion Hazard. Do not operate the system in an environment containing explosive gases. The system is not designed for operation in an explosive environment.

WARNING! Biohazard. For biohazardous material use, always comply with local regulations for hazard assessment, control, and handling. This system or any part is not intended to act as a biological containment.

CAUTION: Potential Mass Shift. Maintain a stable ambient temperature. If the temperature changes by more than 2 °C, then the resolution and mass calibration might be affected.

CAUTION: Potential System Damage. Avoid exposure to corrosive gas and excessive dust.
Electromagnetic Environment

Electromagnetic Compatibility

Basic Electromagnetic Environment: Environment existing at locations characterized by being supplied directly at low voltage from the public mains network.

Performance Criteria A (Criteria A): Equipment shall operate as intended with no degradation of performance and no loss of function during or after test.

Performance Criteria B (Criteria B): Equipment may experience loss of function (one or more) during test but shall operate as intended with some degradation of performance and functions self-recoverable after test.

Performance Criteria C (Criteria C): Equipment may experience loss of function (one or more) during test but shall operate as intended with some degradation of performance and functions recoverable by operator after test.

The equipment is intended for use in a basic electromagnetic environment.

The expected performance loss under the electromagnetic immunity conditions is less than 60% change in total ion count (TIC).

Make sure that a compatible electromagnetic environment for the equipment can be maintained so that the device will perform as intended.

Electromagnetic Interference

Class A Equipment: Equipment which is suitable for use in all establishments other than domestic and those directly connected to a low voltage power supply network which supplies buildings used for domestic purposes. [Derived from CISPR 11:2009, 5.3] Class A equipment shall meet Class A limits.

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC (Federal Communications Commission) Compliance Rules.

These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the operator’s manual, can cause harmful interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful interference in which case you will be required to correct the interference, at your own expense. Changes or modifications not expressly approved by the manufacturer could void your authority to operate the equipment.

Decommissioning and Disposal

Before decommissioning, decontaminate the system following local regulations.

When removing the system from service, separate and recycle different materials according to national and local environmental regulations.
Operational Precautions and Limitations

Do not dispose of system components or subassemblies, including computer parts, as unsorted municipal waste.

Note: SCIEX will not accept any system returns without a completed Decontamination Form. Contact an FSE to obtain a copy of the form.

Qualified Personnel

Only qualified SCIEX personnel shall install and service the equipment. After installing the system, the Field Service Employee (FSE) uses the Customer Familiarization Checklist to orient the customer on system operation, cleaning, and basic maintenance.

Only personnel qualified by the manufacturer shall maintain the equipment. A laboratory designate can be familiarized with the Qualified Maintenance Person (QMP) procedures during the installation.

Equipment Use and Modification

WARNING! Personal Injury Hazard. Contact the SCIEX representative if product installation, adjustment, or relocation is required.

WARNING! Electrical Shock Hazard. Do not remove the covers. Removing the covers might cause injury or malfunctioning of the system. The covers need not be removed for routine maintenance, inspection, or adjustment. Contact the SCIEX FSE for repairs that require the covers to be removed.

WARNING! Personal Injury Hazard. Use SCIEX-recommended parts only. Use of parts not recommended by SCIEX or use of parts for any use other than their intended purpose can place the user at risk of harm or negatively impact system performance.

Use the system indoors in a laboratory that complies with the environmental conditions recommended in the Site Planning Guide.

If the system is used in an environment or in a manner not prescribed by the manufacturer, then the protection provided by the equipment might be impaired.

Unauthorized modification or operation of the system might cause personal injury and equipment damage, and might void the warranty. Erroneous data might be generated if the system is operated either above or below the recommended environmental conditions or operated with unauthorized modifications. Contact an FSE for information on servicing the system.
Contact Us

SCIEX Support
- sciex.com/contact-us
- sciex.com/support/request-support

Customer Training
- In North America: NA.CustomerTraining@sciex.com
- In Europe: Europe.CustomerTraining@sciex.com
- Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center
- sciex.com/LearningPortal

Technical Support

SCIEX and its representatives maintain a staff of fully-trained service and technical specialists located throughout the world. They can answer questions about the system or any technical issues that might arise. For more information, visit the SCIEX Web site at sciex.com.

Related Documentation

The guides and tutorials for the Analyst® software are installed automatically with the software and are available from the Start menu: All Programs > SCIEX > Analyst. A complete list of the available documentation can be found in the Help. To view the Help, press F1.

Documentation for the mass spectrometer can be found on the Customer Reference DVD for the mass spectrometer.

Documentation for the ion source can be found on the Customer Reference DVD for the ion source.
This section lists the hazard symbols and conventions used in the laboratory environment, on the system, and in the documentation.

**Occupational Health and Safety Symbols**

This section describes some occupational health and safety symbols found in the documentation and laboratory environment.

**Table 2-1 General Hazard Symbols**

<table>
<thead>
<tr>
<th>Safety Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>Personal Injury Hazard</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Lifting Hazard</td>
</tr>
</tbody>
</table>

**Table 2-2 Chemical Hazard Symbols**

<table>
<thead>
<tr>
<th>Safety Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>Biohazard</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Explosion Hazard</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Toxic Chemical Hazard</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Fire Hazard</td>
</tr>
</tbody>
</table>
### Table 2-3 Electrical Hazard Warning Symbols

<table>
<thead>
<tr>
<th>Safety Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Electrical Shock Hazard</td>
</tr>
</tbody>
</table>

### Table 2-4 Pressurized Gas Hazard Warning Symbols

<table>
<thead>
<tr>
<th>Safety Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pressurized Gas Hazard</td>
</tr>
</tbody>
</table>

### Table 2-5 Mechanical Hazard Symbols

<table>
<thead>
<tr>
<th>Safety Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Hot Surface Hazard" /></td>
<td>Hot Surface Hazard</td>
</tr>
<tr>
<td><img src="image" alt="Puncture Hazard" /></td>
<td>Puncture Hazard</td>
</tr>
</tbody>
</table>

### Table 2-6 Radiation Hazard Symbols

<table>
<thead>
<tr>
<th>Safety Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Ionizing Radiation Hazard" /></td>
<td>Ionizing Radiation Hazard</td>
</tr>
<tr>
<td><img src="image" alt="Laser Radiation Hazard" /></td>
<td>Laser Radiation Hazard</td>
</tr>
</tbody>
</table>
## Symbols, Indicators, and Labels: Packaging

### Table 2-7 Labels on the Mass Spectrometer Shipping Materials

<table>
<thead>
<tr>
<th>Label/Symbol</th>
<th>Definition</th>
</tr>
</thead>
</table>
| ![Tilt Indicator](image1.png) | Tilt Indicator  
Indicates whether the container was tipped or mishandled.  
Write on the Bill of Lading and inspect for damage. Any claims for tipping require a notation. |
| ![Tilt Indicator](image2.png) | or |

or
### Table 2-7 Labels on the Mass Spectrometer Shipping Materials (continued)

<table>
<thead>
<tr>
<th>Label/Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Keep upright" /></td>
<td>Keep upright.</td>
</tr>
</tbody>
</table>
| ![Impact Indicator](image) | Impact Indicator  
If the indicator is tripped, then this container has been dropped or otherwise mishandled.  
Make a note on the bill of lading and then check for damage. Any claims for shock damage require a notation. |
| ![Fragile](image) | Fragile |

**IMPORTANT!**  
**RECORD ANY VISIBLE CRATE DAMAGE INCLUDING TRIPPED "IMPACT INDICATOR" OR "TILT INDICATOR" ON THE WAYBILL BEFORE ACCEPTING SHIPMENT AND NOTIFY YOUR LOCAL SCIEX CUSTOMER SUPPORT ENGINEER IMMEDIATELY.**  
**DO NOT UNCRATE. CONTACT YOUR LOCAL CUSTOMER SUPPORT ENGINEER FOR UNCRATING AND INSTALLATION."**
## Symbols, Indicators, and Labels: Mass Spectrometer

Refer to [Panel Symbols on page 25](#) for more information.

### Table 2-8 Labels on the Mass Spectrometer

<table>
<thead>
<tr>
<th>Label</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Label Image]</td>
<td>WARNING: No user serviceable parts inside. Refer servicing to qualified personnel. Consult instructions for use.</td>
</tr>
<tr>
<td>![Label Image]</td>
<td>Do not dispose of equipment as unsorted municipal waste (WEEE).</td>
</tr>
<tr>
<td>![Label Image]</td>
<td>WARNING: Lifting Hazard. Six persons required to lift this equipment.</td>
</tr>
<tr>
<td>![Label Image]</td>
<td>WARNING: Hot Surface Hazard.</td>
</tr>
<tr>
<td>![Label Image]</td>
<td>Consult instructions for use.</td>
</tr>
<tr>
<td>![Label Image]</td>
<td>Protective Earth (ground)</td>
</tr>
<tr>
<td>![Label Image]</td>
<td>Alternating Current</td>
</tr>
<tr>
<td>![Label Image]</td>
<td>Amperes (current)</td>
</tr>
<tr>
<td>![Label Image]</td>
<td>Volts (voltage)</td>
</tr>
</tbody>
</table>
Table 2-8 Labels on the Mass Spectrometer (continued)

<table>
<thead>
<tr>
<th>Label</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>VA</td>
<td>Volt Ampere (power)</td>
</tr>
</tbody>
</table>

[Image: WARNING: Do not operate without first ensuring bottle cap is secured. This warning appears on the source exhaust waste bottle.]

Documentation Symbols and Conventions

The following symbols and conventions are used throughout the guide.

- **DANGER!** Danger signifies an action which leads to severe injury or death.
- **WARNING!** Warning signifies an action that could cause personal injury if precautions are not followed.
- **CAUTION:** Caution signifies an operation that could cause damage to the system or corruption or loss of data if precautions are not followed.

**Note:** Note emphasizes significant information in a procedure or description.

**Tip!** Tip provides useful information that helps apply the techniques and procedures in the text for a specific need and provides shortcuts, but is not essential to the completion of a procedure.
The 6500 or 6500+ system is designed for the qualitative and quantitative analysis of chemical species.

This section includes information about the mass spectrometer and the Analyst® software. Refer to the ion source Operator Guide for an overview of the ion source.

### System Overview

This system is intended for the qualitative and quantitative analysis of chemical species.

The system includes the following components:

- A SCIEX Triple Quad™ 6500 or 6500+ or a QTRAP® 6500 or 6500+ mass spectrometer with two roughing pumps and a source of compressed air and nitrogen

- An IonDrive™ Turbo V ion source that uses either the TurbolonSpray® probe or the Atmospheric Pressure Chemical Ionization (APCI) probe. Refer to the IonDrive™ Turbo V Ion Source Operator Guide.

- A SCIEX-supplied computer and monitor with the Analyst® software for instrument optimization, acquisition method development, and data acquisition and processing. For computer specifications and requirements, refer to the Software Installation Guide for the Analyst® software.
Hardware Overview

Figure 3-1 Front View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Refer to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Panel symbols</td>
<td>Panel Symbols on page 25</td>
</tr>
<tr>
<td>2</td>
<td>Syringe pump</td>
<td>Adjust the Integrated Syringe Pump Position on page 47</td>
</tr>
<tr>
<td>3</td>
<td>Ion source</td>
<td>IonDrive™ Turbo V Ion Source Operator Guide, available from the ion source documentation CD, or from the SCIEX Web site, at sciex.com</td>
</tr>
<tr>
<td>4</td>
<td>Diverter valve</td>
<td>Plumb the Diverter Valve in Diverter Mode on page 52.</td>
</tr>
</tbody>
</table>

Panel Symbols

*Table 3-1* describes the mass spectrometer status LEDs.
Principles of Operation

Table 3-1 Panel Symbols

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Power LED" /></td>
<td>Green</td>
<td>Power</td>
<td>Lit when the system is powered up.</td>
</tr>
<tr>
<td><img src="image" alt="Vacuum LED" /></td>
<td>Green</td>
<td>Vacuum</td>
<td>Lit when the correct vacuum has been achieved. Flashing if the vacuum is not at the correct vacuum (during pump down and venting).</td>
</tr>
<tr>
<td><img src="image" alt="Ready LED" /></td>
<td>Green</td>
<td>Ready</td>
<td>Lit when the system is in the Ready state. The system must be in the Ready state to operate.</td>
</tr>
<tr>
<td><img src="image" alt="Scanning LED" /></td>
<td>Blue</td>
<td>Scanning</td>
<td>Flashing when the system is acquiring data.</td>
</tr>
<tr>
<td><img src="image" alt="Fault LED" /></td>
<td>Red</td>
<td>Fault</td>
<td>Lit when the system encounters a system fault.</td>
</tr>
</tbody>
</table>

After the system is turned on, all of the LEDs illuminate. The power LED remains lit. The other LEDs flash for two seconds and then turn off. The vacuum LED starts flashing. After the correct vacuum has been achieved this LED remains lit.

Connections

*Figure 3-2* shows the location of the mass spectrometer connections, including the locations of the **RESET** and **VENT** buttons and the mass spectrometer convenience switch.
**Figure 3-2 Back and Side Views**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Primary Materials</th>
<th>For more information...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Roughing pump vacuum connection</td>
<td>Aluminum (hose fitting), zinc-plated steel (hose clamp)</td>
<td>Contact an FSE.</td>
</tr>
<tr>
<td>2</td>
<td>Nitrogen gas supply (Curtain Gas™ supply, CAD gas)</td>
<td>Plastic</td>
<td>Refer to the <em>Site Planning Guide</em>.</td>
</tr>
<tr>
<td>3</td>
<td>Source exhaust supply</td>
<td>Stainless steel</td>
<td>Refer to the <em>Site Planning Guide</em>.</td>
</tr>
<tr>
<td>4</td>
<td>Source communication connection</td>
<td>Aluminum</td>
<td>Contact an FSE.</td>
</tr>
<tr>
<td>5</td>
<td><strong>RESET</strong> button</td>
<td>Plastic</td>
<td>Refer to <em>Reset the Mass Spectrometer on page 46</em>.</td>
</tr>
</tbody>
</table>
### Theory of Operation—Hardware

Mass spectrometry measures the mass-to-charge ratio of ions to identify unknown compounds, to quantify known compounds, and to provide information about the structural and chemical properties of molecules.

The mass spectrometer has a series of quadrupole filters that transmit ions according to their mass-to-charge \((m/z)\) ratio. The first quadrupole in this series is the IonDrive™ QJet ion guide located between the orifice plate and the Q0 region. The IonDrive™ QJet ion guide does not filter ions, but focuses them before they enter the Q0 region. By prefocusing the larger ion flux created by the wider orifice, the IonDrive™ QJet ion guide increases system sensitivity and improves the signal-to-noise ratio. In the Q0 region, the ions are again focused before passing into the Q1 quadrupole.
The Q1 quadrupole is a filtering quadrupole that sorts the ions before they enter the Q2 collision cell. The Q2 collision cell is where the internal energy of an ion is increased through collisions with gas molecules to the point that molecular bonds break creating product ions. This technique allows users to design experiments that measure the \( m/z \) of product ions to determine the composition of the parent ions.

After passing through the Q2 collision cell, the ions enter the Q3 quadrupole for additional filtering, and then enter the detector. In the detector, the ions create a current that is converted into a voltage pulse. The voltage pulses leaving the detector are directly proportional to the quantity of ions entering the detector. The system monitors these voltage pulses and converts the information into a signal. The signal represents the ion intensity for a particular \( m/z \) value and the system shows this information as a mass spectrum.

The QTRAP® system linear ion trap (LIT) functionality provides a number of enhanced modes of operation. A common factor of the enhanced modes is that ions are trapped in the Q3 quadrupole region and then scanned out to produce full spectrum data. Many spectra are rapidly collected in a short period of time and are significantly more intense than spectra collected in a comparable standard quadrupole mode of operation.
Principles of Operation

During the collection phase, ions pass through the Q2 collision cell where the CAD gas focuses the ions into the Q3 region. The Q3 quadrupole is operated with only the main RF voltage applied. Ions are prevented from passing through the Q3 quadrupole rod set and are reflected back by an exit lens to which a DC barrier voltage is applied. After the fill time elapses (a time defined by the user, or determined by the Dynamic Fill Time feature), a DC barrier voltage is applied to a Q3 entrance lens (IQ3). This confines the collected ions in Q3 and stops additional ions from entering. The entrance and exit lens DC voltage barriers and the RF voltage applied to the quadrupole rods confine the ions within Q3.

During the scan out phase, the voltage on the exit lens and the auxiliary RF voltage are ramped simultaneously with the main RF voltage for increased resolution and sensitivity as compared to quadrupole scan modes. An auxiliary AC frequency is applied to the Q3 quadrupole. The main RF voltage amplitude is ramped from low to high values, which sequentially brings masses into resonance with the auxiliary AC frequency. When ions are brought into resonance with the AC frequency, they acquire enough axial velocity to overcome the exit lens barrier and are axially ejected towards the mass spectrometer ion detector. Full spectra data can be acquired from the ions collected in Q3 by rapidly scanning the main RF voltage.

Data Handling

The Analyst® software requires a computer running the Windows 7 (32- or 64-bit) operating system. The computer and the associated system software work with the system controller and the associated firmware to control the system and data acquisition. During system operation, the acquired data is sent to the Analyst® software where it can be shown as either full mass spectra, intensity of single or multiple ions over time, or total ion current over time.

Analyst® Software Overview

The Analyst® software works with the mass spectrometer and the liquid chromatography (LC) system and the associated firmware to control the system and data acquisition. During system operation, the acquired data is sent to the Analyst® software where it can be shown as full mass spectra, intensity of single or multiple ions over time, or total ion count over time.

Different Data Views

The following figures show examples of two types of data views: total ion chromatogram (TIC) and extracted ion chromatogram (XIC).

Total Ion Chromatogram (TIC): The plot of the total ion current as a function of time.
**Extracted Ion Chromatogram (XIC):** An ion chromatogram created by taking intensity values at a single, discrete mass value or a mass range, from a series of mass spectral scans. It indicates the behavior of a given mass or mass range as a function of time.

**Spectra:** The distribution characteristic of a physical system or phenomenon.
Parameters

The working parameters are the set of instrument parameters currently being used.

- **Source and gas parameters**: (Ion source-dependent) These parameters can change depending on the ion source used.
- **Compound parameters**: These parameters consist mostly of voltages in the ion path. Optimal values for compound-dependent parameters vary depending on the compound being analyzed.
- **Resolution parameters**: These parameters affect the resolution and calibration.
- **Detector parameters**: These parameters affect the detector.

The following figure shows the location of the parameters on the ion optics path.
Figure 3-6 Ion Optics Path and Parameters

<table>
<thead>
<tr>
<th>Location</th>
<th>Parameter Type</th>
<th>Parameter</th>
<th>Use</th>
<th>Scan Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Source and gas</td>
<td>IonSpray Voltage (IS)</td>
<td>The IS parameter controls the voltage applied to the electrode in the TurbolonSpray® probe that ionizes the sample in the ion source. The parameter depends on the polarity and it affects the spray stability and the sensitivity. This parameter is also used with the NanoSpray® and PhotoSpray® ion sources. Refer to the applicable ion source Operator Guide. The parameter can be compound-dependent and should be optimized for each compound.</td>
<td>All</td>
</tr>
<tr>
<td>1</td>
<td>Source and gas</td>
<td>Nebulizer Current (NC)</td>
<td>The NC parameter controls the current applied to the corona discharge needle in the APCI probe, used in the Turbo V™ or DuoSpray™ ion source. The discharge ionizes solvent molecules, which in turn ionize the sample molecules.</td>
<td>All</td>
</tr>
</tbody>
</table>
### Parameters and Their Uses

<table>
<thead>
<tr>
<th>Location</th>
<th>Parameter Type</th>
<th>Use</th>
<th>Scan Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Interface Heater Temperature (IHT)</td>
<td>The IHT parameter controls the temperature of the NanoSpray® interface heater and is only available if the NanoSpray® ion source is installed. The optimal heater temperature depends on the type of sample being analyzed and the solvent used. If the heater temperature is too high, the signal degrades. Typically, heater temperatures are in the 130 °C to 180 °C range. The maximum heater temperature that can be set is 250 °C, but this is too high for most applications.</td>
<td>All</td>
</tr>
<tr>
<td>1</td>
<td>Ion Source Gas 1 (GS 1)</td>
<td>For the Turbo V™ ion source and the IonDrive™ Turbo V ion source, the GS1 parameter controls the nebulizer gas for both the TurbolonSpray® and APCI probes.</td>
<td>All</td>
</tr>
<tr>
<td>1</td>
<td>Ion Source Gas 2 (GS 2)</td>
<td>For the Turbo V™ ion source and the IonDrive™ Turbo V ion source, the GS2 parameter controls the heater gas for the TurbolonSpray® probe.</td>
<td>All</td>
</tr>
<tr>
<td>1</td>
<td>Temperature (TEM)</td>
<td>The TEM parameter controls the temperature of the heater gas for the TurbolonSpray® probe or the temperature of the APCI probe.</td>
<td>All</td>
</tr>
<tr>
<td>1</td>
<td>Curtain Gas (CUR)</td>
<td>The CUR parameter controls the gas flow of the Curtain Gas™ interface. The Curtain Gas™ interface is located between the curtain plate and the orifice. It prevents the contamination of the ion optics.</td>
<td>All</td>
</tr>
<tr>
<td>1</td>
<td>sdip</td>
<td>The sdip parameter controls the selection of the DuoSpray™ ion source probes: TurbolonSpray® or APCI probe.</td>
<td>n/a</td>
</tr>
<tr>
<td>Location</td>
<td>Parameter</td>
<td>Parameter Type</td>
<td>Use</td>
</tr>
<tr>
<td>----------</td>
<td>---------------------------------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>1</td>
<td>Declustering Potential (DP)</td>
<td>Compound</td>
<td>The DP parameter controls the voltage on the orifice, which controls the ability to decluster ions between the orifice and the IonDrive™ QJet ion guide. It is used to minimize the solvent clusters that might remain on the sample ions after they enter the vacuum chamber, and, if required, to fragment ions. The higher the voltage, the higher the energy imparted to the ions. If the DP parameter is too high, unwanted fragmentation might occur. Use the preset value and optimize for the compound.</td>
</tr>
<tr>
<td>2</td>
<td>Entrance Potential (EP)</td>
<td>Compound</td>
<td>The EP parameter controls the potential difference between the voltage on Q0 and ground. The entrance potential guides and focuses the ions through the high-pressure on the Q0 region. Use the preset value.</td>
</tr>
<tr>
<td>2</td>
<td>Q0 Trapping</td>
<td>Compound</td>
<td>The Q0 trapping parameter controls the storage of ions in the Q0 region. It is used to increase sensitivity and duty cycle by trapping ions in the Q0 region while ions are being mass-selectively ejected from the linear ion trap. Use fixed fill time with this parameter. Either select or clear the feature as required by the experiment. The recommended fixed fill time to use with Q0 trapping is 20 ms or greater.</td>
</tr>
</tbody>
</table>
## Principles of Operation

<table>
<thead>
<tr>
<th>Location</th>
<th>Parameter</th>
<th>Parameter Type</th>
<th>Use</th>
<th>Scan Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>CAD Gas</td>
<td>Source and gas</td>
<td>The CAD parameter controls the pressure of the CAD gas in the collision cell during Q3, MS/MS, and LIT scans. For Q3 scans, the collision gas helps to focus the ions as they pass through the Q2 collision cell. The preset value for the CAD parameter is in fixed mode. For MS/MS scan types, the CAD gas helps to fragment the precursor ions. When the precursor ions collide with the collision gas, they dissociate to form product ions. For LIT scan types, the collision gas helps to focus and trap ions in the linear ion trap. Use the preset value and optimize for the compound.</td>
<td>Q3 MI, Q3 MS, MRM, Prec, NL, EMS, ER, EPI, MS/MS/MS, EMC, and TDF</td>
</tr>
<tr>
<td>3</td>
<td>Collision Energy (CE)</td>
<td>Compound</td>
<td>The CE parameter controls the potential difference between the Q0 region and the Q2 collision cell. It is used only in MS/MS scan types. This parameter is the amount of energy that the precursor ions receive as they are accelerated into the Q2 collision cell, where they collide with gas molecules and fragment. Use the preset value and optimize for the compound.</td>
<td>EPI, MS/MS/MS, MRM, MS2, Prec, NL</td>
</tr>
<tr>
<td>3</td>
<td>Collision Energy Spread (CES)</td>
<td>Compound</td>
<td>The CES parameter, in conjunction with the CE parameter, determines which three discreet collision energies are applied to the precursor mass in an Enhanced Product Ion (EPI) or MS/MS/MS (MS3) scan when CES is used. When a collision energy spread value is entered, CES is automatically turned on. Use the preset value and optimize for the compound.</td>
<td>EPI and MS/MS/MS</td>
</tr>
<tr>
<td>Location</td>
<td>Parameter Type</td>
<td>Use</td>
<td>Scan Type</td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td>----------------</td>
<td>-----</td>
<td>-----------</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Collision Cell Exit Potential (CXP)</td>
<td>The CXP parameter is only used in Q3 and MS/MS scan types. This parameter transmits the ions into the Q3 quadrupole. Use the preset value and optimize for the compound.</td>
<td>Q3, MRM, MS2, Prec, and NL</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Q3 Entry Barrier</td>
<td>The Q3 Entry Barrier parameter is used to transfer the ions from the Q2 collision cell into the linear ion trap. Use the preset value.</td>
<td>EMS, EMC, EPI, ER, and MS/MS/MS</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Q3 Empty Time</td>
<td>The Q3 Empty Time parameter controls the amount of time that elapses before singly-charged ions are removed from the linear ion trap. Use the preset value.</td>
<td>EMC</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Multi-Charge Separation (MCS) Barrier</td>
<td>The MCS Barrier parameter controls the voltage used to eliminate the singly-charged ions from the linear ion trap. Use the preset value.</td>
<td>EMC</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>MS/MS/MS Fragmentation Time</td>
<td>The MS/MS/MS Fragmentation Time parameter controls the amount of time that the excitation energy is applied. It is used in combination with the excitation energy to fragment the isolated second precursor ion. Use the preset value.</td>
<td>MS/MS/MS</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Fixed LIT Fill Time</td>
<td>The Fixed LIT Fill Time parameter controls the amount of time that the LIT fills with ions. Use the preset value and adjust it to achieve the desired signal response based on sample concentration.</td>
<td>EMS, EPI, ER, and MS/MS/MS</td>
<td></td>
</tr>
</tbody>
</table>
Principles of Operation

<table>
<thead>
<tr>
<th>Location</th>
<th>Parameter</th>
<th>Parameter Type</th>
<th>Use</th>
<th>Scan Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Dynamic Fill Time (DFT)</td>
<td>Compound</td>
<td>The DFT parameter dynamically calculates the amount of time that ions are collected in the linear ion trap based on the incoming ion signal. When DFT is turned on, the signal is optimized to either increase sensitivity or minimize space-charging. Either select or clear the feature based on the experiment. In the Tools &gt; Settings &gt; Method Options dialog, the DFT settings are optimized for the 10 000 Da/s scan speed. These settings are also suitable for other LIT scan speeds.</td>
<td>EMS, EPI, ER, and MS/MS/MS</td>
</tr>
<tr>
<td>7</td>
<td>CEM (CEM)</td>
<td>Detector</td>
<td>The CEM parameter controls the voltage applied to the detector. The voltage controls the detector response.</td>
<td>All</td>
</tr>
</tbody>
</table>

Theory of Operation—Analyst® Software

Quantitation

The goal of quantitation in LC-MS/MS is to accurately determine the concentration of a compound in an unknown sample. The MRM scan type is primarily used for quantitative analysis in a triple quadrupole mass spectrometer. In an MRM scan, the ability to define the precursor ion and characteristic product ion creates a pair that is highly specific of the analyte. The MRM transition (pair) coupled with the retention time associated with the analyte during liquid chromatography provides the specificity required for quantitation.

Quantitation is accomplished through the use of validated MRM LC-MS/MS acquisition methods, acquisition of calibration standard curves, and the subsequent integration of the peaks associated with the compounds of interest. The calibration curve relationship between signal response and concentration is used to determine the quantity of a particular analyte in an unknown sample.

Integration

In LC-MS/MS data, integration refers to obtaining the area under a curve for the peak associated with a specific compound. Through the development of a quantitation method which specifies the MRM transitions, expected retention times, internal standard, integration and regression parameters, the software is able to automatically integrate peaks for a given set of samples.

The compilation of quantitative information for a given set of samples is called a Results Table. Refer to Results Tables on page 39.
The software has two integration algorithms that can be used: MQ4 and SignalFinder1. The MQ4 algorithm selects a low concentration, but not the lowest concentration, standard or quality control sample by default as the representative sample of the analytical run. The SignalFinder™ algorithm selects a high concentration, but not saturated, standard or quality control sample by default as the representative sample of the analytical run. It is also possible to manually integrate peaks that were missed by the algorithms.

**Results Tables**

A Results Table is a compilation of the quantitative information associated with a set of samples. It includes, among others, the calculations for concentration and accuracy determined as a result of interpolating the calibration (standard) curve. Area, height and other numerical characteristics can be shown. The number and type of columns in the Results Tables might be edited for simplified viewing.

**Calibration Curves**

A calibration curve, also known as a standard concentration curve, is a method for determining the concentration of a substance in an unknown sample by comparing the unknown sample to a set of standard samples of known concentration. The calibration curve is a plot of how the instrument responds (the analytical signal) to changes in the concentration of the analyte (the substance to be measured). The operator prepares a series of standards across a range of concentrations near the expected concentration of the analyte in the unknown sample.

Calibration standards are used to build calibration curves. Incorrect readings or missing readings on some of the calibration samples might indicate issues with the analytical run. Follow acceptable methods found in literature and regulatory agency guidances to create a calibration curve. Examples of good practice in the preparation of calibration curves include:

- Preparing calibration standards in "blank" matrix in which the analyte is to be measured
- Generating a calibration curve for each analyte to be measured
- Making sure of the coverage of the expected concentration range of the analyte, including typical and atypical specimens
- Using six to eight standards to generate the curve

This is not a comprehensive list and other guidances should be used in determining the best practice in developing a calibration curve for the laboratory.

**Note:** In some analytical runs, single-point calibration standards are used. Single-point calibrations are performed using a matrix blank sample and a single standard concentration. The relationship between instrument response and analyte concentration is determined by the line created by these two points. Both the acquisition and quantitation methods should be validated before accepted for their intended use.

**Regression**

The area of the analyte peaks in the calibration curve standards is plotted against the known concentrations. Subsequently a line is fitted to the points. This regression line is used to calculate the concentration of the unknown samples.
Principles of Operation

- Linear \((y = mx + b)\)
- Linear through Zero \((y = mx)\)
- Quadratic \((y = a_2 + bx + c)\)

As well, it is possible to add different types of weighting for the regression, including:

- \(\frac{1}{x}\)
- \(\frac{1}{x^2}\)
- \(\frac{1}{y}\)
- \(\frac{1}{y^2}\)
### Table 4-1 Instrument Setup

<table>
<thead>
<tr>
<th>Step</th>
<th>To do this...</th>
<th>Find the information in...</th>
<th>What does it do?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a hardware profile.</td>
<td>Create a Hardware Profile on page 54</td>
<td>Each hardware profile must include a mass spectrometer. Only devices included in the active hardware profile can be used when creating acquisition methods.</td>
</tr>
<tr>
<td>2</td>
<td>Create projects to store data.</td>
<td>Create Projects and Subprojects on page 60</td>
<td>Before starting an experiment, decide where to store the files related to the experiment. Using projects and subprojects improves data management and makes comparison of results easier.</td>
</tr>
<tr>
<td>3</td>
<td>Optimize the mass spectrometer.</td>
<td>Optimize the Mass Spectrometer on page 64</td>
<td>This is the process of optimizing the resolution and mass spectrometer parameters, and calibrating the mass spectrometer to obtain the best sensitivity and performance from the system.</td>
</tr>
</tbody>
</table>
### Table 4-2 Sample Acquisition Workflow

<table>
<thead>
<tr>
<th>Step</th>
<th>To do this...</th>
<th>Find the information in...</th>
<th>What does it do?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create projects to store data.</td>
<td>Create Projects and Subprojects on page 60</td>
<td>Before starting an experiment, decide where to store the files related to the experiment. Using projects and subprojects improves data management and makes comparison of results easier.</td>
</tr>
<tr>
<td>2</td>
<td>Create an acquisition method.</td>
<td>Operating Instructions — Acquisition Methods on page 81</td>
<td>To analyze samples, create an acquisition method for the mass spectrometer and any LC devices. An acquisition method indicates which peripheral devices to use, when to use them to acquire data, and the associated parameters.</td>
</tr>
<tr>
<td>3</td>
<td>Create and submit a batch.</td>
<td>Add Sets and Samples to a Batch on page 87 and Submit a Sample or Set of Samples on page 90</td>
<td>After creating an acquisition method, run samples by creating an acquisition batch and submitting the batch to the Acquisition Queue.</td>
</tr>
<tr>
<td>4</td>
<td>Acquire data.</td>
<td>Acquire Data on page 91</td>
<td>Running samples involves managing the acquisition queue and monitoring instrument and device status. To submit samples and acquire data, use the Queue Manager. The Queue Manager displays queue, batch, and sample status, and facilitates management of samples and batches in the queue.</td>
</tr>
</tbody>
</table>
Table 4-2 Sample Acquisition Workflow (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>To do this...</th>
<th>Find the information in....</th>
<th>What does it do?</th>
</tr>
</thead>
</table>
| 5    | Analyze data in Explore mode.  
— OR —  
Step 6—Analyze quantitative data. | Operating Instructions — Analyze and Process Data on page 117 | In Explore mode, many tools are available for viewing and processing the acquired data. Graphs can be customized with peak labels and captions, contour plots can be displayed, and spectra can be saved in the library. |
| 6    | Analyze quantitative data | Operating Instructions — Analyze and Process Quantitative Data on page 100 | Use the various quantitative method creation tools in Quantitate mode to analyze the acquired data and build a quantitative method to generate a Results Table. Use the Results Table to manually review all of the peaks for each analyte and internal standard within a batch and to view calibration curves, sample statistics, and metric plots. |
WARNING! Follow the instructions in the documentation when using the system. The protection provided by the equipment might be impaired if the equipment is used in a manner not specified by SCIEX.

Start Up the System

WARNING! Electrical Shock Hazard. Make sure that the system can be disconnected from the AC mains supply outlet in an emergency. Do not block the AC mains supply outlet.
Note: Before operating the instrument, read the safety information in Operational Precautions and Limitations on page 8.

Prerequisites

- The site requirements specified in the Site Planning Guide are met. The Site Planning Guide includes information on the mains supply and connections, ion source exhaust, compressed air, nitrogen, roughing pump, ventilation, exhaust, and site clearance.
- The source exhaust gas, compressed air, and nitrogen gases are connected to the mass spectrometer.
- The 4 L drain bottle is connected to the exhaust waste connection on the back of the mass spectrometer and to the laboratory ventilation system.
- The source exhaust hoses are securely clamped at the mass spectrometer, drain bottle, and ventilation connections.
- The mass spectrometer convenience switch is turned off and the mains supply cable is plugged into the mass spectrometer.
- The mass spectrometer and roughing pump mains supply cables are plugged into the 200 VAC to 240 VAC mains supply.
- The Ethernet cable is connected to both the mass spectrometer and the computer.

WARNING! Lifting Hazard. Do not move the system. Risk of personal injury or system damage. If the system must be moved, then contact a Field Service Employee (FSE).

1. Turn on the roughing pumps. The On/Off switch is beside the mains supply input connection on the roughing pump.
2. Wait five minutes, and then turn on the mass spectrometer convenience switch.
3. Turn on the computer, if it is not on.
4. Start the Analyst® software.

**Reset the Mass Spectrometer**

1. Stop any ongoing scans and then turn off sample flow to the mass spectrometer.
2. In the Analyst® software, deactivate the hardware profile, if it is active.
3. Press and hold the *Reset* button for five seconds.
   - A click is heard when the relay activates. After approximately three minutes, the mass spectrometer should reach operating pressure.

**Shut Down the System**

**Tip!** If the mass spectrometer will not be used for a length of time, then leave it in Standby mode with the ion source in place. If the mass spectrometer must be shut down, then follow these instructions. Do not turn off the roughing pump until after the turbo pumps have spun down.

1. Complete or stop any ongoing scans.
CAUTION: Potential System Damage. Turn off the sample flow before the system is shut down.

2. Turn off the sample flow to the system.
3. In the Analyst® software, deactivate the hardware profile, if it is active.
4. Close the software.
5. Press and hold the Vent button for three seconds.
   The turbo pump will spin down gradually.
6. Wait 15 minutes to fully vent the system.
7. Turn off the roughing pump.
   The switch is located beside the mains supply input connection on the roughing pump.
8. Wait 15 minutes, and then turn off the mass spectrometer convenience switch.
9. Disconnect the mass spectrometer mains supply cable from the mains supply outlet.
10. Disconnect the roughing pump mains supply cable from the mains supply outlet.

Note: Before disconnecting the gas tubing, relieve the pressure in the gas lines.

Plumb the Mass Spectrometer

Adjust the Integrated Syringe Pump Position

WARNING! Puncture Hazard. Take care when handling the syringe. The tip of the syringe is extremely sharp.

WARNING! Puncture Hazard. Make sure that the syringe is seated properly in the syringe pump and that the automatic syringe pump stop is adjusted properly to avoid damaging or breaking the glass syringe. If the syringe breaks, follow established safety procedures for sharps disposal.

1. Press the Release button on the right side of the syringe pump to lower the base and then insert the syringe. Refer to Figure 5-2.
2. Make sure that the end of the syringe is flush against the base and that the shaft of the syringe rests in the cutout.

Figure 5-2 Lowering the Syringe

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Syringe plunger</td>
</tr>
<tr>
<td>2</td>
<td>Release button. Press to raise or lower the base.</td>
</tr>
</tbody>
</table>

3. Adjust the post so that it triggers the automatic syringe stop before the syringe plunger hits the bottom of the glass syringe. Refer to Figure 5-3.
Figure 5-3 Automatic Syringe Stop

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Automatic syringe stop. After the post hits the automatic syringe stop, the syringe pump stops.</td>
</tr>
<tr>
<td>2</td>
<td>Post. Adjust the height to prevent the syringe plunger from hitting the syringe during sample infusion.</td>
</tr>
<tr>
<td>3</td>
<td>Post lock screw. Tighten the screw after the height of the post is adjusted.</td>
</tr>
</tbody>
</table>

4. Turn the side screws as shown in Figure 5-4 to secure the syringe.
5. In the Analyst® software, on the navigation bar, double-click Manual Tuning.
6. Click Start Syringe.
7. To stop the syringe pump, click Stop Syringe.

**Plumb the Diverter Valve in Injector Mode**

The diverter valve is a two-position, six-port valve. It can be plumbed in injector mode or diverter mode. To configure the valve, access the **Configuration** tab and then make sure that the **Use integrated injector/diverter valve** check box is selected. Refer to Add Devices to a Hardware Profile on page 58.

**CAUTION: Potential Wrong Result: Do not press the diverter valve button during a run. Doing so might result in incorrect data.**

When the valve is in Position A, the sample flows through the external loop. Refer to Figure 5-7. When the valve switches to Position B, the sample is injected. Refer to Figure 5-8.

- Plumb the valve for injector mode.

**Table 5-1 Figure Legend**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sample in</td>
</tr>
<tr>
<td>2</td>
<td>Waste out</td>
</tr>
<tr>
<td>3</td>
<td>Sample loop (ports 3 and 6)</td>
</tr>
</tbody>
</table>
**Table 5-1 Figure Legend (continued)**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Mobile phase in</td>
</tr>
<tr>
<td>5</td>
<td>To column</td>
</tr>
</tbody>
</table>

**Figure 5-5 Diverter Valve—Injector Mode Position A**

![Diverter Valve Diagram](image-url)
Plumb the Diverter Valve in Diverter Mode

The diverter valve can be plumbed in injector mode or diverter mode. To configure the valve, access the Configuration tab and then make sure that the Use integrated injector/diverter valve check box is selected. Refer to Add Devices to a Hardware Profile on page 58.

CAUTION: Potential Wrong Result: Do not press the diverter valve button during a run. Doing so might result in incorrect data.

• Plumb the valve for diverter mode. When the valve is in Position A, then the sample flows through the external loop. Refer to Figure 5-7. When the valve is switched to Position B, the sample is injected. Refer to Figure 5-8.

Table 5-2 Legend for the Figures

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>To mass spectrometer</td>
</tr>
<tr>
<td>2</td>
<td>From column</td>
</tr>
<tr>
<td>3</td>
<td>Waste out</td>
</tr>
</tbody>
</table>
Figure 5-7 Diverter Valve—Diverter Mode Position A

Figure 5-8 Diverter Valve—Diverter Mode Position B
Hardware Profiles

A hardware profile tells the software how the mass spectrometer and the devices are configured and connected to the computer.

Each hardware profile must include a mass spectrometer. Before creating an acquisition method, make sure that all devices used in the method are included in the hardware profile. In the configuration options for the mass spectrometer, make sure that the syringe pump is enabled if it will be used during acquisition.

The devices configured in the active hardware profile and selected in the Add/Remove Device Method dialog are shown as icons in the Acquisition method pane. Only devices included in the active hardware profile can be used to create acquisition methods.

For information about setting up the physical connections to the devices, refer to the *Peripheral Devices Setup Guide*. For a list of the supported devices, refer to the *Software Installation Guide* for the Analyst® software.

Create a Hardware Profile

The user can create multiple hardware profiles, but only one profile can be active at any time.

1. On the Navigation bar, under Configure, double-click Hardware Configuration.
Figure 6-1 Hardware Configuration Editor Dialog

2. Click **New Profile**.
3. Type a name in the **Profile Name** field.

4. Click **Add Device**.
   - In the **Available Devices** dialog, in the **Device Type** field, **Mass Spectrometer** is the preset value.

5. Select the mass spectrometer from the **Devices** list.

6. Click **OK**.

7. Select the mass spectrometer from the **Devices in current profile** list.

8. Click **Setup Device**.

9. (Optional) To configure the mass spectrometer for the integrated syringe pump, on the **Configuration** tab, select the **Use integrated syringe pump** check box.
10. On the **Configuration** tab, in the **Dual Mass Mode** section, select one of the following options:

- **Low Mass**: To operate in limited mass range, high sensitivity operating mode, select this option. The maximum mass range is 50 Da to 1250 Da for LIT (linear ion trap) scans and 5 to 1000 Da for quadrupole scans.

- **High Mass**: To operate in extended mass range operating mode, select this option. The maximum mass range is 50 to 2000 Da for LIT scans and 5 Da to 2000 Da for quadrupole scans.

11. (Optional) To configure the mass spectrometer for the diverter valve, on the **Configuration** tab, select **Use integrated injector/diverter valve**.

12. Select additional features on the **Configuration** and **Communication** tabs as required.

13. Click **OK** to return to the **Create New Hardware Profile** dialog.

14. Add and configure each device that is used with the mass spectrometer.

15. Click **OK** in the **Create New Hardware Profile** dialog.

16. Click the hardware profile in the **Hardware Configuration Editor**.

17. Click **Activate Profile**.
The check mark turns green. If a red x is shown, then there is an issue with the hardware profile activation.

**Tip!** A hardware profile need not be deactivated before another is activated. Click a hardware profile and then click **Activate Profile**. The other profile is deactivated automatically.

1. Click **Close**.

### Add Devices to a Hardware Profile

Devices must be configured to enable the software to communicate with them. When the software is installed, the driver required for each device is also installed. After the devices are physically connected to the computer, configure the device.

1. Open the **Hardware Configuration Editor**.
2. In the **Hardware Profiles** list, deactivate the hardware profile.
3. Click **Edit Profile**.
4. Click **Add Device**.
5. In the **Available Devices** dialog, in the **Device Type** list, select the device.

**Figure 6-4 Available Devices Dialog**

![Available Devices Dialog](image)
6. Click **OK**.

7. Select the device from the **Devices in current profile** list.

8. Click **Setup Device**.
   
   A dialog containing configuration values for the device opens.

9. (Optional) On the **Communication** tab, in the **Alias** field, type a name or other identifier.

   **Note:** For devices using serial communication, make sure that the serial port selected matches the serial port to which the device is physically connected.

   **Note:** The **Alias** field might also be referred to as the **Name** box and might be found on another tab under **Alias**.

- If the device uses a **Serial Port** as a communication interface, then in the **COM Port Number** list, select the COM port to which the device is connected.

- If the device uses **Ethernet** as a communication interface, then type the **IP Address** assigned to the device by the administrator or use the corresponding **Host Name** for the address.

- If the device uses **GPIB Board** as a communication interface, then do not change the settings for the GPIB board.

   The rest of the preset values for the device are probably appropriate. Do not change them. For information about the **Configuration** and **Communication** tabs, refer to the Help.

10. To restore the device preset values, on the **Communication** tab, click **Set Defaults**.

11. To save the configuration, click **OK**.

12. Repeat step 4 to step 11 for each device.

13. Click **OK** in the **Create New Hardware Profile** dialog.

14. To activate the hardware profile, in the **Hardware Configuration Editor**, click the hardware profile.

15. Click **Activate Profile**.

   The check mark turns green. If a red x is shown, then there is an issue with the hardware profile activation. For more information, refer to **Troubleshoot Hardware Profile Activation on page 59**.

   **Tip!** An active hardware profile does not have to be deactivated before another one is activated. Click an inactive hardware profile and then click **Activate Profile**. The other profile is deactivated automatically.

16. Click **Close**.

### Troubleshoot Hardware Profile Activation

If a hardware profile fails to become active, then a dialog opens indicating which device in the profile failed. A failed profile might be due to communications errors.
1. Read the error message generated. Depending on the message, there might be an issue with a device or how the communication is set up.

2. Verify that the device has power and is turned on.

3. Verify that the COM port assigned to the device is correct.

   **Tip!** On computers with two built-in serial ports, the first port on the serial port expansion card is usually COM3, even though the cable indicates P1.

4. Verify that the communication settings with the device (for example, dip switch settings) are set correctly and match the settings on the **Communication** tab.

5. Turn off the device.

6. Wait 10 seconds.

7. Turn on the device.

   Wait until all device power-up activities are complete before trying to activate the hardware profile again. Some devices might require 30 seconds or more to complete the power-up activities.

8. Activate the hardware profile.

9. If the issue persists, then delete the failing profile and create a new one.

10. If the issue persists, then contact technical support.

### Projects and Subprojects

#### Create Projects and Subprojects

To use a subproject structure within a project, create the subproject structure when the project is created.

1. Click **Tools** > **Project** > **Create Project**.

2. Type a project name in the **Project name** field.

3. (Optional) To use subprojects, select the required folders and then use the arrow buttons to move them to the **Subproject folders** list.

4. (If subprojects are used) In the **Subproject name** field, type a name for the first subproject or use the existing date.

5. (Optional) To use this project and subproject folder organization for all new projects, select the **Set configuration as default for new projects** check box.

   All new projects are created with this folder configuration.

6. Click **OK**.
Create Subprojects

Subprojects can only be created in a project that has an existing subproject structure.

1. On the Project tool bar, from the Project list, select the project.
2. Click Tools > Project > Create Subproject.
3. In the Subproject name box, type a name for the subproject or use the existing date.
4. Click OK.

Copy Subprojects

A subproject can be copied from another project that has existing subprojects. If the copied subprojects contain folders that also exist in the project folder, then the software uses the project level folders.

1. Click Tools > Project Copy Subproject.
2. Click Browse to navigate to the subproject source in the Copy Subproject dialog.
3. Click OK.
4. Select the subproject from the Source Subproject list.
5. Click Browse to navigate to the subproject destination.
6. Type the name in the Target Subproject field.
7. Click OK.
8. Do one of the following:
   - To copy all folders and files from the Subproject Source into the Subproject Destination, select the Copy Contents check box.
   - To copy only the folders in the same structure into the Subproject Destination, make sure that the Copy Contents check box is cleared.
9. Click Copy.

Switch Between Projects and Subprojects

- On the software tool bar, from the project list, click the required project or subproject.
Figure 6-5 Project List

The project list in this figure shows the **API Instrument**, **Default**, and **Example** folders.

### Installed Project Folders

Three project folders are installed with the software: **API Instrument**, **Default**, and **Example**.

#### API Instrument Folder

The API Instrument folder is unique and very important to the correct functioning of the mass spectrometer. The API Instrument folder contains the information required for tuning and calibrating the mass spectrometer. This information includes parameter settings files, reference files, instrument data files that contain calibration and resolution information, and the acquisition methods used during automatic tuning. The API Instrument folder also contains data files for manual tuning runs that were performed using the Start button rather than the Acquire button. These data files are saved automatically in the API Instrument folder in the Tuning Cache folder and named with the date and time they were created. The Tuning Cache folder is automatically cleared periodically.

#### Default Folder

The Default folder contains folders that are present in new projects and serves as a template for new projects.

#### Example Folder

The Example folder contains sample methods and data files. Users can practice working with the Explore or Quantitate modes using the example data files. The example files are sorted into subfolders by mass spectrometer type and application area.
Back Up the API Instrument Folder

Back up the **API Instrument** folder regularly and after routine maintenance has been performed.

- Copy the **API Instrument** folder, paste it to a different location, preferably to another computer, and then rename the folder. Use the date and a mass spectrometer reference if there is more than one mass spectrometer when the folder is named.

Recover the API Instrument Folder

Back up the **API Instrument** folder regularly and after routine maintenance has been performed.

1. Rename the current **API Instrument** folder.
2. Copy the backup folder into the **Projects** folder.
3. Change the name of the backup folder to **API Instrument**.
Run the Verify instrument performance option weekly or after the mass spectrometer is cleaned to confirm that the system is working properly. In general, for triple quadrupole systems, calibration and resolution is maintained for three to six months unless the system loses vacuum. For QTRAP® systems, the resolution should also be maintained for three to six months but the system should be calibrated approximately monthly. If the system loses vacuum, then check the calibration and resolution before using the system. For more information about tuning and calibration, refer to the Advanced User Guide and the Manual Tuning Tutorial.

**Tip!** Perform maintenance tasks regularly to make sure that the mass spectrometer is performing optimally. Refer to Recommended Maintenance Schedule on page 138.

**Prerequisites**

- The spray is stable and the correct tuning solution is being used.
- A printer is configured.

**Required Materials**

- Tuning solutions that are supplied in the Standards Chemical Kit shipped with the system. If required, a new kit can be ordered from SCIEX.
- 5 mL, 1 mL, and 250 µL serial gas-tight syringes.
- Red PEEK sample tubing.

**Optimize the Mass Spectrometer**

The following procedure describes how to verify the performance of the mass spectrometer. For information about using the other instrument performance options, refer to the Help.

1. On the Navigation bar, under **Tune and Calibrate**, double-click **Manual Tuning**.
2. Run a calibration method, and confirm that the Total Ion Chromatogram (TIC) is stable and that the peaks of interest are present in the spectrum.
3. On the Navigation bar, under **Tune and Calibrate**, double-click **Instrument Optimization**.
   - The Instrument Optimization dialog opens.
4. Click **Verify instrument performance**.
5. Click **Next**.
6. Click **Approved Tuning**.
7. Click **Next**.
8. Select a **Tuning Solution**.
   
   Depending on the solution selected, different modes are available:
   a. Click a polarity.
   b. If available, click **Q1** and **Q3** in the **Quad** section.
   c. If available, click the required scan speeds.
   d. If available, click the scan speeds in the **LIT** section.
   e. If available, click **Excitation** in the **MS/MS/MS** section
9. Click **Next**.
10. If the **Select a mode** page opens, then select **Automatic**.
11. Click **Next**.
12. Click **GO**.
   
   The **Verifying or Adjusting Performance** dialog opens. After the process has completed, the **Results Summary** opens. For more information, refer to the Help.
13. If applicable (depending on the options selected), change solutions when prompted.

### About the Verifying or Adjusting Performance Dialog

The top left corner shows the part of the instrument that is being tuned.

The Current Spectrum graph shows the spectrum of the current scan, the optimal scan selected by the software, or the scan at the current parameter value when the software results are viewed in interactive mode.

The Instrument Optimization Decision Plots, in the top right graph, dynamically show the intensity versus voltage curves of the parameters that are currently being optimized.

### Results Summary

The **Results Summary** is a record of any instrument settings changes that were made by the **Instrument Optimization** wizard.
Figure 7-1 Results Summary

The Results Summary includes the location of data files and instrument settings backups, as well as step-by-step changes and results during optimization.

The Results Summary also shows a verification report. This report contains a snapshot of the mass spectrum for each relevant mass for the scan modes being verified. The spectrum is labeled with the target mass, where the mass was found, mass shift, peak width, and peak intensity. The spectrum can be used as a visual record of peak shape or scan mode performance. A summary table of results follows the spectra.

The Results Summary is saved as a document in the folder indicated at the top of the report. Users can print the Results Summary or open a previously saved Results Summary.
Operating Instructions —
Automatic Optimization

This section describes how to:

- Automatically optimize for the analyte using the Compound Optimization wizard.
- Choose between infusion and flow injection analysis (FIA).
- Use an infusion method to optimize compound-dependent parameters.
- Use an FIA method to optimize compound- and ion source-dependent parameters.

### Prerequisites

- A tuned and calibrated mass spectrometer.
- An optimized acquisition method.
- If the system has an integrated syringe pump, a hardware profile containing a syringe pump.
- For sample introduction by FIA, an LC pump and an autosampler in the hardware profile.
- All the required peripheral devices, including a syringe pump, if needed, and LC components in the hardware profile.

### Required Materials

The mixture of four compounds is used for illustrating the steps of the procedure.

- A syringe, preferably a 1.0 mL syringe.
- Mobile phase: 1:1 acetonitrile:water + 2 mM ammonium acetate + 0.1% formic acid.
- Autosampler vials.

### About Automatic Optimization

Automatic optimization first checks for the presence of the compounds. The voltages of the various ion path parameters are gradually increased or decreased to determine the maximum signal intensity (Q1 scan) for each ion. A text file is generated and shown during the optimization process. This file records the various experiments performed and the optimal values for each parameter. A file folder containing all the experiments performed is also generated and can be found by opening the data file folder in Explore mode. For each experiment performed, an acquisition method is also generated and saved in the Acquisition Method folder.

During the optimization process, select how the precursor ion and the corresponding product ions are to be chosen.
**Types of Sample Introduction**

**Infusion**

Infusion is the continuous flow of the sample at low flow rates into the ion source using a syringe pump. During the infusion optimization process, the software can select precursor and product ions and optimize for declustering potential, collision energy, and collision cell exit potential. The voltages of the ion path parameters are gradually increased or decreased to determine the maximum signal intensity for the precursor and product ions.

Use infusion optimization to optimize compound-dependent parameters only at much lower flow rates than those used during LC-MS/MS analysis.

**FIA**

FIA is the injection of a sample by the autosampler into the mass spectrometer using LC. During the FIA optimization process, multiple sample injections are performed for various ion source- or compound-dependent parameter types that are changed between injections. FIA compound optimization optimizes parameters by performing looped experiments in succession. One compound-dependent parameter is optimized first, followed by the next compound-dependent parameter. FIA optimizes for ion source-dependent parameters by making one injection for each value.

Compound parameters must be narrowed down using at least two more FIA cycles. Use FIA optimization to optimize both compound-dependent and source-dependent parameters using LC at higher flow rates.

**Table 8-1 Differences Between Sample Introduction Methods**

<table>
<thead>
<tr>
<th>Method</th>
<th>Required Devices</th>
<th>Parameters</th>
<th>Typical Flow Rate Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Infusion</td>
<td>Syringe pump</td>
<td>Compound-dependent</td>
<td>5 µL/min to 25 µL/min</td>
</tr>
<tr>
<td>FIA</td>
<td>LC pump and autosampler</td>
<td>Source- and compound-dependent</td>
<td>25 µL/min to 1000 µL/min</td>
</tr>
</tbody>
</table>

**Automatically Optimize for an Analyte Using Infusion**

In this section, users will perform automatic MS/MS optimization using infusion with a known precursor ion and an unknown product ion.

**Confirm the Presence of Compounds**

Confirm the presence of compounds of interest before continuing with automatic optimization.

1. Create a project.
2. Activate the hardware profile.
3. Infuse the compound in solution at a rate of 5 µL/min to 10 µL/min.
4. On the Navigation bar, under **Tune and Calibrate**, double-click **Manual Tuning**.
5. On the **Syringe Pump Method Properties** tab, type the parameter values shown in **Table 8-2**.

### Table 8-2 Syringe Pump Method Properties Tab

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Syringe Diameter</td>
<td>Syringe dependent; 1.0 mL syringe is 4.610 mm</td>
</tr>
<tr>
<td>Flow Rate</td>
<td>10</td>
</tr>
<tr>
<td>Unit</td>
<td>µL/min</td>
</tr>
</tbody>
</table>

6. Click **Start Syringe Pump**.
7. Click **MS Method** from the method list.
8. On the **MS** tab, type the parameter values shown in **Table 8-3**.

### Table 8-3 MS Tab

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan type</td>
<td>Q1 MS (Q1)</td>
</tr>
<tr>
<td>Start (Da)</td>
<td>200</td>
</tr>
<tr>
<td>Stop (Da)</td>
<td>700</td>
</tr>
<tr>
<td>*Time (sec) (if available)</td>
<td>2.5</td>
</tr>
<tr>
<td>*Scan rate (Da/s) (if available)</td>
<td>200</td>
</tr>
</tbody>
</table>
Table 8-3 MS Tab (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration (min)</td>
<td>3</td>
</tr>
</tbody>
</table>

* These fields are instrument-dependent.

9. Click **Start**.

10. Wait until an even TIC is shown on the left and peaks are shown on the right and then click **Stop**.

11. Select the **MCA** check box.

12. Type **10** in the **Cycles** field.

13. Click **Start**.

When the ten scans are complete, the graph should show the masses of the four compounds as ions.

The intensities of the compounds should be much higher than the smallest noise peaks but not so high that any noise peaks are not seen. In the first case, the peak might not be a real compound. In the second case, the concentration might be too high for the software to optimize properly.

**Figure 8-2 Compound Ions**
Perform Automatic MS and MS/MS Optimization Using Infusion with a Known Precursor Ion and an Unknown Product Ion

Automatic optimization for MS/MS analysis optimizes certain compound-dependent parameters for one or more MRM transitions. The software finds the ion of interest and then optimizes the compound-dependent parameters to get the maximum sensitivity for the compound. The software ramps CE and then selects the most intense fragments that meet all of the product ion selection criteria.

If the Initial Q1 scan signal is too high, then the software attempts to lower the CEM to keep ions within the detector range. If the signal is still too high after lowering the CEM, then the process stops and an error message is shown. Dilute the solution and then restart the optimization. Be sure to purge the infusion line. The parameters from the last quantitative optimization are stored.

1. On the Navigation bar, under Tune and Calibrate, double-click Compound Optimization.
2. On the Instrument Settings page, in the Inlet section, click Infusion.
3. Click MS/MS Analysis in the Mass Spectrometer section.
4. Click Next.
5. On the Ions to use in MS/MS Analysis page, type the parameter values shown in Table 8-4.

Table 8-4 MS/MS Analysis Page

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>MW Ion: Search Window</td>
<td>2.500</td>
</tr>
<tr>
<td>Resolution</td>
<td>Unit</td>
</tr>
<tr>
<td>Polarity</td>
<td>Positive</td>
</tr>
<tr>
<td>Product Ion</td>
<td>Auto Select</td>
</tr>
<tr>
<td>Resolution</td>
<td>Unit</td>
</tr>
</tbody>
</table>

Note: The optimization algorithm looks for the most intense peak in the specified search window. If the most intense peak in that window is not the mass of interest, then the software optimizes on the wrong ion.

6. Click Criteria next to the Auto Select option.
7. In the Product Ion Auto Selection Criteria dialog, type the parameters shown in Table 8-5.

6500 and 6500+ Series of Instruments
System User Guide
RUO-IDV-05-2095-A
71 of 181
Table 8-5 Product Ion Auto Selection Criteria Dialog Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Most Intense (peaks)</td>
<td>3</td>
<td>The number of fragment peaks to be optimized. The algorithm will generate a product ion scan spectrum while ramping the CE in MCA mode. In this example, it will then take the three most intense fragment ions from the spectrum and continue the MS/MS optimization on those fragments only.</td>
</tr>
<tr>
<td>Build final method using (most intense peaks)</td>
<td>2</td>
<td>The number of fragment ions per precursor ion (target compound) to be automatically included in the acquisition method. The specified number defines the number of MRM transitions to be included for each target compound in the method, and the order of preference is based on the intensity of the fragment ion. Two is a better starting value than one because typically two product ions are required for quantitation. Start with three in case there is an issue with one of the two best. Go back and the third is already identified.</td>
</tr>
<tr>
<td>Exclude Product Ions within ± (Da of Precursor Ion m/z)</td>
<td>20.000</td>
<td>The Da value that defines the exclusion window around the precursor ion so that fragment ions that fall within this window are not selected for MRM optimization. For example, if the user types ± 5 Da for a precursor ion of 500 m/z, then any fragment ions within the 495 to 505 m/z region are excluded. This prevents the precursor ion from being optimized.</td>
</tr>
<tr>
<td>Min. Mass for Product Ion (Da)</td>
<td>60.000</td>
<td>The lowest fragment mass to be considered for optimization. Use this option to narrow or widen the window of fragment ions to be considered from the precursor mass.</td>
</tr>
<tr>
<td>Threshold for Product Ion (cps)</td>
<td>100.000</td>
<td>Minimum number of counts for a product ion to be considered.</td>
</tr>
</tbody>
</table>

8. Click **OK** to save the changes to the selection criteria.

9. Click **Next**.

10. In the **Target Components** dialog, type the parameter values shown in **Table 8-6**.

    **Note:** The compound name must be unique for each compound or transition.
<table>
<thead>
<tr>
<th>Target Compound</th>
<th>Field</th>
<th>Value*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reserpine</td>
<td>Compound Name</td>
<td>Reserpine</td>
</tr>
<tr>
<td></td>
<td>MW (Da)</td>
<td>609.3</td>
</tr>
<tr>
<td></td>
<td>No. Charges</td>
<td>1</td>
</tr>
<tr>
<td>Minoxidil</td>
<td>Compound Name</td>
<td>Minoxidil</td>
</tr>
<tr>
<td></td>
<td>MW (Da)</td>
<td>210.2</td>
</tr>
<tr>
<td></td>
<td>No. Charges</td>
<td>1</td>
</tr>
<tr>
<td>Tolbutamide</td>
<td>Compound Name</td>
<td>Tolbutamide</td>
</tr>
<tr>
<td></td>
<td>MW (Da)</td>
<td>271.1</td>
</tr>
<tr>
<td></td>
<td>No. Charges</td>
<td>1</td>
</tr>
<tr>
<td>Rescinnamine (IS)</td>
<td>Compound Name</td>
<td>Rescinnamine</td>
</tr>
<tr>
<td></td>
<td>MW (Da)</td>
<td>635.3</td>
</tr>
<tr>
<td></td>
<td>No. Charges</td>
<td>1</td>
</tr>
</tbody>
</table>

*Type the exact ion mass.

11. Click **Finish** to begin the optimization process.

The screen shows two windows, a text file window and an acquisition window. The user might need to minimize one of them to see the other. The experiment being run is shown on the top of the acquisition window. The X-axis shows the parameter that is being optimized for each experiment. The text file window is updated as results are generated.

After optimization is complete, an MRM acquisition file is created and named *[compound]_QOpt_FinalMRM_Pos.dam*, where [compound] is the first compound in the Target Components page.

**Check the Optimization Results**

At the end of the optimization, the optimized parameters are saved in an acquisition method. All .dam and .wiff files generated in the optimization process are saved in the Acquisition Method folder and in a subfolder in the Data folder, respectively, in the project. The name of the subfolder is generated using the name of the compound and the date.

1. After completing the optimization, print the text file containing the optimized parameters for each compound.
2. Click **File > Menu** and then select the **Reserpine_QOpt_FinalMRM.POS.dam** file.
Operating Instructions — Automatic Optimization

3. Compare the values in the text file to those in the .dam file.

4. Check the contents of the following folders:
   - **Data**: Look through all the runs executed during optimization. Compare a .wiff file with the optimized value in the method or printed parameters.
   - **Acquisition Method**: *Reserpine_QOpt_FinalMRM.POS.dam* file and other .dam files created during optimization.
   - **Log**: Report file (.rtf) shown during the optimization process.

**Automatically Optimize for an Analyte Using FIA**

<table>
<thead>
<tr>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Before optimizing using FIA, identify the ions for the compounds and saved the basic acquisition method.</td>
</tr>
<tr>
<td>• Because using FIA for optimization requires that an autosampler and LC pump be active in the hardware profile, add these two devices to the basic acquisition method.</td>
</tr>
<tr>
<td>• Before beginning, create an LC-MS/MS acquisition method based on the <em>Reserpine_QOpt_FinalMRM.POS.dam</em> file and then name the new method. Make sure that the project contains an acquisition method.</td>
</tr>
</tbody>
</table>

**Note**: Although FIA can be used to optimize compound-dependent parameters, this is typically not done because of the number of cycles required to obtain the optimal parameter values.

1. Put a dilution of the four-compound mix in an autosampler.
   
   Enough sample is required to review each variable of each parameter and have sample left over. For example, for the temperature to run at 300 °C, 400 °C, and 50 °C, more than a 30 µL (3 × 10 µL injection) is required.

2. Confirm that **LC Sync** is selected in the method.
3. Make sure that the ion source and gas parameters are set to reasonable levels to prevent the contamination of the mass spectrometer.

4. Set the horizontal micrometer to 5.

5. Set the vertical micrometer on the ion source for the flow rate. Refer to the ion source Operator Guide for information on vertical micrometer settings.

6. Set the values for the HPLC system and use an autosampler injection volume of 10 µL. Use the same concentration or lower as for the infusion experiment.
   The LC pumps must be set for an isocratic run with no column. The MS and LC times must be the same to collect the proper data.
   The flow rate and percent of mobile phases used should be based on the LC column used, the general chromatography, and the approximate mobile phase concentration at which the compounds of interest elute.

7. On the Navigation bar, under Tune and Calibrate, double-click Compound Optimization.

8. On the Instrument Settings page, depending on the stack being used, type the parameter values shown in Table 8-7 and then select the appropriate default acquisition method.

### Table 8-7 Instrument Settings Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inlet</td>
<td>FIA</td>
</tr>
<tr>
<td>Rack Code</td>
<td>Autosampler specific</td>
</tr>
<tr>
<td>Rack Position</td>
<td>Autosampler specific</td>
</tr>
</tbody>
</table>
### Table 8-7 Instrument Settings Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Injection Volume</td>
<td>10 µL</td>
</tr>
<tr>
<td>Mass Spectrometer</td>
<td>MS/MS Analysis</td>
</tr>
</tbody>
</table>

9. Click **Next**.

10. Make sure that the **Int. Std.** check box is cleared.

   Selecting the check box indicates which MRM corresponds to the internal standards. Internal standards are not optimized during the optimization process.

11. In the **Resolution** section, select **Unit** in both the **Q1 Resolution** and **Q3 Resolution** fields.

#### Figure 8-4 Q1 and Q3 Resolution Fields

12. Click **Next**.
13. On the **FIA Source Parameters** page, type numbers that are lower or higher than the original value as long as they are still within specifications. Be sure not to go too low with any of the settings to keep the system clean. Use the parameters shown in Table 8-8.

**Table 8-8 Parameters for FIA Source Parameters Page**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Select the Optimize Check Box?</th>
<th>Values for Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curtain Gas</td>
<td>Yes</td>
<td>20;40;55</td>
</tr>
<tr>
<td>Collision Gas</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>IonSpray Voltage</td>
<td>Yes</td>
<td>1500;2000;3000;4000;5000</td>
</tr>
<tr>
<td>Temperature</td>
<td>Yes</td>
<td>300;400;500;600;700</td>
</tr>
<tr>
<td>Ion Source Gas 1</td>
<td>Yes</td>
<td>40;50;60;70;80;90</td>
</tr>
<tr>
<td>Ion Source Gas 2</td>
<td>Yes</td>
<td>40;50;60;70;80;90</td>
</tr>
<tr>
<td>Interface Heater</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

14. Select 1 or 2 beside **Replicate Injection for each Parameter**.

The total number of injections and the total sample volume are calculated based on the specifications here. Note the total sample volume needed. Sample volume might be high depending on how many variables for each parameter being optimized, as each variable is a separate method.
15. Click **Next**.

16. On the **FIA Compound Parameters** page, type the parameters shown in **Table 8-9**.

**Note:** The values in **Table 8-9** are suggested values. For more information, refer to the Help.

### Table 8-9 FIA Compound Parameters Page

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Select the Optimize Check Box?</th>
<th>Values for Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Declustering Potential</td>
<td>Yes</td>
<td>60;80;100;120;200</td>
</tr>
<tr>
<td>Entrance Potential</td>
<td>No</td>
<td>—</td>
</tr>
</tbody>
</table>
Table 8-9 FIA Compound Parameters Page (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Select the Optimize Check Box?</th>
<th>Values for Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collision Energy</td>
<td>Yes</td>
<td>20;30;40;50;70;80;100</td>
</tr>
<tr>
<td>Collision Cell Exit Potential</td>
<td>Yes</td>
<td>2;4;6;8;10;12</td>
</tr>
</tbody>
</table>

The total number of injections and dependent sample volume update automatically. In contrast to ion source parameters, which require one injection per value per replicate, compound-dependent parameters only require one injection per parameter. A looped experiment is performed for each parameter. The values are alternated scan-by-scan within one injection.

**Note:** Do not enter too many values that will prevent proper evaluation of the parameter.

17. Type **15** in the **Mass Spec. Duration** field. This value should be at least the required length of time for each injection.
18. Click **Finish** to begin the optimization process.

The software optimizes the specified ion source- and compound-dependent parameters to get the maximum sensitivity for the MRM transition of the compound. As the software proceeds through the optimization, it creates a **Compound Optimization** report.

19. To obtain optimized parameters, repeat this routine. Typically, the ion source and gas parameters must be narrowed using one more FIA cycle.

20. The software generates several acquisition methods. Open the final optimized FIA method called "*_FIA_sample_1."

21. Save this method using a simpler name.
An acquisition method consists of experiments and periods. Use the Acquisition Method editor to create a sequence of periods and experiments for the instrument and devices.

We recommend that only users who are proficient in method development create or modify acquisition and quantitation methods. Refer in the Laboratory Director's Guide for more information about roles and security.

### Create an Acquisition Method Using the Acquisition Method Editor

**Tip!** If users are creating a new acquisition method file from an existing file, then some or all of the peripheral device methods in the acquisition method might be used.

Only devices configured in the active hardware profile appear in the Acquisition method pane. Any devices added to the hardware profile must also be added to existing acquisition methods. For more information about devices, refer to the Peripheral Devices Setup Guide.

1. Make sure that a hardware profile containing the mass spectrometer and peripheral devices is active.
2. On the Navigation bar, under Acquire, double-click Build Acquisition Method.
3. Select a Synchronization Mode on the Acquisition Method Properties tab.
4. (Optional) Select the Auto-Equilibration check box and then type the required equilibration time, in minutes.
5. Click the Mass Spec icon in the Acquisition method pane.
6. Select a Scan type on the MS tab.
7. Type values in the fields as required. Refer to Parameters on page 32.
8. On the Advanced MS tab, type values in the fields as required.
9. On the MS tab, click Edit Parameters.
10. On the Source/Gas tab, specify values in the fields as required.
11. On the Compound tab, specify values in the fields as required and then click OK.
12. Click a device icon and then select the parameters for the device.
13. Add any additional periods and experiments. Refer to Add an Experiment on page 82 and Add a Period on page 82.
14. Click File > Save.
Configure the Syringe Pump

1. Click the **Syringe Pump** icon in the **Acquisition method** pane.
   
   The **Syringe Pump Method Properties** tab opens in the **Acquisition Method** editor pane.

2. Type the syringe diameter in the **Syringe Diameter (mm)** field.

3. Type the flow rate in the **Flow Rate** field.

4. Select the units of flow from the **Unit** list.

Add an Experiment

1. Right-click the period and then click **Add experiment**.
   
   An experiment is added below the last experiment in the period.

   **Note:** An experiment cannot be inserted between experiments or periods. Users can only add an experiment at the end of the period.

2. Select the appropriate device or instrument parameters in the **Acquisition Method Editor** pane.

   **Note:** Users cannot use multiple periods in an IDA experiment.

Add a Period

- In the **Acquisition method** pane, right-click the **Mass Spec** icon, and then click **Add period**.
   
   A period is added below the last period created.

   **Note:** Users cannot use multiple periods in an IDA experiment.

Copy an Experiment into a Period

1. Open a multi-period method.

2. In the **Acquisition method** pane, press **Ctrl**, and then drag the experiment to the period.
   
   The experiment is copied below the last experiment in the period.
Copy an Experiment within a Period

Use this procedure to add the same or similar experiments to a period if most or all of the parameters are the same.

- Right-click the experiment and then click **Copy this experiment**.

A copy of the experiment is added below the last experiment created. This is useful when the same or similar experiments are added to an acquisition method.

## Scan Techniques

**MS**: In MS scans, also referred to as single MS scans, ions are separated according to their mass-to-charge (\(m/z\)) ratio. A single MS scan might be used to determine the molecular weight of a compound. Single MS scans can also be referred to as survey scans. MS scans do not provide any information about the chemical make-up of the ions other than the \(m/z\) ratio. Perform MS/MS or MS/MS/MS scans to obtain more information about the ions.

**MS/MS**: MS/MS scans are used to identify or confirm a molecular species. For MS/MS scans in triple quadrupole systems, precursor ion fragmentation occurs in the collision cell.

- For triple quadrupole systems, fragmentation occurs in the collision cell.
- For QTRAP\textsuperscript{®} systems, fragmentation can occur in the collision cell or the linear ion trap.

If enough energy is used, then the precursor ion fragments to produce characteristic product ions.

**MS/MS/MS**: The LIT system MS/MS/MS scans go one step further than MS/MS scans. A fragment that is produced in the collision cell is fragmented further in the linear ion trap to give more structural information about the molecular ion.

## Quadrupole-Mode Scan Types

Triple quadrupole instruments have high-sensitivity Multiple Reaction Monitoring (MRM) capabilities required for quantitation experiments. In addition, they have highly specific scan types, such as precursor ion and neutral loss scans, that allow a more advanced search to be performed on the components of the samples.

**Q1 MS (Q1)**: A full scan type using the first quadrupole (Q1). The ion intensity is returned for every mass in the scan range.

**Q1 Multiple Ions (Q1 MI)**: A zero-width scan type using the Q1 quadrupole. The ion intensity is returned for the specified masses only.

**Q3 MS (Q3)**: A full scan type using the third quadrupole (Q3). The ion intensity is returned for every mass in the scan range.

**Q3 Multiple Ions (Q3 MI)**: A zero-width scan type using the Q3 quadrupole. The ion intensity is returned for the specified masses only.
MRM (MRM): An MS/MS scan in which a user-selected ion is passed through the Q1 quadrupole and then fragmented in the Q2 collision cell. The Q3 quadrupole then selects the fragment ion that enters the detector. This scan mode is used primarily for quantitation.

Product Ion (MS2): An MS/MS full scan where the Q1 quadrupole is fixed to transmit a specific precursor ion and the Q3 quadrupole scans a defined mass range. Used to identify all of the products of a particular precursor ion.

Precursor Ion (Prec): An MS/MS scan where the Q3 quadrupole is fixed at a specified mass-to-charge ratio to transmit a specific product ion and the Q1 quadrupole scans a mass range. Used to confirm the presence of a precursor ion or, more commonly, to identify compounds sharing a common product ion.

Neutral Loss (NL): An MS/MS scan where both the Q1 quadrupole and the Q3 quadrupole scan a mass range, a fixed mass apart. A response is observed if the ion chosen by the Q1 quadrupole fragments by losing the neutral loss (the fixed mass) specified. Used to confirm the presence of a precursor ion or, more commonly, to identify compounds sharing a common neutral loss.

LIT-Mode Scan Types

The LIT-mode scans use the Q3 quadrupole as a linear ion trap. Ions are trapped and stored in the Q3 quadrupole before being scanned out, giving increased sensitivity. In addition, MS/MS/MS analysis can be performed in the linear ion trap, providing more information about the sample. LIT-mode scan types are typically used for qualitative measurements.

Enhanced MS (EMS): Ions are scanned in the Q1 quadrupole to the linear ion trap where they are collected. These ions are scanned out of the Q3 quadrupole to produce single MS type spectra.

Enhanced Multi-Charge (EMC): This scan type is similar to the EMS scan except that before ions are scanned out of the linear ion trap, there is a delay period during which low-charge state ions (primarily singly-charged ions) are allowed to preferentially escape from the linear ion trap. When the retained ions are scanned out, the multiply-charged ion population dominates the resulting spectrum.

Enhanced Product Ion (EPI): This scan type is used to obtain a high quality MS/MS spectrum on a specific ion. The fragmentation is done in the Q2 collision cell and thus provides the information-rich MS/MS spectrum typical of collisionally activated dissociation (CAD) fragmentation. In this scan mode, the precursor ion to be fragmented is first selected in the Q1 quadrupole with a mass window that is 1 Da to 4 Da wide, filtering out all other ions. The precursor ion is fragmented by CAD gas in the Q2 collision cell. The fragment ions generated are captured in the linear ion trap and then scanned out at one of three scan speeds, depending on the required fragment ion resolution.

For IDA experiments, the Product Of field is set to 30 Da by default, and this value should not be changed.

Enhanced Resolution (ER): This scan type is similar to the EMS scan except that a small 30 Da mass around the precursor mass is scanned out of the linear ion trap at the slowest scan rate to produce a narrow window of the best-resolved spectra.

MS/MS/MS (MS3): A precursor ion is selected by the Q1 quadrupole and fragmented with collisionally activated dissociation in the Q2 collision cell. The resulting product ions are all transmitted to the linear ion trap, where a single product ion is then isolated. The isolated ion is further fragmented in the linear ion trap, and the resulting...
product ions are scanned out of the trap at one of three scan speeds. As with any in-trap Collision Induced Disassociation (CID) technique, there is a low mass cut-off for the second MS/MS step due to the condition that the lowest mass fragment and precursor must be simultaneously stable in the trap. For QTRAP® systems, this results in the loss of ions lower than 28 percent of the mass of the precursor ion during MS3 experiments. This phenomenon is often referred to as the one-third cut-off rule.

## About Spectral Data Acquisition

Spectral data can be acquired in one of the modes described in *Table 9-1*.

### Table 9-1 Spectral Data

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile</td>
<td>The preset value is 0.1 Da. Profile data is the data generated by the mass spectrometer and corresponds to the intensity recorded at a series of evenly spaced discrete mass values. For example, for a mass range from 100 Da to 200 Da and a step size of 0.1 Da, the mass spectrometer scans 99.95 to 100.05 (recorded as value 100), 100.05 to 101.15 (recorded as value 101)…199.95 to 200.05 (recorded as value 200).</td>
</tr>
<tr>
<td>Peak Hopping</td>
<td>The preset value is 1.0 Da. Peak Hopping is a mode of operating a mass spectrometer in which large steps (approximately 1 Da) are made. It has the advantage of speed (fewer data steps are made) but with the loss of peak shape information.</td>
</tr>
<tr>
<td>Centroid</td>
<td>The mass spectrometer scans as in Profile mode, but creates a centroid of the data, replacing found peaks with the intensity-weighted center of gravity for each peak. Centroid data has the advantage of significantly reducing file size. The disadvantage is that peak shape information is lost and if data has been collected as a centroid then it cannot be altered. We recommend the use of profile mode and centroiding of the data post-acquisition.</td>
</tr>
</tbody>
</table>
Operating Instructions — Batches

**CAUTION:** Potential System Damage. If the HPLC system connected to the mass spectrometer is not controlled by the software, then do not leave the mass spectrometer unattended while in operation. The HPLC system can flood the ion source when the mass spectrometer goes into Standby mode.

A batch is a collection of information about the samples to be analyzed. Batches tell the software the order in which to analyze the samples. For information about importing batches, refer to the *Advanced User Guide*.

**Set Queue Options**

The queue goes one-by-one through the list, acquiring each sample with the selected acquisition method. After all of the samples have been acquired, the queue stops and the mass spectrometer goes into Standby mode. In Standby mode, the LC pumps and some instrument voltages are turned off.

The user can change the length of time the queue runs after the last acquisition has finished, before the Analyst® software puts the mass spectrometer into Standby mode. For information about the other fields in the *Queue Options* dialog, refer to the Help.

1. On the Navigation bar, click **Configure**.
2. Click **Tools > Settings > Queue Options**.
3. In the **Max. Num. Waiting Samples** field, set the maximum number of samples to a value that is greater than the number of samples that will be submitted to the queue.
4. In the **Max. Idle Time** field, type the length of time the queue will wait after acquisition is completed before going to Standby mode. The preset value is 60 minutes.
   - If gas cylinders are used, then adjust this time to make sure that the gas in the cylinders is not depleted.
   - If an LC method is used, then before the run is started, make sure that there is enough solvent in the reservoirs for all of the sample runs at the primary flow rate and the maximum idle time.
5. Select the **Leave Mass Spec on in Standby** check box to keep the mass spectrometer running after analysis has been completed. This feature allows the heaters and gases to continue running, even after devices have entered Idle state, so that the ion source and entrance to the mass spectrometer are kept free of contaminants.
6. Select the **Fail Whole Batch in Case of Missing Vial** check box to fail the entire batch when a missing vial is encountered. If this option is not selected, then only the current sample will fail and the queue will continue to the next sample.
Add Sets and Samples to a Batch

A set can consist of a single sample or multiple samples.

**Note:** For more information about adding quantitation information to a batch, refer to the *Advanced User Guide*.

1. On the Navigation bar, under **Acquire**, double-click **Build Acquisition Batch**.

**Figure 10-1 Batch Editor Dialog**

2. In the **Sample** tab, in the **Set** list, type a name.
3. Click **Add Set**.
4. Click **Add Samples** to add samples to the new set.
5. In the **Sample name** section, in the **Prefix** field, type a name for the samples in this set.

6. To add incremental numbering to the end of the sample name, select the **Sample number** check box.

7. If the **Sample number** check box is selected, then in the **Number of digits** field, type the number of digits to include in the sample name.
   
   For example, if 3 is typed, then the sample names would be samplename001, samplename002, and samplename003.

8. In the **Data file** section, in the **Prefix** field, type a name for the data file that will store the sample information.

9. Select the **Set name** check box to use the set name as part of the data file name.

10. Select the **Auto Increment** check box to increment the data file names automatically.

   **Note:** The data for each sample can be stored in the same or a separate data file. The names of the data file will have numerical suffixes starting from 1.

11. Type a name in the **Sub Folder** field.

    The folder is stored in the **Data** folder for the current project. If the **Sub Folder** field is left blank, then the data file is stored in the **Data** folder and a subfolder is not created.

12. In the **New samples** section, in the **Number** field, type the number of new samples.
13. Click **OK**.

The sample table fills with the sample names and data file names.

**Tip!** Fill Down and Auto Increment options are available in the right-click menu after a single column heading or several rows in a column are selected.

14. In the **Sample** tab, in the **Acquisition** section, select a method from the list.

Depending on how the system is set up, specific information for the autosampler must be entered. Even if the injection volume is set in the method, the user can change the injection volume for one or more samples by changing the value in the injection volume column.

**Note:** To use different methods for some of the samples in this set, select the **Use Multiple Methods** check box. The **Acquisition Method** column is shown in the **Sample** table. Select the acquisition method for each sample in this column.

15. To change the injection volumes from the volumes listed in the method, in the **Inj. Volume (µL)** column, type the injection volume for each sample.

16. Indicate the positions of the vials in the **Vial Position** column.

**Note:** To automatically fill in the samples from the **Locations** tab, click on the first and last vial within a set while pressing the **Shift** key. These vials appear as red circles. On the **Locations** tab, multiple injections from the same vial can be done by pressing the **Ctrl** key while clicking the vial location. The red circle turns green.

17. (Optional) Use the procedures in **Table 10-1** as required.

**Table 10-1 Batch Editor Tips**

<table>
<thead>
<tr>
<th>To do this...</th>
<th>...do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>To change all the values in a column simultaneously</td>
<td>click a column heading and then right-click. From the menu, use the <strong>Auto Increment</strong> and <strong>Fill Down</strong> commands to change the values in the column. This feature also works for multiple cells in the same column.</td>
</tr>
<tr>
<td>To change an existing acquisition method</td>
<td>select the method and then click <strong>Method Editor</strong> from the list. To create a new acquisition method, select <strong>None</strong> from the list and then click <strong>Method Editor</strong>. Only experienced users should use this feature. Do not use this feature if the <strong>Use Multiple Methods</strong> option is selected.</td>
</tr>
</tbody>
</table>
Table 10-1 Batch Editor Tips (continued)

<table>
<thead>
<tr>
<th>To do this...</th>
<th>...do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>To apply a previously created quantitation method</td>
<td>select the method from the Quantitation list.</td>
</tr>
<tr>
<td>To select more than one well or vial at a time</td>
<td>hold down the Shift key and then click the first and last well or vial in the range.</td>
</tr>
</tbody>
</table>

18. To set sample locations, do one of the following:

- Set Sample Locations in the Batch Editor on page 91
- Select Vial Positions Using the Locations Tab (Optional) on page 92

19. (Optional) To define quantitation details prior to submitting the batch, refer to Set Quantitation Details in the Batch Editor (Optional) on page 93.

20. Click the Submit tab.

21. If the Submit Status section contains a message about the status of the batch, then do one of the following:

- If the message indicates that the batch is ready for submission, then proceed to the next step.
- If the message indicates that the batch is not ready for submission, then make the changes as indicated by the message.

22. Click Submit.

   The Acquisition dialog opens.

23. Save the file.

Submit a Sample or Set of Samples

1. Click the Submit tab in the Batch Editor.

2. If the Submit Status section contains a message about the status of the batch, then do one of the following:

   - If the message indicates that the batch is ready for submission, then proceed to the next step.
   - If the message indicates that the batch is not ready for submission, then make the changes as indicated by the message.

3. Click Submit.

4. Save the file.
Change Sample Order

The order of the samples can be edited before the samples are submitted to the Queue.

- On the Submit tab, double-click any of the numbers at the far left of the table (a very faint square box is visible), and then drag them to the new location.

Acquire Data

The system must not be in Tune and Calibrate mode when sample acquisition is started. Also, if the system has been previously run that day and has not yet been set to Standby mode, then sample acquisition will start automatically.

1. On the Navigation bar, click Acquire.
2. Click View > Sample Queue.
   - The Queue Manager opens with all submitted samples.

   **Figure 10-3 Queue Manager**

   ![Queue Manager](image)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The Reserve Instrument for Tuning icon should not be pressed in.</td>
</tr>
<tr>
<td>2</td>
<td>Queue status should be Stand By.</td>
</tr>
<tr>
<td>3</td>
<td>Queue Server should be in Normal. Refer to Queue States on page 96.</td>
</tr>
</tbody>
</table>

3. Click Acquire > Start Sample.

   **Note:** We recommend that the sample be run again if an abnormal termination occurs during sample acquisition.

Set Sample Locations in the Batch Editor

If an autosampler is used in the acquisition method, then the vial positions of the samples must be defined in the acquisition batch. Define the location in the Sample tab or in the Locations tab. For more information about creating batches, refer to Add Sets and Samples to a Batch on page 87.
Operating Instructions — Batches

Note: Depending on the autosampler being used, it might not be necessary to type details in additional columns.

1. In the Sample tab, from the Set list, select the set.
2. For each sample in the set, do the following if applicable:
   • In the Rack Code column, select the rack type.
   • In the Rack Position column, select the position of the rack in the autosampler.
   • In the Plate Code column, select the plate type.
   • In the Plate Position column, select the position of the plate on the rack.
   • In the Vial Position column, type the position of the vial in the plate or tray.
3. Save the file.

Select Vial Positions Using the Locations Tab (Optional)

1. Click the Locations tab in the Batch Editor.
2. Select the set from the Set list.
3. Select the autosampler from the Autosampler list.
   The appropriate number of rack spaces for the autosampler is shown in the graphic rack view.
4. In the space associated with the rack, right-click and then select the rack type.
   The plates or trays are shown in the rack.
5. Double-click one of the rectangles.
   The circles depicting the wells or vials for the plate or tray are shown.
6. To select whether samples are marked by row or column, click the **Row/Column selection** selector button.
   If the button shows a red horizontal line, then the **Batch Editor** marks the samples by row. If the button shows a red vertical line, then the **Batch Editor** marks the samples by column.

7. Click the sample wells or vials in the order to be analyzed.

   **Tip!** Click a selected well or vial again to clear it.

8. Save the file.

   **Tip!** To fill in the samples automatically, press the **Shift** key while clicking the first and last vial within a set. To perform multiple injections from the same vial, press the **Ctrl** key while clicking the vial location. The red circle changes to a green circle.

---

**Set Quantitation Details in the Batch Editor (Optional)**

If a quantitation method is used with a batch and if the user does not want to select quantitation details after acquisition, then the quantitation details must be defined before the batch is submitted.

The appropriate Internal Standard and Standard columns are shown in the Quantitation tab according to the quantitation method selected in the Sample tab.

1. With a batch file open in the **Batch Editor** window, click the **Quantitation** tab.
2. Select the set containing the samples.
3. Select a **Quant Type** for all the samples from the list in the cell.
4. If applicable, type the peak concentration in the Analyte column.
5. If applicable, type the Internal Standard.
6. Repeat this procedure for each set in the batch.
7. Save the file.

**Note:** The order of samples can be edited before the samples are submitted to the queue. To change the order of a sample, on the Submit tab, double-click any of the numbers at the far left of the table (a very faint square box is shown), and then drag them to the new location.

### Stop Sample Acquisition

When a sample acquisition is stopped, the current scan finishes before the acquisition is stopped.

1. In the Queue Manager, click the sample in the queue after the point where acquisition should stop.
2. On the Navigation bar, click Acquire.
3. Click Acquire > Stop Sample.

   The queue stops after the current scan in the selected sample is complete. The sample status in the Queue Manager (Local) window changes to Terminated, and all other samples following in the queue are Waiting.

4. To continue processing the batch, click Acquire > Start Sample.

### Import and Submit Batch Files

Users can import a text file containing batch information instead of creating a batch in the Batch Editor. If all the sample details are in a spreadsheet, then it is faster to rearrange and import the data in the spreadsheet than to manually type the data into the Batch Editor.

Before importing batch information from a text file, make sure that the data in the file is organized and formatted correctly. In particular, the column headings in the spreadsheet must match the Batch Editor column headings.

### Build a Batch as a Text File

**Prerequisites**

Make sure that the active hardware profile includes all of the devices to be used to acquire the samples.

To make sure that the text file includes the proper headings, create a batch using the Batch Editor, export it as a text file, type the appropriate values in a spreadsheet editor, and then import the file back into the Batch Editor. Users can export a batch only if it contains at least one set with at least one sample. The saved text file can be used again later as a template.
1. In the **Batch Editor**, create a single-set, single-sample batch.

2. Click **File > Export**.
   
   The **Save As** dialog opens.

3. Type a name for the text file in the **File name** field and then click **Save**.

4. Open the text file in a spreadsheet program such as Microsoft Excel.

5. Type, or copy and paste, the details for the samples: one sample per row, with the details under the appropriate headings.

   **Note:** Do not delete any of the columns. The columns in the spreadsheet must match the columns in the Batch Editor.

6. Save the modified text file as a .txt or .csv file and then close the spreadsheet program.

   The text file is now ready to be imported into the Batch Editor.

**Import a Batch as a Text File**

1. In the **Batch Editor**, in the **Sample** tab, right-click, and then click **Import From > File**.

   The **Open** dialog opens.

2. Click the required text file and then click **Open**.

   If an autosampler is used, then the **Select Autosampler** dialog opens.

   **Note:** If the saved text file is not visible in the **Files of type** list, then select **Microsoft Text Driver (*.txt; *.csv)**. Files with the extension .txt are shown in the field.

3. In the autosampler list, select the autosampler and then click **OK**.

   The sample table fills with the details from the text file.

4. Submit the batch.

**Batch Editor Right-click Menu**

Right-click in the **Batch Editor** table to access the options.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Opens a batch file.</td>
</tr>
<tr>
<td>Import From</td>
<td>Imports a file.</td>
</tr>
</tbody>
</table>
Function Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save As Batch</td>
<td>Saves the batch with a different name.</td>
</tr>
<tr>
<td>Save As a Template</td>
<td>Saves the batch as a template. Used with the Express View feature.</td>
</tr>
<tr>
<td>Hide/Show Column</td>
<td>Hides or shows a column.</td>
</tr>
<tr>
<td>Save Column Settings</td>
<td>Saves the batch column settings.</td>
</tr>
<tr>
<td>Add Custom Column</td>
<td>Adds a custom column.</td>
</tr>
<tr>
<td>Delete Custom Column</td>
<td>Deletes a custom column.</td>
</tr>
<tr>
<td>Fill Down</td>
<td>Copies the same data into the selected cells.</td>
</tr>
<tr>
<td>AutoIncrement</td>
<td>Automatically increments data into the selected cells.</td>
</tr>
<tr>
<td>Delete Samples</td>
<td>Deletes the selected row.</td>
</tr>
<tr>
<td>Select Autosampler</td>
<td>Selects an autosampler.</td>
</tr>
</tbody>
</table>

Queue States and Device Status

The Queue Manager shows queue, batch, and sample status. Detailed information about a particular sample in the queue can also be viewed.

Queue States

The current state of the queue is indicated in the Queue Server.

Figure 10-5 Queue Server Indicator Showing Normal Mode

![Queue Server Indicator Showing Normal Mode](image)

Figure 10-6 Queue Server Indicator Showing Tune Mode

![Queue Server Indicator Showing Tune Mode](image)

The first icon indicates the queue state. The second icon indicates whether the queue is in Tune mode (for tuning) or Normal mode (for running samples). Table 10-2 describes the icons and queue states.
**Table 10-2 Queue States**

<table>
<thead>
<tr>
<th>Icons</th>
<th>State</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Not Ready" /></td>
<td>Not Ready</td>
<td>The hardware profile is deactivated and the queue is not accepting any sample submissions.</td>
</tr>
<tr>
<td><img src="image" alt="Stand By" /></td>
<td>Stand By</td>
<td>The hardware profile has been activated, but all devices are idle. Pumps are not running and gases are turned off.</td>
</tr>
<tr>
<td><img src="image" alt="Warming Up" /></td>
<td>Warming Up</td>
<td>The mass spectrometer and devices are equilibrating, columns are being conditioned, the autosampler needle is being washed, and column ovens are reaching temperature. The duration of equilibration is selected by the operator. From this state, the system can go to the <strong>Ready</strong> state.</td>
</tr>
<tr>
<td><img src="image" alt="Ready" /></td>
<td>Ready</td>
<td>The system is ready to start running samples and the devices have been equilibrated and are ready to run. In this state, the queue can receive samples and will run after samples are submitted.</td>
</tr>
<tr>
<td><img src="image" alt="Waiting" /></td>
<td>Waiting</td>
<td>The system will automatically begin acquisition when the next sample is submitted.</td>
</tr>
<tr>
<td><img src="image" alt="PreRun" /></td>
<td>PreRun</td>
<td>The method is being downloaded to each device and device equilibration is occurring. This state occurs before the acquisition of each sample in a batch.</td>
</tr>
<tr>
<td><img src="image" alt="Acquiring" /></td>
<td>Acquiring</td>
<td>The method is running and data acquisition is occurring.</td>
</tr>
<tr>
<td><img src="image" alt="Paused" /></td>
<td>Paused</td>
<td>The system has been paused during acquisition.</td>
</tr>
</tbody>
</table>

**View Instrument and Device Status Icons**

Icons representing the mass spectrometer and each device in the active hardware configuration are shown on the status bar in the bottom right corner of the window. The user can view the detailed status of an LC pump to...
determine whether the LC pump pressure is appropriate or view the detailed status of the mass spectrometer to confirm the temperature of the ion source.

**Note:** For each status, the background color can be red. A red background indicates that the device encountered an error while in that state.

- On the status bar, double-click the icon for the device or mass spectrometer.

  The **Instrument Status** dialog opens.

**Table 10-3 Instrument and Device Status Icons**

<table>
<thead>
<tr>
<th>Status</th>
<th>Icon</th>
<th>Background Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Idle</td>
<td><img src="green.png" alt="Green" /> <img src="yellow.png" alt="Yellow" /></td>
<td>Green or yellow</td>
<td>The device is not running. If the background color is yellow, then the device should be equilibrated before it is ready to run. If the background color is green, the device is ready to run.</td>
</tr>
<tr>
<td>Equilibrating</td>
<td><img src="green.png" alt="Green" /> <img src="yellow.png" alt="Yellow" /></td>
<td>Green or yellow</td>
<td>The device is equilibrating.</td>
</tr>
<tr>
<td>Waiting</td>
<td><img src="green.png" alt="Green" /> <img src="yellow.png" alt="Yellow" /></td>
<td>Green</td>
<td>The device is waiting for a command from the software or another device, or for some action by the operator.</td>
</tr>
<tr>
<td>Running</td>
<td><img src="green.png" alt="Green" /> <img src="yellow.png" alt="Yellow" /></td>
<td>Green</td>
<td>The device is running a batch.</td>
</tr>
<tr>
<td>Aborting</td>
<td><img src="green.png" alt="Green" /> <img src="yellow.png" alt="Yellow" /></td>
<td>Green</td>
<td>The device is aborting a run.</td>
</tr>
<tr>
<td>Downloading</td>
<td><img src="green.png" alt="Green" /> <img src="yellow.png" alt="Yellow" /></td>
<td>Green</td>
<td>A method is being transferred to the device.</td>
</tr>
<tr>
<td>Ready</td>
<td><img src="green.png" alt="Green" /> <img src="yellow.png" alt="Yellow" /></td>
<td>Green</td>
<td>The device is not running, but is ready to run.</td>
</tr>
<tr>
<td>Error</td>
<td><img src="red.png" alt="Red" /></td>
<td>Red</td>
<td>The device has encountered an error that should be investigated.</td>
</tr>
</tbody>
</table>

**Queue Right-click Menu**

Right-click in the Queue table to access the options.
## Operating Instructions — Batches

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Details</td>
<td>Opens the Sample Details dialog.</td>
</tr>
<tr>
<td>Reacquire</td>
<td>Acquires a sample again.</td>
</tr>
<tr>
<td>Insert Pause</td>
<td>Inserts a pause, in seconds, between two samples.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes either the batch or the selected samples.</td>
</tr>
<tr>
<td>Move Batch</td>
<td>Moves the batch within the queue.</td>
</tr>
<tr>
<td>Sort</td>
<td>Sorts on the preselected column.</td>
</tr>
<tr>
<td>Column Settings</td>
<td>Changes the column settings.</td>
</tr>
</tbody>
</table>
Use the sample files found in the Example folder to learn how to select samples for quantitation, how to select preset queries and create table-specific queries, and how to analyze the acquired data. For more information about the following topics, refer to the Advanced User Guide:

- Metric Plots
- Layout of a Results Table

Quantitative Analysis

Quantitative analysis is used to find the concentration of a particular substance in a sample. By analyzing an unknown sample and comparing it to other samples containing the same substance with known concentrations (standards), the software can calculate the concentration of the unknown sample. The process involves creating a calibration curve using the standards and then calculating the concentration for the unknown sample. The calculated concentrations of each sample are then available in a Results Table.

Quantitation Methods

A quantitation method is a set of parameters used to generate peaks in a sample. The quantitation method can include parameters used to locate and integrate peaks, generate standard curves, and calculate unknown concentrations. A previously saved quantitation method can be selected from the Quantitation menu in the batch. For information about creating a batch, refer to Add Sets and Samples to a Batch on page 87.

The user can create a quantitation method before data acquisition and then apply the method to the quantitative data automatically after the batch is complete. Alternatively, a quantitation method can be created and applied post-acquisition.

Three tools can be used to create a quantitation method: the Quantitation Wizard, the Build Quantitation Method, and Quick Quant.

Quantitation Wizard

With the Quantitation Wizard, a Results Table is generated at the same time as the quantitation method. Alternatively, an existing quantitation method can be used to quantitate different sets of data. This is the most common way of creating a quantitation method.

Build Quantitation Method

The Build Quantitation Method does not generate a quantitation Results Table although the method can subsequently be used in the Quantitation Wizard to create a Results Table. The Build Quantitation Method can
also be used to change existing quantitation methods. This is the most flexible way of creating a quantitation method.

**Quick Quant**

*Quick Quant* is part of the **Batch Editor**. Use *Quick Quant* to add compound concentrations prior to data acquisition. Because a sample has not been acquired, a representative sample cannot be selected nor can peaks be reviewed. With this process, only the method components are defined.

**About Results Tables**

Results tables summarize the calculated concentration of an analyte in each unknown sample based on the calibration curve. Results tables also include the calibration curves as well as statistics for the results. The user can customize the results tables and view the results tables in layouts.

The data from a results tables can be exported to a .txt file for use in other applications, such as Microsoft Excel. The user can also export data in the table or just the data in the visible columns.

**Quantitation Methods and Results Tables**

For the following procedures, use the sample data that is installed with the software. **PK Data** contains the batches **Mix_Batch1** and **Mix_Batch2**. These sample batches are used to demonstrate the usefulness of metric plots to isolate problematic samples. The ions scanned were reserpine (609.3/195.0), minoxidil (210.2/164.2), tolbutamide (271.1/91.1) and rescinnamine (635.3/221.2), which is the internal standard. Batch 1 contains no errors in terms of sample preparation, whereas Batch 2 contains a QC sample where the internal standard was added twice (sample QC2).

**Create a Method Using the Quantitation Method Editor**

<table>
<thead>
<tr>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Switch Between Projects and Subprojects on page 61</em></td>
</tr>
<tr>
<td><em>Show Basic Quantitative Data on page 121</em></td>
</tr>
</tbody>
</table>

1. On the Navigation bar, under **Quantitate**, double-click **Build Quantitation Method**.

   The **Select Sample** dialog opens.

2. Double-click the **Triple Quad** folder in the **Data Files** list.

3. Select **Mix_Batch_2. wiff**.

   The samples in the selected data file are shown in the **Samples** list.
4. Click **OK**.

5. In the **Internal Standards** table, in the **Name** column, select rescinnamine (635.3/221.2).

6. In the **Analytes** table, do the following:
   a. In the **Name** column, select **reserpine**.
   b. In the **Internal Standard** column, from the list, select the internal standard to be associated with each analyte.
   c. In the **Q1/Q3** column, select **609.3/195.0**.
   d. If required, add one or more of the other compounds for a more complex analysis.

**Note:** If the Compound ID field was populated for the samples and internal standards in the acquisition method, then in the Analytes table, the Name field and Q1/Q3 field are populated.

7. Click the **Integration** tab.

   The preset integration parameters are suitable for most peaks.

8. If the integration is not suitable, then change the algorithm.

9. Click the **Show or Hide Parameters** icon to show the additional integration algorithms.

10. Click the **Calibration** tab.

   The preset parameters are suitable for these samples.

11. Save the quantitation method.

   The new method can be used when a batch is created in the **Batch Editor** or when the **Quantitation Wizard** is used to generate a **Results Table**.

**Tip!** The quantitation method can only be used in the current project unless it is copied to another project. To do this, click **Tools > Project > Copy Data**. A new project must be created and selected to be available for use.
Create a Results Table Using the Quantitation Wizard

Prerequisites

- Switch Between Projects and Subprojects on page 61
- Show Basic Quantitative Data on page 121

1. On the Navigation bar, under Quantitate, double-click Quantitation Wizard.
   The Create Quantitation Set - Select Samples page opens.
2. Double-click the Triple Quad folder in the Available Data Files list.
3. Select Mix_batch_2. wiff.
4. Click Add All.

   **Note:** We recommend that users do not process or report results from any sample for which acquisition was abnormally or unexpectedly terminated.

5. Click Next.
   The Create Quantitation Set - Select Settings & Query page opens.
6. Click Select Existing: Query in the Default Query section.
7. Select Accuracy 15% from the Query list.

   **Note:** To create a query at the same time, refer to Create a Standard Query on page 104.

8. Click Next.
   The Create Quantitation Set - Select Method page opens.
9. Click Choose Existing Method.
10. Select PK Data_Mix.qmf from the Method list.
11. Click Finish.
    The Results Table opens.

   **Tip!** To add or remove samples in the Results Table, click Tools > Results Table > Add/Remove Samples.

12. Save the Results Table.
Create a Standard Query

A query and a standard query can be created numerous ways. The following is one example. For more information about creating queries, refer to the Help.

1. On the Navigation bar, under Quantitate, double-click Quantitation Wizard.
2. Select samples in the Create Quantitation Set - Select Samples page.
3. Click Next.
4. In the Select Settings & Query page, in the Default Query section, select Create New Standard Query.
5. Type a query name.

Figure 11-1 Create Quantitation Set — Select Settings & Query Page

Note: We recommend that users do not change datafile (.wiff) names if a Results Table includes samples from that file.

Tip! Well-formatted reports can be created from a Results Table using the Reporter software. We recommend that the user validate the results if a Reporter template that contains a query is used. Refer to Reporter Software on page 134.
6. Click **Next**.

**Figure 11-2 Create Quantitation Set — Create Default Query Page**

7. In the **Maximum Allowed Accuracy Variation for QCs (%)** table in the **Max. Variation** column, type the maximum allowable percent of variation for each QC, for example 5 is ± 5%, in the same row as the corresponding concentration. If the concentrations were not specified during acquisition, then they are not shown here. In this case, type them in the **Concentration** column.

8. In the **Maximum Allowed Accuracy Variation for Standards (%)** table, in the **Max. Variation** column, type the maximum allowable percent of variation for each standard, for example 10 is ±10%, in the same row as the corresponding concentration. If the concentrations were not specified during acquisition, then they are not shown here. Type the concentrations in the **Concentration** column.

9. Click **Next**.
10. Select or create a method.

11. Click **Finish**.

The query is applied as a standard query. The query results are shown as a Pass or Fail entry in the Standard Query Status column of the **Results Table**.

**Tip!** To return to the full view, right-click and then click **Full**.

### Results Table Right-click Menu

Right-click in the **Results Table** to access the options shown in **Table 11-1**.

### Table 11-1 Results Table Right-click Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full</td>
<td>Shows all the columns.</td>
</tr>
<tr>
<td>Summary</td>
<td>Shows specific columns.</td>
</tr>
<tr>
<td>Analyte</td>
<td>Shows a specific analyte.</td>
</tr>
<tr>
<td>Analyte Group</td>
<td>Creates an analyte group.</td>
</tr>
</tbody>
</table>
Peak Review and Manual Integration of Peaks

Use peak review to survey the peaks that the software has identified and then redefine the peak or the start and end points where required.

After identifying the analytes and internal standards that the software must find, the software searches for the peaks in the samples. When the software identifies a peak, it shows the chromatograms for each analyte and internal standard in the Create Quantitation Method: Define Integration page of the Standard Wizard or on the Integration tab of the Full Method Editor. The user can confirm the peaks that are found or change the quantitation method to better define the peaks. We recommend that users manually review all integration results.

Review Peaks

During peak review, the user might want to view a peak in its entirety or to examine the baseline to find out how well the software found the start and end points of the peak. The automatic zooming feature can be used to do either.

To help the software find a peak, define the exact start and end points of the peak and background manually. These changes will apply only to that individual peak unless the global method is updated.
Note: We recommend that manually integrated results be validated.

Tip! To review an individual peak, right-click on a point on the curve and then click *Show Peak*. The software opens the **Peak Review** window with the selected peak.

1. Right-click in the **Results Table** and then click **Analyte**.
2. Select a sample.
3. Click **Tools > Peak Review > Pane**.
   The peaks are shown below the **Results Table** with only the peaks listed in the **Results Table**.
4. Right-click in the pane and then click **Options**.
5. In the **Peak Review Options** dialog, in the **Appearance** section, change **Num. rows** to 1 and **Num. columns** to 2.
6. In the **Automatic Zooming** section, click **Zoom Y axis to: 100% of largest peak** to show the entire peak.

**Figure 11-4 Peak Review Options Dialog**
7. Click **OK**.

8. To move through the peaks, click the right-pointing arrow. Refer to **Figure 11-5**.

9. Go to the second injection of standard 3.

   In this example, the peak can be integrated closer to the baseline by selecting the Specify Parameters option.

   **Tip!** To move to a specific peak in the **Peak Review** pane, select the corresponding row in the **Results Table**.

---

**Figure 11-5 Peak Review Pane**

![Figure 11-5 Peak Review Pane](image)

---

<table>
<thead>
<tr>
<th>Item</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Number of rows</td>
</tr>
<tr>
<td>2</td>
<td>Number of columns</td>
</tr>
<tr>
<td>3</td>
<td><strong>Zoom Y-axis to 100% of largest peak</strong> to show the entire peak</td>
</tr>
<tr>
<td>Item</td>
<td>Definition</td>
</tr>
<tr>
<td>------</td>
<td>------------</td>
</tr>
<tr>
<td>1</td>
<td>Arrows: Click to move through the peaks.</td>
</tr>
<tr>
<td>2</td>
<td>Show or Hide Parameters: Click to show the integration parameters.</td>
</tr>
<tr>
<td>3</td>
<td>Integration parameters: Click to change the parameters.</td>
</tr>
</tbody>
</table>

10. Click **Show or Hide Parameters** twice.

11. Click **Specify Parameters - MQ III**.

12. Change the **Noise Percent** value.

13. Click **Apply**.

   The peak is integrated closer to the baseline.

14. If the change does not improve the peak integration, then adjust the **Noise Percent** parameter until the optimal value is found.

**Note:** The **Update Method** function only updates the algorithm values for that specific analyte (or internal standard) and not all analytes.

15. To update the algorithm for all peaks, right-click in the pane and then click **Update Method**.

**Figure 11-6 Update Method**

![Update Method Figure](attachment:image.png)
Manually Integrate Peaks

Manually integrating peaks should be done last, to limit person-to-person variability. Manually integrate peaks only if all the peaks have not been found after the algorithm parameters have been adjusted and updated.

**Note:** Peaks that are manually integrated, or where the algorithm was changed for only that peak, are identified in the Record Modified column of the Results Table, as are peaks that have algorithm parameter changes for a sample that are not applied to the entire analyte group.

1. In the Peak Review pane, click **Manual Integration Mode**.

![Figure 11-7 Peak Review Pane: Manual Integration](image)

2. Zoom in on the lower 10% of the peak.

![Figure 11-8 Peak Review Pane: Zooming in on a Peak](image)

3. Move the cross-hair to where the start of the peak is to be defined and then drag the cross-hair to where the end of the peak is to be defined.
The software shades the area bounded by the base and sides of the peak. Peak parameters are gray as they are no longer applicable because the peak was drawn manually.

4. Do one of the following:

- To make this change permanent, click **Accept**.
- To discard the changes, clear the **Manual Integration** check box.

**Tip!** If a peak was correct as originally selected, right-click the peak and then click **Revert to Method**.

### Peak Review Right-Click Menu

Right-click in the **Peak Review** window or pane to access the options shown in **Table 11-2**.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>Opens the <strong>Peak Review Options</strong> dialog.</td>
</tr>
<tr>
<td>Sample Annotation</td>
<td>Opens the <strong>Sample Annotation</strong> dialog.</td>
</tr>
<tr>
<td>Save Active to Text File</td>
<td>Saves the selected peak as a text file.</td>
</tr>
<tr>
<td>Show First Page</td>
<td>Goes to the first sample.</td>
</tr>
<tr>
<td>Show Last Page</td>
<td>Goes to the last sample.</td>
</tr>
<tr>
<td>Slide Show Peak Review</td>
<td>Opens the slide show.</td>
</tr>
<tr>
<td>Update Method</td>
<td>Updates the algorithm for all peaks.</td>
</tr>
<tr>
<td>Revert to Method</td>
<td>Selects a redefined peak based on the current quantitation method.</td>
</tr>
<tr>
<td>Delete Pane</td>
<td>Deletes the active pane.</td>
</tr>
</tbody>
</table>

### Calibration Curves

Use calibration curves to find the calculated concentration of samples, including quality control (QC) samples. QC samples are added to a batch to estimate the data quality and accuracy of standards in the batch. QC samples have known analyte concentrations but are treated as unknowns so that the measured concentrations can be compared to the actual value.
The calibration curve is generated by plotting the concentration of the standard versus its area or height. If an internal standard is used, then the ratio of the standard concentration or internal standard versus the ratio of the standard peak height or area to the internal standard peak height or area is plotted. The area or height ratio of a sample is then applied to this curve to find the concentration of the sample, as shown in the Results Table. A regression equation is generated by this calibration curve according to the regression that was specified. The regression equation is used to calculate the concentration of the unknown samples.

**View Calibration Curves**

The user can view the calibration curve and change the regression options in an open Results Table. If two or more Results Tables are open, then the calibration curves can be overlaid. To overlay curves, make sure that the method used to create the tables is the same.

Plot a calibration curve to see the curve used for regression. The Calculated Concentration field in the Results Table reflects any changes resulting from the fit of the curve to the points of the standard.

**Note:** This option is available only when a Results Table is open in the workspace.

1. Open a **Results Table**.
2. Click **Tools > Calibration > Pane**.
   
   The Calibration Curve pane containing the calibration curve opens.
3. If there is more than one analyte, then use the following steps to view the calibration curve for another analyte:
   a. From the **Analyte** list, select an analyte.
   b. If required, from the next list, select **Area** or **Height**.
4. To change the regression options for the calibration curve, do the following:
   a. Click **Regression**.
   
   **Figure 11-9 Regression Options Dialog**

   ![Regression Options Dialog](image)

   b. Select **Linear** in the **Fit** list.
c. Select $1/x$ in the Weighting list.

d. Click OK.

The calibration curve opens. The user can review individual peaks on the curve or exclude points from the curve to produce a better curve.

5. If required, repeat these steps to create a more appropriate curve.

6. To save the changes, click Accept.

**Overlay Calibration Curves**

**Tip!** To examine the curve for one table more closely, right-click the curve and then click Active Plot. Select the curve to be plotted on top.

1. With two or more open Results Tables, view a calibration curve for one of the tables.

2. Right-click the calibration curve and then click Overlay.

**Figure 11-10 Overlay Dialog**

3. Select the tables to overlay with the current curve.

4. Click OK.

The software plots the curves for all selected tables on the same graph.

**Calibration Curve Right-Click Menu**

Right-click in the Calibration window or pane table to access the options shown in Table 11-3.
Table 11-3 Calibration Curve Right-click Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude (Include)</td>
<td>Right-click the point and then click <strong>Exclude</strong> to exclude the point from the curve. Right-click the point and then click <strong>Include</strong> to include the point.</td>
</tr>
<tr>
<td>Exclude All Analytes (Include All Analytes)</td>
<td>Right-click a point and then click <strong>Exclude All Analytes</strong> to exclude all the analytes from the curve. Right-click a point and then click <strong>Include All Analytes</strong> to include the points.</td>
</tr>
<tr>
<td>Show Peak</td>
<td>Reviews an individual peak.</td>
</tr>
<tr>
<td>Overlay</td>
<td>Overlays two graphs.</td>
</tr>
<tr>
<td>Active Plot</td>
<td>Determines which plot is active.</td>
</tr>
<tr>
<td>Legend</td>
<td>Shows the graph legend.</td>
</tr>
<tr>
<td>Log Scale X Axis*</td>
<td>Uses a log scale for the x-axis.</td>
</tr>
<tr>
<td>Log Scale Y Axis*</td>
<td>Uses a log scale for the y-axis.</td>
</tr>
<tr>
<td>Delete Pane</td>
<td>Deletes the active pane.</td>
</tr>
<tr>
<td>Home Graph</td>
<td>Scales the graph to its original size</td>
</tr>
</tbody>
</table>

* A log scale arranges the data points in a more manageable view so that the effect of all points can be monitored simultaneously. For this view, select Log Scale Y Axis versus Log Scale X and not just the log of one axis.

Sample Statistics

Use the **Statistics** window to view the statistics samples, typically for standards and QCs (quality controls). The data from each available batch in the **Results Table** opens in tabular form in the grid and a row of data is shown for each standard or QC concentration.

View the Statistics for Standards and QCs

When more than one **Results Table** is open, statistical information about the standards and QCs for additional batches in the **Statistics** window can be obtained. This facilitates comparison of results between batches and identification of trends in the standards or QCs.

1. Open a **Results Table**.
2. Click **Tools > Statistics**.
3. Select **Concentration** from the **Statistics Metric** list.
4. Select an analyte in the **Analyte Name** field.
5. Select **Standard** in the **Sample Type** field.
   The results are shown.

6. Look at the **%CV** and **Accuracy** columns.
   
   The **%CV** shows the coefficient of variance between the measurements of a single parameter, for example
   the area. **Accuracy** shows how close the plotted point is to the interpolated value.

7. If required, select the **Display Low/High values** check box and then examine the **Low, High** values, and
   **Mean** for each row in the grid. Each row represents standards that have the same concentration levels.

8. Select another analyte.
   
   The results are shown on a per-analyte basis.

9. To check for **Quality Control** variations at the same concentration levels, select **QC** in the **Sample Type**
   field.

### Compare Results Between Batches

The number of analytes and the analyte names must be the same for the data to be combined in the **Statistics**
pane.

1. Open a **Results Tables**.
2. Click **Tools > Statistics**.
3. Do one of the following:

   - Select **Group By Batch** to arrange the results by **Results Table** in the **Conc. as Rows** list.
   - Select **Group By Concentration** to arrange the results in order of concentration in the **Conc. as Rows**
     list.
   - Select **Group By Concentration (no All)** to arrange the results in order of concentration without a
     row showing the statistics for each group or batch in the **Conc. as Rows** list.

   The software sorts the results. At the end of each batch or group, one or two additional rows are shown: All,
   statistics for all **Results Tables** in that group, and Average, (statistics on the statistics for that batch or group.
Use the sample files installed in the Example folder to learn how to view and analyze data using the most common analysis and processing tools. For more information about the following topics, refer to the Advanced User Guide:

- Labeling graphs
- Overlaying and summing spectra or chromatograms
- Performing background subtractions
- Smoothing algorithms
- Working with smoothed data
- Working with centroid data
- Working with contour plots
- Working with the fragment interpretation tool
- Working with library databases and library records

### Open Data Files

**Tip!** To turn off the automatic update on the mass spectrum, right-click the mass spectrum and then click Show Last Scan. If there is a check mark beside Show Last Scan, then the spectrum will update in real-time.


2. In the Data Files list, navigate to the data file to open, select a sample, and then click OK.

   The Select Sample dialog opens. The data acquired from the sample is shown. If data is still being acquired, then the mass spectrum, DAD/UV trace, and TIC continue to update automatically.

### Navigate Between Samples in a Data File

**Note:** Toolbar Icons on page 165 shows the navigation icons used in this procedure.
If samples were saved in separate data files, then open each file individually.

- Open a data file and then do one of the following:
  - Click the icon with the arrow pointing to the right to skip to the next sample in the data file.
  - Click the icon with the arrow curving to the right to skip to a non-sequential sample.
  - In the Select Sample dialog, from the Sample list, select the sample.
  - Click the icon with the arrow pointing to the left to go to the previous sample in the data file.

**Show Experimental Conditions**

The experimental conditions used to collect data are stored in the data file with the results. The information contains the details of the acquisition method used: the MS acquisition method (that is, the number of periods, experiments, and cycles) including instrument parameters and the HPLC device method (LC pump flow rate). In addition, it also contains the MS resolution and mass calibration tables used for the sample acquisition. *Table 12-1* shows the software functionality available when the user views the file information.

- Click *Explore > Show > Show File Information*.

  The File Information pane opens below the graph.

  **Tip!** To create an acquisition method from the File Information pane, right-click the File Information pane and then click *Save Acquisition Method*.

**Table 12-1 Right-click Menu for Show File Information Pane**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies the selected data.</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes data.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all the data in the pane.</td>
</tr>
<tr>
<td>Save To File</td>
<td>Saves data as an .rtf file.</td>
</tr>
<tr>
<td>Font</td>
<td>Changes the font.</td>
</tr>
<tr>
<td>Save Acquisition Method</td>
<td>Saves the acquisition method as a .dam file.</td>
</tr>
</tbody>
</table>
Table 12-1 Right-click Menu for Show File Information Pane (continued)

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Acquisition Method to CompoundDB</td>
<td>Opens the Specify Compound Information dialog. Select the IDs and molecular weights to be saved in the compound database.</td>
</tr>
<tr>
<td>Delete Pane</td>
<td>Deletes the selected pane.</td>
</tr>
</tbody>
</table>

Show Data in Tables

1. Open a data file.
2. Click Explore > Show > Show List Data.
   The data is shown in a pane below the graph.
Figure 12-1 Peak List Tab

Table 12-2 Right-click Menu for Spectral Peak List Tab

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Options</td>
<td>Opens the Select Columns for Peak List dialog.</td>
</tr>
<tr>
<td>Save As Text</td>
<td>Saves the data as a .txt file.</td>
</tr>
<tr>
<td>Delete Pane</td>
<td>Deletes the selected pane.</td>
</tr>
</tbody>
</table>
Table 12-3 Right-click Menu for Chromatographic Peak List Tab

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Peaks in Graph</td>
<td>Show the peaks in two colors in the graph.</td>
</tr>
<tr>
<td>IntelliQuan Parameters</td>
<td>Opens the IntelliQuan dialog.</td>
</tr>
<tr>
<td>Save As Text</td>
<td>Saves the data as a .txt file.</td>
</tr>
<tr>
<td>Delete Pane</td>
<td>Deletes the selected pane.</td>
</tr>
</tbody>
</table>

Show ADC Data

Analog-to-digital converter (ADC) data is acquired from a secondary detector (for example from a UV detector through an ADC card), and is useful for comparison with mass spectrometer data. To make ADC data available, acquire the ADC data and the mass spectrometer data simultaneously and save both in the same file.

1. Open a data file containing ADC data.
2. Click Explore > Show > Show ADC Data.
   The Select ADC Channel dialog opens.

   Figure 12-2 Select ADC Channel Dialog

3. From the Channel list, select a channel.
4. Click OK.
   The ADC data opens in a new pane below the active pane.

Show Basic Quantitative Data

1. Open a data file.
2. Click Explore > Show > Show List Data.
3. In the Peak List tab, right-click and then select Show Peaks in Graph.
Peaks are shown in two colors.

4. To change the peak finding algorithm settings, right-click and then select either Analyst Classic Parameters or Intelliquan Parameters, whichever is active.

5. (Optional) To remove the colored peaks, right-click in the Peak List tab and then clear Show Peaks in Graph.

**Chromatograms**

Refer to Table 12-8 on page 131 for more information about using the available icons.

**Table 12-4 Types of Chromatograms**

<table>
<thead>
<tr>
<th>Types of Chromatograms</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIC (Total Ion Chromatogram)</td>
<td>A chromatographic view generated by plotting the intensity of all ions in a scan against time or scan number. When a data file is opened, it is preset to open as a TIC. If the experiment contains only one scan, then it is shown as a spectrum. If the MCA check box is selected during acquisition of the data file, then the data file opens to the mass spectrum. If the MCA check box is not selected, then the data file opens as the TIC.</td>
</tr>
<tr>
<td>XIC (Extracted Ion Chromatogram)</td>
<td>An ion chromatogram created by taking intensity values at a single, discrete mass value, or a mass range, from a series of mass spectral scans. It indicates the behavior of a given mass, or mass range, as a function of time.</td>
</tr>
<tr>
<td>BPC (Base Peak Chromatogram)</td>
<td>A chromatographic plot that shows the intensity of the most intense ion within a scan versus time or scan number.</td>
</tr>
<tr>
<td>TWC (Total Wavelength Chromatogram)</td>
<td>A chromatographic view created by summing all of the absorbance values in the acquired wavelength range and then plotting the values against time. It consists of the summed absorbances of all ions in a scan plotted against time in a chromatographic pane.</td>
</tr>
<tr>
<td>XWC (Extracted Wavelength Chromatogram)</td>
<td>A subset of TWC. An XWC shows the absorbance for a single wavelength or the sum of the absorbance for a range of wavelengths.</td>
</tr>
<tr>
<td>DAD (Diode Array Detector)</td>
<td>A UV detector that monitors the absorption spectrum of eluting compounds at one or more wavelengths.</td>
</tr>
</tbody>
</table>
Show TICs from a Spectrum

To see an example data file, make sure that the Example project is selected.

- Click Explore > Show > Show TIC.

The TIC opens in a new pane.

Tip! Right-click inside a pane containing a spectrum and then click Show TIC.

Show a Spectrum from a TIC

1. In a pane containing a TIC, select a range.
2. Click Explore > Show > Show Spectrum.

The spectrum opens in a new pane.

Tip! Double-click in the TIC pane at a particular time to show the spectrum.

About Generating XICs

XICs can be generated only from single-period, single-experiment chromatograms or spectra. To obtain an XIC from multi-period or multi-experiment data, split the data into separate panes by clicking the triangle under the X-axis. Refer to Table 12-8 on page 131 for more information about using the available icons.

Several methods are available for extracting ions to generate an XIC, depending on whether chromatographic or spectral data is used. Table 12-5 contains a summary of methods that can be used with chromatograms and spectra.

Table 12-5 Summary of XIC Generation Methods

<table>
<thead>
<tr>
<th>Method</th>
<th>Use with Chromatogram</th>
<th>Use with Spectrum</th>
<th>Extraction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected range</td>
<td>No</td>
<td>Yes</td>
<td>Extracts ions from a selected area in a spectrum.</td>
</tr>
<tr>
<td>Maximum</td>
<td>No</td>
<td>Yes</td>
<td>Extracts ions from a selected area in a spectrum using the most intense peak in the selected area. This option creates an XIC using the maximum mass from the selected spectral range.</td>
</tr>
</tbody>
</table>
Table 12-5 Summary of XIC Generation Methods (continued)

<table>
<thead>
<tr>
<th>Method</th>
<th>Use with Chromatogram</th>
<th>Use with Spectrum</th>
<th>Extraction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base peak masses</td>
<td>Yes</td>
<td>Yes</td>
<td>Can be used only with Base Peak Chromatograms (BPCs). Use the Use Base Peak Masses command to extract ions results in an XIC with a different colored trace for each mass. If the selection includes multiple peaks, then the resulting XIC will have an equal number of colored traces, one for each mass.</td>
</tr>
<tr>
<td>Specified masses</td>
<td>Yes</td>
<td>Yes</td>
<td>Extracts ions from any type of spectrum or chromatogram. Select up to ten start and stop masses for which to generate XICs.</td>
</tr>
</tbody>
</table>

**Generate an XIC Using a Selected Range**

1. Open a data file containing spectra.
2. Select a range by pressing the left mouse button at the start of the range, dragging the cursor to the stop point, and then releasing the left mouse button.
   
   The selection is indicated in blue.
3. Click **Explore > Extract Ions > Use Range**.
   
   An XIC of the selection opens in a pane below the spectrum pane. The experiment information at the top of the pane contains the mass range and the maximum intensity in counts per second.

**Generate an XIC Using the Maximum Peak**

1. Open a data file containing spectra.
2. Select a range.
   
   The selection is indicated in blue.
3. Click **Explore > Extract Ions > Use Maximum**.
   
   An XIC of the maximum peak specified selection opens below the spectrum pane. The experiment information at the top of the pane contains the mass range and the maximum intensity in counts per second.

**Generate an XIC Using Base Peak Masses**

1. Open a data file containing spectra.
2. In a BPC, select the peak from which to extract ions. The selection is indicated in blue.

3. Click **Explore > Extract Ions > Use Base Peak Masses.**

   An XIC of the specified selection opens below the spectrum pane. The experiment information at the top of the pane shows the mass range and the maximum intensity in counts per second.

**Extract Ion by Selecting Masses**

1. Open a spectrum or chromatogram.

2. Click **Explore > Extract Ions > Use Dialog.**

   **Figure 12-3 Extract Ions Dialog**

   ![Extract Ions Dialog](image)

3. Type the values for each XIC to be created. If a stop value is not typed, then the range is defined by the start value.

   - In the **Start** field, type the start value (lower value) for the mass range.
   - In the **Stop** field, type the stop value (higher value) for the mass range.

4. Click **OK.**
An XIC of the selection opens below the chromatogram pane. The experiment information at the top of the pane includes the masses and the maximum intensity in counts per second.

### Generate BPCs

BPCs can be generated only from single-period, single-experiment data.

1. Open a data file.
2. Select an area within a TIC.
   - The selection is indicated in blue.
3. Click **Explore > Show > Show Base Peak Chromatogram**.
   - The selections are shown in the **Start Time** and **End Time** fields.

**Figure 12-4 Base Peak Chromatogram Options**

4. In the **Mass Tolerance** field, type the value to indicate the mass range used to find a peak. The software finds the peak using a value twice the typed range (± the mass value).
5. Type the intensity below which peaks are ignored by the algorithm in the **Minimum Intensity** field.
6. Type the mass that determines the beginning of the scan range in the **Minimum Mass** field.
7. Type the mass that determines the end of the scan range in the **Maximum Mass** field.
8. To set the start and end times, select the **Use Limited Range** check box and do the following:
• In the **Start Time** field, type the time that determines the start of the experiment.
• In the **End Time** field, type the time that determines the end of the experiment.

9. Click **OK**.
The BPC is generated in a new pane.

### Generate XWCs

Up to three ranges can be extracted from a DAD spectrum to generate the XWC. Refer to *Table 12-8 on page 131* for more information about using the available icons.

1. Open a data file that contains a DAD spectrum
2. Right-click anywhere in the pane and then click **Extract Wavelengths**.

![Figure 12-5 Extract Wavelengths Dialog](image)

3. Type **Start** and **Stop** values.
4. Click **OK**.
The XWC opens in a pane below the DAD spectrum.

### Generate DAD Data

Like mass spectrometer data, DAD data can be viewed in chromatogram or spectrum form.

1. Open a data file containing data acquired with a DAD.
   The TWC, which is analogous to a TIC, opens in a pane below the TIC.
2. In the **TWC** pane, click a point to select a single point in time, or highlight an area of the spectrum to select a range of time.
3. Click **Explore > Show** > **Show DAD Spectrum**.
The DAD spectrum opens in a pane below the TWC. The Y-axis shows the absorbance and the X-axis shows the wavelength.

Tip! If the pane with the TWC is closed, then click a point anywhere in the TWC to open it again. Click Explore > Show > Show DAD TWC.

Generate TWCs

A TWC shows total absorbance (mAU) on the Y-axis plotted against time on the X-axis. Refer to Table 12-8 on page 131 for more information about using the available icons.

1. Open a data file that contains a DAD spectrum.
2. Click Explore > Show > Show DAD TWC.

The TWC opens in a pane below the DAD spectrum.

Tip! Right-click inside the pane containing the DAD spectrum and then click Show DAD TWC.

Adjust the Threshold

The threshold is an invisible line drawn parallel to the X-axis of a graph that sets a limit below which the software will not include peaks in a spectrum. The line has a handle, represented by a blue triangle to the left of the Y-axis. Click the blue triangle to view a dotted line that represents the threshold. The threshold can be raised or lowered, but changing the threshold value does not change the data. The software does not label any peaks in the region that lies below the threshold.

1. Open a data file.
2. Do one of the following:
   - To raise the threshold, drag the blue triangle up the Y-axis. To lower the threshold, drag the blue triangle down.
   - Click Explore > Set Threshold. In the Threshold Options dialog that opens, type the threshold value and then click OK.
   - Click Explore > Threshold.

The graph updates to show the new threshold. Peak labeling and the peak list are also updated.
## Chromatogram Panes

### Table 12-6 Right-click Menu for Chromatogram Panes

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Data</td>
<td>Lists the data points and integrates the peaks found in chromatograms.</td>
</tr>
<tr>
<td>Show Spectrum</td>
<td>Generates a new pane containing the spectrum.</td>
</tr>
<tr>
<td>Show Contour Plot</td>
<td>Shows a color-coded plot of a data set, where the color represents the intensity of the data at that point. Only certain MS modes are supported.</td>
</tr>
<tr>
<td>Extract Ions</td>
<td>Extracts a specific ion or set of ions from a selected pane and then generates a new pane containing a chromatogram for the specific ions.</td>
</tr>
<tr>
<td>Show Base Peak Chromatogram</td>
<td>Generates a new pane containing a base peak chromatogram.</td>
</tr>
<tr>
<td>Show ADC Data</td>
<td>Generates a new pane containing the ADC data trace, if acquired.</td>
</tr>
<tr>
<td>Show UV Detector Data</td>
<td>Generates a new pane containing the UV data trace, if acquired.</td>
</tr>
<tr>
<td>Spectral Arithmetic Wizard</td>
<td>Opens the Spectral Arithmetic Wizard.</td>
</tr>
<tr>
<td>Save to Text File</td>
<td>Generates a text file of the pane, which can be opened in Microsoft Excel or other programs.</td>
</tr>
<tr>
<td>Save Explore History</td>
<td>Saves information about changes to processing parameters, also called processing options, that were made when a .wiff file was processed in Explore mode. The processing history is stored in a file with an .EPH (Explore Processing History) extension.</td>
</tr>
<tr>
<td>Add Caption</td>
<td>Adds a caption at the cursor point in the pane.</td>
</tr>
<tr>
<td>Add User Text</td>
<td>Adds a text box at cursor point in the pane.</td>
</tr>
<tr>
<td>Set Subtract Range</td>
<td>Sets the subtract range in the pane.</td>
</tr>
<tr>
<td>Clear Subtract Range</td>
<td>Clears the subtract range in the pane.</td>
</tr>
<tr>
<td>Subtract Range Locked</td>
<td>Locks or unlocks the subtract ranges. If the subtract ranges are not locked, then each subtract range can be moved independently. The subtract ranges are preset to locked.</td>
</tr>
<tr>
<td>Delete Pane</td>
<td>Deletes the selected pane.</td>
</tr>
</tbody>
</table>
### Spectra Panes

Table 12-7 Right-click Menu for Spectra Panes

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Data</td>
<td>Lists the data points and integrates chromatograms.</td>
</tr>
<tr>
<td>Show TIC</td>
<td>Generates a new pane containing the TIC.</td>
</tr>
<tr>
<td>Extract Ions (Use Range)</td>
<td>Extracts a specific ion or set of ions from a selected pane and then</td>
</tr>
<tr>
<td></td>
<td>generates a new pane containing a chromatogram for the specific ions.</td>
</tr>
<tr>
<td>Extract Ions (Use Maximum)</td>
<td>Extracts ions using the most intense peak in a selected area.</td>
</tr>
<tr>
<td>Save to Text File</td>
<td>Generates a text file of the pane, which can be opened in Excel or other</td>
</tr>
<tr>
<td></td>
<td>programs.</td>
</tr>
<tr>
<td>Save Explore History</td>
<td>Saves information about changes to processing parameters, also</td>
</tr>
<tr>
<td></td>
<td>called <strong>Processing Options</strong>, that were made when a .wiff file was</td>
</tr>
<tr>
<td></td>
<td>processed in <strong>Explore</strong> mode. The processing history is stored in a</td>
</tr>
<tr>
<td></td>
<td>file with an .EPH (Explore Processing History) extension.</td>
</tr>
<tr>
<td>Add Caption</td>
<td>Adds a caption at the cursor point in the pane.</td>
</tr>
<tr>
<td>Add User Text</td>
<td>Adds a text box at the cursor point in the pane.</td>
</tr>
<tr>
<td>Show Last Scan</td>
<td>Shows the scan prior to the selection.</td>
</tr>
<tr>
<td>Select Peaks For Label</td>
<td>In this dialog, select the parameters to reduce peak labeling.</td>
</tr>
<tr>
<td>Delete Pane</td>
<td>Deletes the selected pane.</td>
</tr>
<tr>
<td>Add a Record</td>
<td>Adds records and compound-related data, including spectra, to the library.</td>
</tr>
<tr>
<td></td>
<td>An active spectrum is required to perform this task.</td>
</tr>
<tr>
<td>Search Library</td>
<td>Searches the library without constraints or with previously saved</td>
</tr>
<tr>
<td></td>
<td>constraints.</td>
</tr>
<tr>
<td>Set Search Constraints</td>
<td>Searches the library using the criteria typed in <strong>Search Constraints</strong></td>
</tr>
<tr>
<td></td>
<td>dialog.</td>
</tr>
</tbody>
</table>

### Data Processing

Graphical data can be processed many ways. This section provides information and procedures for using some of the most commonly used tools.
The user can zoom in on part of a graph to view a particular peak or an area in greater detail in both spectra and chromatograms. The user can also zoom in repeatedly to view smaller peaks.

We recommend that users do not use the Subsetting features included within the Analyst® software.

**Graphs**

The same data can be examined in different ways. Data can also be kept for comparison purposes before performing processing operations such as smoothing or subtraction.

A window contains one or more panes arranged in such a way that all the panes are fully visible and that they do not overlap.

Panes might be of a variable or fixed size. Panes are automatically tiled within the window and are arranged into column and row format. If the size of a window is changed, then the panes within the window change in size to accommodate the new size. A window cannot be sized to the point where any of the panes become smaller than their minimum size.

Two or more windows or panes containing similar data can be linked, for example, spectra with similar mass ranges. As one pane or window is zoomed in, the other pane zooms in simultaneously. For example, the user can link an XIC to the BPC from which the XIC was extracted. Zooming in the BPC also zooms the XIC, so that both chromatograms show the same magnification.

**Manage Data**

- Use the following menu options or icons to manage data in graphs.

**Table 12-8 Graph Options**

<table>
<thead>
<tr>
<th>To do this…</th>
<th>use this menu option…</th>
<th>…or click this icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy a graph to a new window</td>
<td>Select the graph to copy. Click Explore &gt; Duplicate Data &gt; In New Window.</td>
<td>![Explore Icon]</td>
</tr>
<tr>
<td>Rescale a graph to its original size</td>
<td>Select the graph. Click Explore &gt; Home Graph.</td>
<td>![Home Graph Icon]</td>
</tr>
</tbody>
</table>
Table 12-8 Graph Options (continued)

<table>
<thead>
<tr>
<th>To do this...</th>
<th>use this menu option...</th>
<th>...or click this icon</th>
</tr>
</thead>
</table>
| Move a pane  | • Select the graph. Click **Window > Move Pane**.  
|              | • Select the pane or window and then drag it to the new position. This position can be inside the same window or within another window.  
|              | • A four-headed arrow is shown when the cursor is on the boundary of the active window or pane.  
|              | • If the pane is at the top or bottom of the target pane, then the pane moves above or below that pane, respectively.  
|              | • If the pane is at the left or right of the target pane, then the pane moves to the left or right of that pane, respectively.  
|              | • If the pane is at any other position, then the pane moves to the target row. The drop shadow of the pane as the pane is moved indicates its new position. | ![icon](image) |
| Link panes   | a. With the two graphs open, click one to make that pane active.  
|              | b. Click **Explore > Link** and then click the other pane. | ![icon](image) |
| Remove linking | Close one of the panes. Click **Explore > Remove Link**. | ![icon](image) |
| Delete a pane | Select the graph. Click **Window > Delete Pane**. | ![icon](image) |
| Lock a pane  | Select the graph. Click **Window > Lock Panes**. | ![icon](image) |
| Hide a pane  | Select the graph. Click **Window > Hide Pane**. | ![icon](image) |
Table 12-8 Graph Options (continued)

<table>
<thead>
<tr>
<th>To do this...</th>
<th>use this menu option...</th>
<th>...or click this icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize a pane</td>
<td>Select the graph. Click <strong>Window</strong> &gt; <strong>Maximize Pane</strong>.</td>
<td>![icon]</td>
</tr>
<tr>
<td>Tile panes</td>
<td>Select the graph. Click <strong>Window</strong> &gt; <strong>Tile all Panes</strong>.</td>
<td>![icon]</td>
</tr>
</tbody>
</table>

**Zoom In on the Y-axis**

1. Move the pointer to the left of the y-axis to either side of the area to be expanded and then drag away from the starting point in a vertical direction while holding the left mouse button.

   A box is drawn along the y-axis representing the new scale.

   **Note:** Take care when zooming in on the baseline. Zoom in too far and the zoom-in box closes.

2. Release the mouse button to draw the graph to the new scale.

**Zoom In on the X-axis**

**Tip!** To return the graph to the original scale, double-click either axis. To restore the entire graph to the original scale, click **Explore** > **Home Graph**.

1. Move the pointer under the x-axis to either side of the area to be expanded and then drag away from the starting point in a horizontal direction while holding the left mouse button.

2. Release the mouse button to draw the graph to the new scale.
The Reporter software extends the reporting functionality available in the Analyst® software.

The Reporter software can be used to create custom reports with Microsoft Word and Excel (2010 or 2013). The Reporter software has the following features:

- Provides a variety of reports that use the data available in a Results Table, in file information, and in quantitative peak review windows.

- Uses Microsoft Word templates to provide the format information needed when generating reports. These templates can be created or modified to provide customized report formats. Refer to the Help for information about creating or editing the Report Template Editor.

- Contains a blank starting template that can be used in the Analyst® software Reporter editing environment to design report templates to meet most reporting requirements.

- Automatically prints, exports to Adobe Portable Document Format (pdf), and delivers results by e-mail.

- Generates reports from custom software applications that use the available Analyst® software programming libraries.

Reporter software can be used as follows:

- Within the Analyst® software to manually generate a report or set of reports.

- By a batch script to automate report generation within a batch. Users can generate reports on a sample-by-sample basis, either during or after batch acquisition.

- By applications that do not use the Analyst® software.
Reporter User Interface

Figure 13-1 Analyst Reporter

<table>
<thead>
<tr>
<th>Item</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>File &gt; Exit</td>
<td>Exits the program and releases all resources.</td>
</tr>
<tr>
<td>2</td>
<td>Settings &gt; Select Output Language</td>
<td>Sets the language dictionary that will be used to replace language tags within a report template. Templates that contain language tags can be used to generate reports in any language. The language tags are replaced with text from a matching tag in the dictionary file for the selected language. These dictionary files are contained in the folder: C:\Program Files\AB SCIX\AnalystReporter\Resources\Languages on Windows 7 32-bit operating systems or C:\Program Files (x86)\AB SCIX\AnalystReporter\Resources\Languages on Windows 7 64-bit operating systems.</td>
</tr>
<tr>
<td>Item</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>2</td>
<td>Settings &gt; Select Library</td>
<td>Browse to a spectral library. This library will be used for matching and scoring MS/MS data from <strong>Results Tables</strong> that contain data from information dependent acquisition (IDA) triggered MS/MS scan types.</td>
</tr>
<tr>
<td>2</td>
<td>Settings &gt; Select Template Folder</td>
<td>Sets the folder from which the available templates will be read. To return to the default template folder, select the Default option.</td>
</tr>
<tr>
<td>3</td>
<td>Help &gt; About</td>
<td>Shows information about the version of Reporter software currently installed.</td>
</tr>
<tr>
<td>4</td>
<td>Current Output Language</td>
<td>Shows the currently selected language dictionary used for replacing language tags within a report template. The language dictionary can be selected using <strong>Settings &gt; Select Output Language</strong>.</td>
</tr>
<tr>
<td>5</td>
<td>Current Spectral Library</td>
<td>Shows the currently selected spectral library. The spectral library can be selected using <strong>Settings &gt; Select Library</strong>.</td>
</tr>
<tr>
<td>6</td>
<td>Available Templates and Description</td>
<td>Shows a list of available report templates. Selecting a template will show a description of the template. To change the folder from which available templates are read, select <strong>Settings &gt; Select Template Folder &gt; Browse</strong>.</td>
</tr>
<tr>
<td>7</td>
<td>Output Format</td>
<td>Shows the output formats that are supported by the Reporter software. Only formats that are compatible with the selected report template are enabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Word: Microsoft Word document (.docx) is produced. This document can be viewed by Microsoft Word 2010 and above.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PDF: A report is created directly in PDF format.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• HTML: Microsoft Word is used to generate an HTML file. Associated image files are stored in a folder with the same name as the HTML file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Excel: A plain text file (.csv) is produced. Report templates that contain values separated by commas can be opened in Microsoft Excel, where each value will be shown in a separate cell. Only templates that are specifically marked as text-compatible can be used for this output format.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Text: A plain text document (.txt) is produced. Only templates that are specifically marked as text-compatible can be used for this output format.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Print Automatically: After the report has been created it is printed to the selected printer. Select any available printer.</td>
</tr>
</tbody>
</table>
Generate Reports

The Reporter software extracts numerical data from the Results Table and sample and graphical information from the .wiff file.

Select a template in the Available Template field.

1. Open a Results Table.
3. In the Analyst Reporter dialog, in the Available Templates field, select a template.
4. Click the PDF output format.
   The Word option is pre-selected and the report is automatically saved in the current project Results folder. If this option is not selected, then the report is created and opened in Word or printed as selected, but the report is not saved. This lets the user edit the report in Word prior to saving the original report.
5. Select either one document containing all samples or multiple documents with one sample in each.
6. Select the Print Automatically check box to print the reports automatically on a pre-selected printer.
   The Default Printer set in Windows is used unless a different printer is selected. The Reporter tool retains the selected printer between operations. If the printer is set to a .PDF printer driver, then the Reporter generates .PDF file versions of the created reports automatically.
7. Click Create Report.
   The screen shows various progress indicators as the tool opens the template and populates it with data from the Results Table. Some reports can take seconds to generate, others can take longer. A large data set with many MRM transitions or a large number of graphics might result in reports of several hundred pages that take hours to generate.
Recommended Maintenance Schedule

Regularly clean and maintain the system for optimal performance.

Table 14-1 provides a recommended schedule for cleaning and maintaining the system.

**Tip!** Perform maintenance tasks regularly to make sure that the mass spectrometer is performing optimally.

For information on maintaining the ion source, refer to the ion source *Operator Guide*.

Contact a Qualified Maintenance Person (QMP) to order consumable parts. Contact a SCIEX Field Service Employee (FSE) for maintenance service and support.

**Table 14-1 Maintenance Tasks**

<table>
<thead>
<tr>
<th>Component</th>
<th>Frequency</th>
<th>Task</th>
<th>For more information...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mass Spectrometer</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>System</td>
<td>Daily</td>
<td>Inspect for leaks</td>
<td>Refer to Chemical Precautions on page 11.</td>
</tr>
<tr>
<td>Curtain plate</td>
<td>Daily</td>
<td>Clean</td>
<td>Refer to Clean the Curtain Plate on page 144.</td>
</tr>
</tbody>
</table>
### Table 14-1 Maintenance Tasks (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>Frequency</th>
<th>Task</th>
<th>For more information...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orifice plate (front)</td>
<td>Daily</td>
<td>Clean</td>
<td>Refer to Clean the Front of the Orifice Plate on page 145.</td>
</tr>
<tr>
<td>Mass spectrometer air filter</td>
<td>Every 6 months</td>
<td>Replace</td>
<td>Contact the local QMP or FSE.</td>
</tr>
<tr>
<td>Roughing pump oil</td>
<td>Annually</td>
<td>Replace</td>
<td>Contact the local QMP or FSE.</td>
</tr>
<tr>
<td>Orifice plate (front and rear)</td>
<td>As needed</td>
<td>Clean</td>
<td>Contact the local QMP or FSE.</td>
</tr>
<tr>
<td>IonDrive™ QJet ion guide and IQ0 lens</td>
<td>As needed</td>
<td>Clean</td>
<td>Contact the local QMP or FSE.</td>
</tr>
<tr>
<td>Q0 rod set and IQ1 lens</td>
<td>As needed</td>
<td>Clean</td>
<td>Contact the local QMP or FSE.</td>
</tr>
<tr>
<td>Instrument surfaces</td>
<td>As needed</td>
<td>Clean</td>
<td>Refer to Clean the Surfaces on page 140.</td>
</tr>
<tr>
<td>Drain bottle</td>
<td>As needed</td>
<td>Empty</td>
<td>Refer to Empty the Source Exhaust Drain Bottle on page 145.</td>
</tr>
<tr>
<td>Roughing pump oil</td>
<td>As needed</td>
<td>Check and fill</td>
<td>Contact the local QMP or FSE.</td>
</tr>
</tbody>
</table>

#### Ion Source

<table>
<thead>
<tr>
<th>Component</th>
<th>Frequency</th>
<th>Task</th>
<th>For more information...</th>
</tr>
</thead>
<tbody>
<tr>
<td>TurbolonSpray® and APCI electrodes</td>
<td>As needed</td>
<td>Inspect and replace</td>
<td>Refer to the ion source Operator Guide.</td>
</tr>
<tr>
<td>Corona discharge needle</td>
<td>As needed</td>
<td>Replace</td>
<td>Refer to the ion source Operator Guide.</td>
</tr>
<tr>
<td>Turbo heater</td>
<td>As needed</td>
<td>Replace</td>
<td>Contact the local QMP or FSE.</td>
</tr>
<tr>
<td>Sample tubing</td>
<td>As needed</td>
<td>Replace</td>
<td>Refer to the ion source Operator Guide.</td>
</tr>
</tbody>
</table>

For "As needed" tasks, follow these guidelines:

- Clean the IonDrive™ QJet ion guide and Q0 region if system sensitivity degrades.

**Tip!** Clean the Q0 region regularly to minimize the impact of charging (a significant loss of sensitivity of the ions of interest over a short period of time) on the quadrupoles and lenses. Contact a QMP or FSE.
Clean the Surfaces

Clean the external surfaces of the mass spectrometer after a spill or when they become dirty.

**CAUTION: Potential System Damage. Use only the recommended cleaning methods and materials to avoid damaging the equipment.**

1. Wipe the external surfaces with a soft cloth dampened with warm, soapy water.
2. Wipe the external surfaces with a soft cloth moistened with water to remove any soap residue.

Clean the Front-End

The following warning applies to all procedures in this section:

![WARNING! Hot Surface Hazard. Let the ion source cool for at least 90 minutes before starting any maintenance procedures. Surfaces of the ion source and the vacuum interface components become hot during operation.]

Clean the mass spectrometer front-end using the routine cleaning method, to:

- Minimize unscheduled system downtime.
- Maintain optimum sensitivity.
- Avoid more extensive cleaning that requires a service visit.

When contamination occurs, perform an initial routine cleaning. Clean up to and including the front of the orifice plate. If routine cleaning does not resolve issues with sensitivity, a full cleaning might be necessary. Contact the local QMP or FSE.

This section provides instructions for performing routine cleaning without breaking vacuum and full cleaning under atmospheric pressure, after venting the mass spectrometer.

**Note:** Follow all applicable local regulations. For health and safety guidelines, refer to Chemical Precautions on page 11.

Symptoms of Contamination

The system might be contaminated if any one of the following is observed:
• Significant loss in sensitivity
• Increased background noise
• Additional peaks that are not part of the sample appear in full scan or survey scan methods

If any of these issues are observed, then clean the mass spectrometer front-end.

Required Materials

**Note:** U.S. customers can call 877-740-2129 for ordering information and inquiries. International customers can visit [sciex.com/contact-us](http://sciex.com/contact-us).

• Powder-free gloves (nitrile or neoprene recommended)
• Safety glasses
• Laboratory coat
• Fresh, high-quality (pure) water (at least 18 MΩ de-ionized [DI] water or ultra-pure HPLC-grade water). Old water can contain contaminants that can further contaminate the mass spectrometer.
• MS-grade methanol, isopropanol (2-propanol), or acetonitrile
• Cleaning solution. Use one of:
  • 100% methanol
  • 100% isopropanol
  • 50:50 acetonitrile:water solution (freshly prepared)
  • 50:50 acetonitrile:water with 0.1% acetic acid solution (freshly prepared)
• Clean 1 L or 500 mL glass beaker to prepare cleaning solutions
• 1 L beaker to catch used solvent
• Organic waste container
• Lint-free wipes. Refer to [Tools and Supplies Available from the Manufacturer on page 141](#).
• (Optional) Poly swabs

**Tools and Supplies Available from the Manufacturer**

<table>
<thead>
<tr>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small poly swab (thermally bonded). Available in the Cleaning kit.</td>
<td>1017396</td>
</tr>
<tr>
<td>Lint-free wipe (11 cm x 21 cm, 4.3 inches x 8.3 inches). Available in the Cleaning kit.</td>
<td>018027</td>
</tr>
<tr>
<td>Cleaning kit. Contains the small poly swab, lint-free wipes, Q0 cleaning tool, tapered IonDrive™ QJet ion guide cleaning brush, Q0 cleaning brush, and alconox packets.</td>
<td>5021294</td>
</tr>
</tbody>
</table>
Best Practices

WARNING! Toxic Chemical Hazard. Refer to chemical product Safety Data Sheets and follow all safety guidelines when handling, storing, and disposing of chemicals. For health and safety precautions, refer to Chemical Precautions on page 11.

WARNING! Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Determine whether mass spectrometer decontamination is required prior to cleaning or maintenance. The customer must decontaminate the system prior to cleaning or maintenance if radioactive materials, biological agents, or toxic chemicals have been used with a mass spectrometer.

WARNING! Environmental Hazard. Do not dispose of system components in municipal waste. Follow local regulations when disposing of components.

- Always wear clean, powder-free gloves (nitrile or neoprene recommended) for the cleaning procedures.
- After cleaning the mass spectrometer components, and before reassembling them, put on a new, clean pair of gloves.
- Do not use cleaning supplies other than those specified in this procedure.
- If possible, prepare cleaning solutions just before you begin cleaning.
- Prepare and store all organic solutions and organic-containing solutions in very clean glassware only. Never use plastic bottles. Contaminants can leach from these bottles and further contaminate the mass spectrometer.
- To avoid contaminating the cleaning solution, pour the solution on the wipe or swab.
- Allow only the center area of the wipe to contact the mass spectrometer surface. Cut edges can leave fibers behind.

Tip! Wrap the wipe around a thermally-bonded polyester swab (poly swab).

Figure 14-1 Example: Folding the Wipe

- To avoid cross-contamination, discard the wipe or swab after it has touched the surface once.
• Larger parts of the vacuum interface, such as the curtain plate, might require several cleanings, using multiple wipes.
• Only dampen the wipe or swab slightly when applying water or cleaning solution. Water, more often than organic solvents, might cause the wipe to deteriorate, leaving residue on the mass spectrometer.
• Do not rub the wipe across the aperture. Wipe around the aperture to prevent fibers from the wipes from entering the mass spectrometer.
• Do not insert the brush in the aperture on the curtain plate or orifice plate.

**Prepare the Mass Spectrometer**

1. Deactivate the hardware profile.
2. Remove the ion source. Refer to the ion source *Operator Guide*.

   **CAUTION: Potential System Damage. Do not drop anything into the source drain when the ion source is removed.**

When the ion source is not in use, store it to protect it from damage and to maintain operating integrity.

*Figure 14-2 Source Drain on the Vacuum Interface*
Clean the Curtain Plate

**CAUTION:** Potential System Damage. Do not rest the curtain plate or orifice plate on the aperture tip. Make sure that the conical side of the curtain plate faces up.

1. Pull the curtain plate off the vacuum interface and then place it, conical side up, on a clean, stable surface.

![Figure 14-3 Curtain Plate Removal](image)

It is held in place by three retaining ball catches mounted on the orifice plate.

2. Dampen a lint-free wipe with pure water and then clean both sides of the curtain plate. Use multiple wipes, as required.

3. Repeat step 2 using the cleaning solution.

4. Using a dampened wipe or small poly swab, clean the aperture.

5. Wait until the curtain plate is dry.

6. Inspect the curtain plate for solvent stains or lint, removing any residue with a clean, slightly damp, lint-free wipe.

**Note:** Persistent spotting or filming is an indicator of contaminated solvent.
Clean the Front of the Orifice Plate

**CAUTION:** Potential System Damage: When cleaning the surface of the orifice plate, do not remove the interface heater. Frequent removal of the interface heater can result in damage to the interface heater. Surface cleaning of the interface heater is adequate for routine cleaning.

**CAUTION:** Potential System Damage. Do not insert a wire or metal brush into the aperture on the curtain plate, orifice plate, or interface heater to avoid damaging the aperture.

1. Dampen a lint-free wipe with water and then wipe the front of the orifice plate, including the interface heater.
2. Repeat the previous step using the cleaning solution.
3. Wait until the orifice plate is dry.
4. Inspect the orifice plate for solvent stains or lint, removing any residue with a clean, slightly damp, lint-free wipe.

**Note:** Persistent spotting or filming is an indicator of contaminated solvent.

Put the Mass Spectrometer Back in Service

1. Install the curtain plate on the mass spectrometer.
2. Install the ion source on the mass spectrometer. Remember to tighten the ion source by turning the source latches down into the locking position. Refer to the ion source *Operator Guide*.
3. Activate the hardware profile.

Empty the Source Exhaust Drain Bottle

**WARNING!** Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Deposit hazardous materials in appropriately labeled waste containers and dispose of them according to local regulations.
WARNING! Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Take care to vent exhaust gases to a dedicated laboratory fume hood or exhaust system, and make sure that the vent tubing is secured with clamps.

Inspect the source exhaust drain bottle regularly, and empty it before it becomes full. Also inspect the bottle and its fitting for leaks, and tighten connections or replace components, if required. Follow the steps in this procedure to empty the bottle.

1. Remove the ion source. Refer to the ion source Operator Guide.

2. Loosen the clamps connecting the hoses to the cap of the source exhaust drain bottle.

3. Disconnect the hoses from the cap.

4. If applicable, lift the drain bottle out of the holder.

5. Remove the drain bottle from the cap.

6. Empty the drain bottle and then dispose of the waste according to laboratory procedures and local waste regulations.

7. Install the cap on the bottle and then put the bottle in the holder.

8. Attach the hoses to the cap and then secure them tightly with clamps.
Figure 14-4 Source Exhaust Drain Bottle

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Connection to vent</td>
</tr>
<tr>
<td>2</td>
<td>Source exhaust drain tubing: 2.5 cm (1.0 inch) inside diameter (i.d.)</td>
</tr>
<tr>
<td>3</td>
<td>Roughing pump exhaust hose: 3.2 cm (1.25 inch) i.d.</td>
</tr>
<tr>
<td>4</td>
<td>Source exhaust drain bottle. The drain bottle may be located at the side of the mass spectrometer in the drain bottle holder. Make sure that the bottle is secured to prevent spillage.</td>
</tr>
<tr>
<td>5</td>
<td>Connection to mass spectrometer: 1.6 cm (0.625 inch) i.d.</td>
</tr>
</tbody>
</table>

**Note:** Source exhaust hose connections at the drain bottle, mass spectrometer, and the lab vent are secured with hose clamps.
Storage and Handling

**WARNING! Environmental Hazard. Do not dispose of system components in municipal waste. Follow local regulations when disposing of components.**

If the mass spectrometer must be stored for a long time or prepared for shipping, then contact a SCIEX FSE for decommissioning information. To disconnect power from the mass spectrometer, remove the mains supply connector from the AC mains supply.

**Note:** The system must be transported and stored between −30°C to +60°C (-22°F to 140°F). Store the system below 2000 m (6562 ft) above sea level.
Mass Spectrometer Troubleshooting

This section contains information for troubleshooting basic system issues. Certain activities can only be carried out by the SCIEX trained Qualified Maintenance Person (QMP) in the laboratory. For advanced troubleshooting, contact a Field Service Employee (FSE).

Table 15-1 System Issues

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensitivity is reduced.</td>
<td>The mass spectrometer or ion source requires tuning or optimization.</td>
<td>Optimize the mass spectrometer. Refer to Operating Instructions — Tune and Calibrate on page 64.</td>
</tr>
<tr>
<td></td>
<td>The curtain plate is dirty.</td>
<td>Refer to Clean the Curtain Plate on page 144.</td>
</tr>
<tr>
<td></td>
<td>The orifice plate is dirty.</td>
<td>Refer to Clean the Front of the Orifice Plate on page 145.</td>
</tr>
<tr>
<td></td>
<td>The IonDrive™ QJet ion guide, Q0 quadrupole, or IQ0 lens is dirty.</td>
<td>Contact the local QMP or an FSE.</td>
</tr>
<tr>
<td>The IonDrive™ QJet ion guide is extremely dirty or frequently becomes dirty.</td>
<td>The Curtain Gas™ flow rate is too low.</td>
<td>Verify the setting for the CUR parameter, and increase it, if applicable.</td>
</tr>
<tr>
<td>A system fault has occurred because the vacuum pressure is too high.</td>
<td>The roughing pump oil level is too low.</td>
<td>Inspect the roughing pump oil level, and ten contact the local QMP or an FSE to add oil.</td>
</tr>
<tr>
<td></td>
<td>There is a leak.</td>
<td>Inspect and repair leaks.</td>
</tr>
<tr>
<td></td>
<td>The wrong orifice plate is installed.</td>
<td>Install the correct orifice plate.</td>
</tr>
</tbody>
</table>

For sales, technical assistance or service, contact an FSE or visit the SCIEX Web site at sciex.com for contact information.
The user must control the autosampler and injection valve manually, as these devices cannot be controlled through the system while it is in **Tune and Calibrate** mode.

**Prerequisites**

- The mass spectrometer is tuned and calibrated.
- Conditions for an LC separation are known.
- If the system has an integrated syringe pump, there is a hardware profile containing a syringe pump.
- All the required peripheral devices, including a syringe pump, if needed, and LC components are in the hardware profile.

**Required Materials**

To tune instrument parameters for particular compounds the following solutions are recommended. The mixture of four compounds is used for illustrating the steps of the procedure.

- Mobile phase: 1:1 acetonitrile:water + 2 mM ammonium acetate + 0.1% formic acid.
- LC pump and autosampler.
- Autosampler vials.
- Four-compound mix (50 ng/mL), consisting of reserpine, minoxidil, tolbutamide, and rescinnamine. The solution can be used for infusion and flow injection analysis (FIA). The concentration is system-dependent. Use a solution that is 49.9% acetonitrile, with 50% deionized water and 0.1% formic acid as diluent. Other compounds can be substituted as long as their molecular weight is known and the compound is reasonable to be ionized by the IonDrive™ Turbo V ion source.

**Table A-1 Compounds and Molecular Weights**

<table>
<thead>
<tr>
<th>Compound</th>
<th>m/z</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minoxidil</td>
<td>210.2</td>
</tr>
<tr>
<td>Tolbutamide</td>
<td>271.1</td>
</tr>
<tr>
<td>Reserpine</td>
<td>609.3</td>
</tr>
<tr>
<td>Rescinnamine</td>
<td>635.3</td>
</tr>
</tbody>
</table>
About Manual Compound Optimization

Manual compound optimization is used to optimize compound- and ion source-dependent parameters for an analyte. When the user manually optimizes for an analyte, an MS acquisition method is created in Tune and Calibrate mode. Depending on the method of sample introduction selected, add an LC method to the acquisition method so that infusion or LC can be used.

Optimizing to give the highest signal does not always give the highest signal-to-noise ratios. Noise can scale with signal for some parameters and should be verified during optimization if the goal is to obtain maximum signal-to-noise ratio.

When optimizing ion source-dependent parameters, introduce the sample at flow rates that will be used during sample analysis, using either FIA or Tee-infusion as the method of sample introduction. The CAD gas is the only compound-dependent parameter that is shown on the Source/Gas tab and can be easily optimized while infusing the analyte.

Optimize the position of the ion source before optimizing the ion source-dependent parameters. Refer to the ion source Operator Guide.

About Scan Types

For this example, use the Q1 MS, Q1 MI, Product Ion, and MRM scan types. The Q1 MS scan type is used to confirm the presence of compounds of interest. The Q1 MI scan is used to optimize MS or pre-collision cell voltages. The Product Ion scan type is used to determine the product ions of each compound. The MRM scan type is used to optimize the collision energy (CE) and collision cell exit potential (CXP) for each product ion or fragment. Use the methods created in this section for quantitative or qualitative analysis.

Manually Optimize an Analyte

After the acquisition method is created, optimize compound-dependent parameters using the Edit Ramp function or by manually editing the parameters in the Tune Method Editor. Ion source-dependent parameters can be optimized only by manually adjusting the parameters in the Tune Method Editor. Depending on the scan type used, different parameters are available to optimize.

Follow the procedures in the order given:

1. Confirm the Presence of Compounds on page 152
2. Optimize MS-Specific Parameters on page 153
3. Determine the Product Ions for Optimization on page 155
4. Optimize Collision Cell Exit Potential for each Product Ion on page 156
Confirm the Presence of Compounds

1. Create a project.
2. Activate the hardware profile.
3. Infuse the compound in solution at a rate of 5 µL/min to 10 µL/min.
4. On the Navigation bar, under **Tune and Calibrate**, double-click **Manual Tuning**.
5. In the method list field, click **Syringe Pump Method**.
6. On the **Syringe Pump Method Properties** tab, type the parameter values shown in *Table A-2*.

**Table A-2 Syringe Pump Method Properties Tab**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Syringe Diameter</td>
<td>Syringe dependent: 1.0 mL syringe is 4.610 mm</td>
</tr>
<tr>
<td>Flow Rate</td>
<td>10</td>
</tr>
<tr>
<td>Unit</td>
<td>µL/min</td>
</tr>
</tbody>
</table>

**Figure A-1 Syringe Pump Method Properties Tab**

7. Click **Start Syringe Pump**.
8. Click **MS Method** from the method list.
9. On the **MS** tab, type the parameter values shown in *Table A-3*.
Table A-3 MS Tab

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan type</td>
<td>Q1 MS (Q1)</td>
</tr>
<tr>
<td>Start (Da)</td>
<td>200</td>
</tr>
<tr>
<td>Stop (Da)</td>
<td>700</td>
</tr>
<tr>
<td>Scan rate (Da/s) (if available)</td>
<td>200</td>
</tr>
<tr>
<td>Duration (min)</td>
<td>3</td>
</tr>
</tbody>
</table>

10. Click **Start**.

11. Wait until an even TIC is shown on the left and peaks are shown on the right and then click **Stop**.

12. Select the **MCA** check box.

13. Type **10** in the **Cycles** field.

14. Click **Start**.

15. When the ten scans are complete, the masses of the four compounds are shown as ions.

   Ion intensities of the compounds can show large variances. To facilitate moving to a solution of higher or lower concentration as needed during the optimization, have several concentration levels prepared before beginning optimization.

16. Right-click the bottom-right spectral pane and then click **Open File**.

17. Find the compounds of interest and then write down the $m/z$ values for the highest peaks. These values should be within 0.1 Da to 0.2 Da of the expected $m/z$. In the next procedure, use the $m/z$ values.

**Optimize MS-Specific Parameters**

Declustering potential (DP) and entrance potential (EP) are pre-collision cell voltages. Optimization of these values involves gradually changing the voltage range while monitoring the signal intensity of the compound.

The DP is the difference between the orifice and the ground. The higher the potential difference, the greater the amount of declustering.

The DP parameter has a significant effect on analyte signal. Typical DP values range from 20 V to 150 V. A DP value that is too low will result in lower ion intensity and potential interferences from clusters. A DP value that is too high can cause fragmentation of the analyte in the source. Generally, the DP should be set to the value that provides the highest intensity.

The EP parameter controls the entrance potential, which guides and focuses the ions through the high-pressure Q0 region. It is typically set at 10 V for positive ions or −10 V for negative ions. The EP has a minor effect on compound optimization and, therefore, can generally be left at default values without impact on analyte detection limits.
1. Return to the Tune Method Editor and change the method to the Q1 Multiple Ions (Q1 MI) scan type.

2. In the mass table, type the parameter values as shown in Table A-4.

### Table A-4 Mass Table Parameters—Q1 Multiple Ions (Q1 MI)

<table>
<thead>
<tr>
<th>Compound</th>
<th>Q1 Mass</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reserpine</td>
<td>609.3</td>
<td>1</td>
</tr>
<tr>
<td>Minoxidil</td>
<td>210.2</td>
<td>1</td>
</tr>
<tr>
<td>Tolbutamide</td>
<td>271.1</td>
<td>1</td>
</tr>
<tr>
<td>Rescinnamine</td>
<td>635.3</td>
<td>1</td>
</tr>
</tbody>
</table>

Start with reserpine for a simple case. Repeat the manual optimization process for the remaining compounds.

3. Click Edit Ramp.


**Note:** Start with the DP parameter and then optimize the other parameters in the order that they appear in the dialog. The parameters might not be optimized correctly if they are optimized out of order.

5. Type the required Start, Stop, and Step values. The existing values are good starting points. Use the Edit Ramp function to change these values to be more efficient.

6. Click OK.

7. Click Start.

8. Right-click the bottom-right XIC pane and then click Open File to maximize the XIC view.

9. Monitor the XICs. The value that gives the best signal per second for the ion of interest is the optimal value.

10. Note the optimal value for the ion of interest.

11. Move the cursor to the mass table, right-click and then add the parameter just optimized. This adds a column to the table.

12. Add the optimized value to the appropriate row.

13. Repeat these steps for each mass in the acquisition method until there is a list of the optimal values for all the masses.

14. Repeat these steps to optimize for the other MS-specific parameters.
Determine the Product Ions for Optimization

The collision energy (CE) controls the amount of energy that the precursor ions receive as they are accelerated into the collision cell.

Perform this procedure, one compound at a time, using the MS-specific optimized values that were obtained previously. The product ions provide the Q3 mass of MRM transitions.

In this example, the compound reserpine is used.

1. In the Tune Method Editor, close the XIC panes.
2. Click Product Ion (MS2) in the Scan type field.
3. Select the Compound tab and then type the optimal value noted previously.
4. On the MS tab, in the Product Of field, type 609.4. This value is the mass assignment for reserpine that was noted in Confirm the Presence of Compounds on page 152.
5. Make sure that the Center / Width check box is not selected.
6. In the mass table, type the values specified in Table A-6:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start (Da)</td>
<td>100</td>
</tr>
<tr>
<td>Stop (Da)</td>
<td>650</td>
</tr>
<tr>
<td>Time (sec)</td>
<td>2</td>
</tr>
</tbody>
</table>

7. Click Edit Ramp.
8. In the Ramp Parameter Settings dialog, select Collision Energy and then type the required Start, Stop, and Step values. The existing values are good starting points. Use the Edit Ramp function to change these values to be more efficient.
9. Click OK.
10. Select the MCA check box.
11. Click Start.
Operating Instructions — Manual Optimization

12. Right-click the bottom-right XIC pane and then click Open File.

13. Pick the product ions with the greatest intensity. Note the product ion m/z to the first decimal point, such as 195.1.

   We recommend that two or three product ions be optimized for each compound. The additional transitions can be used for confirmation, or to avoid the need to re-optimize a compound in case an interference is found.

   **Note:** Make sure that the highest peaks selected for optimization do not represent a common loss from the precursor ion, such as water or carbon dioxide. Also make sure that the product ion is not too low in mass or interferences for that transition in real samples or clusters from the mobile phase when analyzing on column might occur.

14. Repeat this procedure for the remaining compounds.

**Optimize Collision Cell Exit Potential for each Product Ion**

1. In the Tune Method Editor, close the XIC panes.

2. Open the previously saved method.

3. In the mass table, verify the Q1 and Q3 m/z values for the compound.

4. Select the Compound tab and then type the optimal DP and CE values noted previously.

5. Click Edit Ramp.

6. In the Ramp Parameter Settings dialog, select Collision Cell Exit Potential (CXP) and then type the required Start, Stop, and Step values. The existing values are good starting points. Use the Edit Ramp function to change these values to be more efficient.

7. Click OK and then click Start.

8. Right-click the bottom-right XIC pane and then click Open File.

9. Note the optimal value for the ion of interest.

   The value that gives the best signal is the optimal value.

10. In the mass table, right-click and then select the parameter just optimized. This adds a column to the table.

11. Repeat if other product ions were monitored.

12. Add the optimized values to the appropriate row.

13. Save the method.

14. Repeat for the other compounds if previously optimized.
Manually Optimize the Ion Source and Gas Parameters

The ion source and gas settings must be set correctly to prevent contamination of the mass spectrometer and that the compounds of interest have been optimally put into the gas phase as ions.

The ion source and gas settings must be adjusted when the LC conditions change significantly.

To optimize the ion source and gas parameters, set up a syringe pump with the compounds of interest and connect the line with a tee to the LC device. Controlling the LC pump can be done manually or through the software.

Another way to manually optimize ion source and gas settings is to use the autosampler to manually inject the compound of interest while manually varying the parameters in manual tuning to find the optimal settings.

Prepare the Ion Source

1. Set the horizontal micrometer to 5.
2. Set the vertical micrometer on the ion source for the flow rate.

Use the parameters in Table A-7. Refer to the ion source Operator Guide.

<table>
<thead>
<tr>
<th>Flow Rate</th>
<th>Initial Vertical Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 µL/min to 20 µL/min</td>
<td>10</td>
</tr>
<tr>
<td>20 µL/min to 250 µL/min</td>
<td>5</td>
</tr>
<tr>
<td>250 µL/min to 500 µL/min</td>
<td>2</td>
</tr>
<tr>
<td>500 + µL/min</td>
<td>0</td>
</tr>
</tbody>
</table>

Depending on how the optimization is run, a hardware profile with the LC pumps might need to be configured.

Optimize the Ion Source Parameters

Ion source parameters are optimized for best signal-to-noise for the compound of interest. The Curtain Gas™ supply is optimized at the highest setting without losing sensitivity. Refer to the ion source Operator Guide.

Use the following procedure to optimize the Curtain Gas™ parameter. The main function of the Curtain Gas™ flow parameter is to prevent the contamination of the ion optics. The Curtain Gas™ flow parameter should always be maintained as high as possible without losing sensitivity. The value depends on the type of mass spectrometer and ion source.

Do not set the parameter below the starting value.

2. Click File > Open.

3. In the Files list, click the acquisition method used to optimize the compound parameter and then click OK.
   - The method opens in the Tune Method Editor.

4. Click the Source/Gas tab.

5. Using the ion source and gas flow guide, set all of the ion source and gas parameters so that they are appropriate for the flow rate.

6. Set the run time long enough so that many parameters can be adjusted. A recommended starting time is 15 minutes.

7. Click Start.
   - Data is shown in panes below the Tune Method Editor.

8. Note the signal of the peak of interest.

9. In the Curtain Gas (CUR) field, increase the value by five.

10. Continue increasing the Curtain Gas (CUR) value until the highest value without losing sensitivity is found.
    - As with most Source/Gas parameters, if two values give the same result, then use the higher value.

11. Repeat this procedure for the other Source/Gas parameters. When optimizing for these parameters, look for the value that gives the highest signal-to-noise value.
The first number under each scan type is the preset value. The range of numbers is the accessible range for each parameter.

### Table B-1 6500 and 6500+ Series System Parameters

<table>
<thead>
<tr>
<th>Parameter ID</th>
<th>Access ID</th>
<th>Positive Ion Mode</th>
<th>Negative Ion Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Q1</td>
<td>Q3</td>
</tr>
<tr>
<td>CUR</td>
<td>CUR</td>
<td>20</td>
<td>20 to 55</td>
</tr>
<tr>
<td>CAD&lt;sup&gt;(a)(b)&lt;/sup&gt;</td>
<td>CAD&lt;sup&gt;(a)(b)&lt;/sup&gt;</td>
<td>0</td>
<td>6</td>
</tr>
<tr>
<td>CAD&lt;sup&gt;(c)(d)&lt;/sup&gt;</td>
<td>CAD&lt;sup&gt;(c)(d)&lt;/sup&gt;</td>
<td>0</td>
<td>6</td>
</tr>
<tr>
<td>IS&lt;sup&gt;(1)(2)(7)&lt;/sup&gt;</td>
<td>IS&lt;sup&gt;(1)(2)(7)&lt;/sup&gt;</td>
<td>5500</td>
<td>5500</td>
</tr>
<tr>
<td>IS&lt;sup&gt;(5)&lt;/sup&gt;</td>
<td>IS&lt;sup&gt;(5)&lt;/sup&gt;</td>
<td>1500</td>
<td>1500</td>
</tr>
<tr>
<td>IS&lt;sup&gt;(6)&lt;/sup&gt;</td>
<td>IS&lt;sup&gt;(6)&lt;/sup&gt;</td>
<td>1000</td>
<td>1000</td>
</tr>
<tr>
<td>NC&lt;sup&gt;(3)(4)(8)&lt;/sup&gt;</td>
<td>NC&lt;sup&gt;(3)(4)(8)&lt;/sup&gt;</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>TEM&lt;sup&gt;(2)(3)(4)(5)(7)(8)&lt;/sup&gt;</td>
<td>TEM&lt;sup&gt;(2)(3)(4)(5)(7)(8)&lt;/sup&gt;</td>
<td>0</td>
<td>0 to 750</td>
</tr>
<tr>
<td>OR (DP = OR)</td>
<td>DP</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

*Note*: The table entries for CAD, IS, NC, and TEM are not fully filled, indicating that some parameters may have specific access levels or ranges not listed in the table.
### Table B-1 6500 and 6500+ Series System Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter ID</th>
<th>Access ID</th>
<th>Positive Ion Mode</th>
<th>Negative Ion Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q0</td>
<td>EP</td>
<td>Q1: 10 to 15</td>
<td>Q1: −10 to −15</td>
</tr>
<tr>
<td>(EP = −Q0)</td>
<td></td>
<td>Q3: 10 to 15</td>
<td>MS/MS: 10 to 15</td>
</tr>
<tr>
<td>Q1</td>
<td>IQ1</td>
<td>Q0 + (−0.5) −0.1 to −2</td>
<td>Q0 + (−0.5) −0.1 to −2</td>
</tr>
<tr>
<td>(IQ1 = Q0 + offset)</td>
<td></td>
<td>Q1: 10 to 15</td>
<td>MS/MS: 10 to 15</td>
</tr>
<tr>
<td>ST</td>
<td>ST</td>
<td>Q0 + (−8) −12 to −5</td>
<td>Q0 + (−8) −12 to −5</td>
</tr>
<tr>
<td>(ST = Q0 + offset)</td>
<td></td>
<td>Q1: 10 to 15</td>
<td>MS/MS: 10 to 15</td>
</tr>
<tr>
<td>R01</td>
<td>IE1</td>
<td>1 to 3 n/a</td>
<td>1 to 3 n/a</td>
</tr>
<tr>
<td>(IE1 = Q0 − R01)</td>
<td></td>
<td>1 to 3 n/a</td>
<td>1 to 3 n/a</td>
</tr>
<tr>
<td>Q0</td>
<td>EP</td>
<td>Q1: 10 to 15</td>
<td>Q1: −10 to −15</td>
</tr>
<tr>
<td>(EP = −Q0)</td>
<td></td>
<td>Q3: 10 to 15</td>
<td>MS/MS: 10 to 15</td>
</tr>
<tr>
<td>ST3</td>
<td>ST3</td>
<td>R02 + 10 n/a</td>
<td>R02 + 10 n/a</td>
</tr>
<tr>
<td>(ST3 = R02 + offset)</td>
<td></td>
<td>R02 + 10 n/a</td>
<td>R02 + 10 n/a</td>
</tr>
<tr>
<td>ST3</td>
<td>CXP</td>
<td>n/a 15 to 55</td>
<td>n/a 15 to 55</td>
</tr>
<tr>
<td>(CXP = R02 − ST3)</td>
<td></td>
<td>n/a 15 to 55</td>
<td>n/a 15 to 55</td>
</tr>
<tr>
<td>R03</td>
<td>R03</td>
<td>−50 n/a</td>
<td>−50 n/a</td>
</tr>
<tr>
<td>(IE3 = R02 − R03)</td>
<td></td>
<td>n/a 1 to 5</td>
<td>n/a 1 to 5</td>
</tr>
<tr>
<td>R03</td>
<td>IE3</td>
<td>n/a 1 to 5</td>
<td>n/a 1 to 5</td>
</tr>
<tr>
<td>(IE3 = R02 − R03)</td>
<td></td>
<td>n/a 1 to 5</td>
<td>n/a 1 to 5</td>
</tr>
</tbody>
</table>
### Table B-1 6500 and 6500+ Series System Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter ID</th>
<th>Access ID</th>
<th>Positive Ion Mode</th>
<th>Negative Ion Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Q1</td>
<td>Q3</td>
</tr>
<tr>
<td>CEM</td>
<td>CEM</td>
<td>1700 0 to 3300</td>
<td>1700 0 to 3300</td>
</tr>
<tr>
<td>GS1</td>
<td>GS1</td>
<td>20 0 to 90</td>
<td>20 0 to 90</td>
</tr>
<tr>
<td>GS2</td>
<td>GS2</td>
<td>0 0 to 90</td>
<td>0 0 to 90</td>
</tr>
<tr>
<td>IHT</td>
<td>IHT</td>
<td>150</td>
<td>150</td>
</tr>
<tr>
<td>sdps</td>
<td>sdps</td>
<td>1 1 or 2</td>
<td>1 1 or 2</td>
</tr>
</tbody>
</table>

(1) Turbo V™ ion source (2) TurboIonSpray® (TIS) probe (3) APCI probe (4) DuoSpray™ ion source, 1=TIS, and 2=HN (5) PhotoSpray® ion source (6) NanoSpray® ion source (7) IonDrive™ Turbo V ion source (8) IonDrive™ Turbo V ion source with the APCI probe (a) QTRAP® 6500 or 6500+ system Low Mass (LM) (b) QTRAP® 6500 or 6500+ system High Mass (HM) (c) SCIEX Triple Quad™ 6500 or 6500+ system LM (d) SCIEX Triple Quad™ 6500 or 6500+ system HM

### Table B-2 6500 and 6500+ Series System Parameters for LIT Scan Types Only

<table>
<thead>
<tr>
<th>Parameter ID</th>
<th>Access ID</th>
<th>Positive Ion Mode</th>
<th>Negative Ion Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>High Low, Medium, High</td>
<td>High Low, Medium, High</td>
</tr>
<tr>
<td>AF2**</td>
<td>AF2</td>
<td>0.1 0 to 1</td>
<td>0.1 0 to 1</td>
</tr>
<tr>
<td>AF3</td>
<td>AF3</td>
<td>Mass-Speed Dependent 0 to 10</td>
<td>Mass-Speed Dependent 0 to 10</td>
</tr>
<tr>
<td>EXB</td>
<td>EXB</td>
<td>Mass-Speed Dependent –165 to 0</td>
<td>Mass-Speed Dependent 0 to 165</td>
</tr>
<tr>
<td>CES</td>
<td>CES</td>
<td>0 0 to 87.5</td>
<td>0 0 to 87.5</td>
</tr>
</tbody>
</table>
Table B-2 6500 and 6500+ Series System Parameters for LIT Scan Types Only (continued)

<table>
<thead>
<tr>
<th>Parameter ID (Q0 - ROS)</th>
<th>Access ID</th>
<th>Positive Ion Mode</th>
<th>Negative Ion Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROS (1) Turbo V™ ion source (2) TurboIonSpray® (tis) probe (3) APCI probe (4) DuoSpray™ ion source, 1=TIS, and 2=HN (5) PhotoSpray® ion source (6)NanoSpray® ion source (7) IonDrive™ Turbo V ion source (8) IonDrive™ Turbo V ion source with the APCI probe</td>
<td>CE</td>
<td>10 5 to 180</td>
<td>–10 –5 to –180</td>
</tr>
</tbody>
</table>

** MS/MS/MS only

(1) Turbo V™ ion source (2) TurboIonSpray® (tis) probe (3) APCI probe (4) DuoSpray™ ion source, 1=TIS, and 2=HN (5) PhotoSpray® ion source (6)NanoSpray® ion source (7) IonDrive™ Turbo V ion source (8) IonDrive™ Turbo V ion source with the APCI probe
# Calibration Ions and Solutions

## Table C-1 Tuning Frequency

<table>
<thead>
<tr>
<th>Calibration</th>
<th>Resolution Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Scan Type</td>
</tr>
<tr>
<td>Q1 and Q3</td>
<td>Both</td>
</tr>
<tr>
<td>LIT</td>
<td>Both</td>
</tr>
</tbody>
</table>

## Table C-2 Suggested Tuning Solutions for 6500 and 6500+ Series Systems

<table>
<thead>
<tr>
<th>System</th>
<th>Q1 and Q3</th>
<th>LIT</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCIEX SCIEX Triple Quad™ 6500 or 6500+ LC-MS/MS system (Low Mass and High Mass)</td>
<td>Positive: PPG, $2 \times 10^{-7}$ M (500:1)</td>
<td>Negative: NEG PPG, $3 \times 10^{-5}$ (10:1)</td>
</tr>
<tr>
<td>QTRAP® 6500 or 6500+ LC-MS/MS system (Low Mass and High Mass)</td>
<td>Positive: PPG, $2 \times 10^{-7}$ M (500:1)</td>
<td>Negative: NEG PPG, $3 \times 10^{-5}$ (10:1)</td>
</tr>
</tbody>
</table>

## Table C-3 Q1 and Q3 Scans for 6500 or 6500+ Series Systems

<table>
<thead>
<tr>
<th>Polarity</th>
<th>Masses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Mass</td>
<td></td>
</tr>
<tr>
<td>Positive</td>
<td>59.05 175.133 500.38 616.464 906.673 1080.799 1196.883 N/A</td>
</tr>
<tr>
<td>Negative</td>
<td>44.998 585.385 933.636 1223.845 N/A N/A N/A N/A</td>
</tr>
<tr>
<td>High Mass</td>
<td></td>
</tr>
</tbody>
</table>
### Calibration Ions and Solutions

Table C-3 Q1 and Q3 Scans for 6500 or 6500+ Series Systems (continued)

<table>
<thead>
<tr>
<th>Polarity</th>
<th>Masses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Positive</td>
<td>59.05</td>
</tr>
<tr>
<td></td>
<td>175.133</td>
</tr>
<tr>
<td></td>
<td>500.38</td>
</tr>
<tr>
<td></td>
<td>616.464</td>
</tr>
<tr>
<td></td>
<td>906.673</td>
</tr>
<tr>
<td></td>
<td>1254.925</td>
</tr>
<tr>
<td></td>
<td>1545.134</td>
</tr>
<tr>
<td></td>
<td>1952.427</td>
</tr>
<tr>
<td>Negative</td>
<td>44.998</td>
</tr>
<tr>
<td></td>
<td>411.259</td>
</tr>
<tr>
<td></td>
<td>585.385</td>
</tr>
<tr>
<td></td>
<td>933.636</td>
</tr>
<tr>
<td></td>
<td>1223.845</td>
</tr>
<tr>
<td></td>
<td>1572.097</td>
</tr>
<tr>
<td></td>
<td>1863.306</td>
</tr>
<tr>
<td></td>
<td>1979.389</td>
</tr>
</tbody>
</table>

Table C-4 LIT Scans for the QTRAP 6500 or 6500+ LC-MS/MS System

<table>
<thead>
<tr>
<th>Polarity</th>
<th>Masses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Mass</td>
<td></td>
</tr>
<tr>
<td>Positive</td>
<td>118.087</td>
</tr>
<tr>
<td></td>
<td>322.049</td>
</tr>
<tr>
<td></td>
<td>622.029</td>
</tr>
<tr>
<td></td>
<td>922.01</td>
</tr>
<tr>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td>Negative</td>
<td>112.985</td>
</tr>
<tr>
<td></td>
<td>431.982</td>
</tr>
<tr>
<td></td>
<td>601.978</td>
</tr>
<tr>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td>High Mass</td>
<td></td>
</tr>
<tr>
<td>Positive</td>
<td>118.087</td>
</tr>
<tr>
<td></td>
<td>322.049</td>
</tr>
<tr>
<td></td>
<td>622.029</td>
</tr>
<tr>
<td></td>
<td>922.01</td>
</tr>
<tr>
<td></td>
<td>1521.972</td>
</tr>
<tr>
<td>Negative</td>
<td>112.987</td>
</tr>
<tr>
<td></td>
<td>431.982</td>
</tr>
<tr>
<td></td>
<td>601.978</td>
</tr>
<tr>
<td></td>
<td>1033.988</td>
</tr>
<tr>
<td></td>
<td>1633.949</td>
</tr>
</tbody>
</table>
Toolbar Icons

For additional toolbar icons, refer to the *Advanced User Guide*.

### Table D-1 Tool Bar Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder]</td>
<td>New Subproject</td>
<td>Creates a subproject. <strong>Subprojects</strong> can only be created later in the process if the project was originally created with subprojects.</td>
</tr>
<tr>
<td>![Folder]</td>
<td>Copy Subproject</td>
<td>Copies a Subproject folder. Subprojects can be copied only from another project that has existing subprojects. If the same folders exist at both the project and subproject levels, then the software uses the project level folders.</td>
</tr>
</tbody>
</table>

### Table D-2 Acquisition Method Editor Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Mass Spec]</td>
<td>Mass Spec</td>
<td>Shows the <strong>MS</strong> tab in the <em>Acquisition Method</em> editor.</td>
</tr>
<tr>
<td>![Period]</td>
<td>Period</td>
<td>Right-click to add an experiment, add an <strong>IDA Criteria Level</strong>, or delete the period.</td>
</tr>
<tr>
<td>![Autosampler]</td>
<td>Autosampler</td>
<td>Opens the <strong>Autosampler Properties</strong> tab.</td>
</tr>
<tr>
<td>![Syringe Pump]</td>
<td>Syringe Pump</td>
<td>Opens the <strong>Syringe Pump Properties</strong> tab.</td>
</tr>
<tr>
<td>![Column Oven]</td>
<td>Column Oven</td>
<td>Opens the <strong>Column Oven Properties</strong> tab.</td>
</tr>
<tr>
<td>![Valve]</td>
<td>Valve</td>
<td>Opens the <strong>Valve Properties</strong> tab.</td>
</tr>
<tr>
<td>![DAD]</td>
<td>DAD</td>
<td>Opens the <strong>DAD Method Editor</strong>. Refer to <em>Generate DAD Data on page 127</em>.</td>
</tr>
<tr>
<td>![ADC]</td>
<td>ADC</td>
<td>Opens the <strong>ADC Properties</strong> tab. Refer to <em>Show ADC Data on page 121</em>.</td>
</tr>
</tbody>
</table>
# Toolbar Icons

## Table D-3 Acquire Mode Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="View Queue" /></td>
<td>View Queue</td>
<td>Shows the sample queue.</td>
</tr>
<tr>
<td><img src="image" alt="Instrument Queue" /></td>
<td>Instrument Queue</td>
<td>Shows a remote instrument station.</td>
</tr>
<tr>
<td><img src="image" alt="Status for Remote Instrument" /></td>
<td>Status for Remote Instrument</td>
<td>Shows the status of a remote instrument.</td>
</tr>
<tr>
<td><img src="image" alt="Start Sample" /></td>
<td>Start Sample</td>
<td>Starts the sample in the queue.</td>
</tr>
<tr>
<td><img src="image" alt="Stop Sample" /></td>
<td>Stop Sample</td>
<td>Stops the sample in the queue.</td>
</tr>
<tr>
<td><img src="image" alt="Abort Sample" /></td>
<td>Abort Sample</td>
<td>Aborts a sample acquisition in the middle of the processing of that sample.</td>
</tr>
<tr>
<td><img src="image" alt="Stop Queue" /></td>
<td>Stop Queue</td>
<td>Stops the queue before it has completed processing all the samples.</td>
</tr>
<tr>
<td><img src="image" alt="Pause Sample Now" /></td>
<td>Pause Sample Now</td>
<td>Inserts a pause in the queue.</td>
</tr>
<tr>
<td><img src="image" alt="Insert Pause before Selected Sample(s)" /></td>
<td>Insert Pause before Selected Sample(s)</td>
<td>Inserts a pause before a specific sample.</td>
</tr>
<tr>
<td><img src="image" alt="Continue Sample" /></td>
<td>Continue Sample</td>
<td>Continues acquiring the sample.</td>
</tr>
<tr>
<td><img src="image" alt="Next Period" /></td>
<td>Next Period</td>
<td>Starts a new period.</td>
</tr>
<tr>
<td><img src="image" alt="Extend Period" /></td>
<td>Extend Period</td>
<td>Extends the current period.</td>
</tr>
<tr>
<td><img src="image" alt="Next Sample" /></td>
<td>Next Sample</td>
<td>Stops acquiring the current sample and starts acquiring the next sample.</td>
</tr>
<tr>
<td><img src="image" alt="Equilibrate" /></td>
<td>Equilibrate</td>
<td>Selects the method to be used to equilibrate the devices. This method should be the same as the method used with the first sample in the queue.</td>
</tr>
<tr>
<td><img src="image" alt="Standby" /></td>
<td>Standby</td>
<td>Puts the instrument in <strong>Standby</strong> mode.</td>
</tr>
</tbody>
</table>
Table D-3 Acquire Mode Icons (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![icon]</td>
<td>Ready</td>
<td>Puts the instrument in <strong>Ready</strong> mode.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Reserve Instrument for Tuning</td>
<td>Reserves the mass spectrometer for tuning and calibrating.</td>
</tr>
<tr>
<td>![icon]</td>
<td>IDA Method Wizard</td>
<td>Starts the <strong>IDA Method Wizard</strong>.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Purge Modifier</td>
<td>Starts the modifier purge from the modifier pump.</td>
</tr>
</tbody>
</table>

Table D-4 Tune and Calibrate Mode Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![icon]</td>
<td>Calibrate from spectrum</td>
<td>Opens the <strong>Mass Calibration Option</strong> dialog and uses the active spectrum to calibrate the mass spectrometer.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Manual Tune</td>
<td>Opens the <strong>Manual Tune Editor</strong>.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Compound Optimization</td>
<td>Optimizes for a compound using infusion by FIA.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Instrument Optimization</td>
<td>Verifies the instrument performance, adjusts the mass calibration, or adjusts mass spectrometer settings.</td>
</tr>
<tr>
<td>![icon]</td>
<td>View Queue</td>
<td>Views the sample queue.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Instrument Queue</td>
<td>Views a remote instrument.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Status for Remote Instrument</td>
<td>Views the status of a remote instrument.</td>
</tr>
</tbody>
</table>
Table D-4 Tune and Calibrate Mode Icons (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Reserve Instrument for Tuning</td>
<td>Reserves the instrument for tuning and calibrating.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>IDA Method Wizard</td>
<td>Starts the <strong>IDA Method Wizard</strong>.</td>
</tr>
</tbody>
</table>

Table D-5 Explore Quick Reference: Chromatograms and Spectrum

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Open Data File</td>
<td>Opens files.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Show Next Sample</td>
<td>Goes to the next sample.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Show Previous Sample</td>
<td>Goes to the previous sample.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>GoTo Sample</td>
<td>Opens the <strong>Select Sample</strong> dialog.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>List Data</td>
<td>Views the data in tables.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Show TIC</td>
<td>Generates a TIC from a spectrum.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Extract Using Dialog</td>
<td>Extracts ions by selecting masses.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Show Base Peak Chromatogram</td>
<td>Generates a BPC.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Show Spectrum</td>
<td>Generates a spectrum from a TIC.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Copy Graph to new Window</td>
<td>Copies the active graph to a new window.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Baseline Subtract</td>
<td>Opens the <strong>Baseline Subtract</strong> dialog.</td>
</tr>
</tbody>
</table>
### Table D-5 Explore Quick Reference: Chromatograms and Spectrum (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Threshold.png" alt="Threshold" /></td>
<td>Threshold</td>
<td>Adjusts the threshold.</td>
</tr>
<tr>
<td>![Noise Filter](Noise Filter.png)</td>
<td>Noise Filter Options</td>
<td>Shows the Noise Filter Options dialog, which can be used to define the minimum width of a peak. Signals below this minimum width are regarded as noise.</td>
</tr>
<tr>
<td>![Show ADC](Show ADC.png)</td>
<td>Show ADC</td>
<td>Shows ADC data.</td>
</tr>
<tr>
<td>![Show File Info](Show File Info.png)</td>
<td>Show File Info</td>
<td>Shows the experimental conditions used to collect the data.</td>
</tr>
<tr>
<td>![Add arrows](Add arrows.png)</td>
<td>Add arrows</td>
<td>Adds arrows to the x-axis of the active graph.</td>
</tr>
<tr>
<td>![Remove all arrows](Remove all arrows.png)</td>
<td>Remove all arrows</td>
<td>Removes arrows from the x-axis of the active graph.</td>
</tr>
<tr>
<td>![Offset Graph](Offset Graph.png)</td>
<td>Offset Graph</td>
<td>Compensates for slight differences in the time during which the ADC data and the mass spectrometer data were recorded. This is useful when overlaying graphs for comparison.</td>
</tr>
<tr>
<td>![Force Peak Labels](Force Peak Labels.png)</td>
<td>Force Peak Labels</td>
<td>Labels all of the peaks.</td>
</tr>
<tr>
<td>![Expand Selection By](Expand Selection By.png)</td>
<td>Expand Selection By</td>
<td>Sets the expansion factor for a portion of a graph to be viewed in greater detail.</td>
</tr>
<tr>
<td>![Clear ranges](Clear ranges.png)</td>
<td>Clear ranges</td>
<td>Returns the expanded selection to normal view.</td>
</tr>
<tr>
<td>![Set Selection](Set Selection.png)</td>
<td>Set Selection</td>
<td>Defines start and stop points for a selection. This feature provides more accurate selection than is possible by selecting the region using the cursor.</td>
</tr>
<tr>
<td>![Normalize To Max](Normalize To Max.png)</td>
<td>Normalize To Max</td>
<td>Scales a graph to maximum size, so that the most intense peak is scaled to full scale, whether or not it is visible.</td>
</tr>
<tr>
<td>![Show History](Show History.png)</td>
<td>Show History</td>
<td>Shows a summary of data processing operations performed on a particular file, such as smoothing, subtraction, calibration, and noise filtering.</td>
</tr>
<tr>
<td>![Open Compound Database](Open Compound Database.png)</td>
<td>Open Compound Database</td>
<td>Opens the compound database.</td>
</tr>
<tr>
<td>![Set Threshold](Set Threshold.png)</td>
<td>Set Threshold</td>
<td>Adjusts the threshold.</td>
</tr>
</tbody>
</table>
Table D-5 Explore Quick Reference: Chromatograms and Spectrum (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Show Contour Plot</td>
<td>Shows selected data as either a spectrum graph or an XIC. Additionally, for data acquired by a DAD, a contour plot can show selected data as either a DAD spectrum or an XWC.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Show DAD TWC</td>
<td>Generates a TWC of the DAD spectrum.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Show DAD Spectrum</td>
<td>Generates a DAD spectrum.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Extract Wavelength</td>
<td>Extracts up to three wavelength ranges from a DAD spectrum to view the XWC.</td>
</tr>
</tbody>
</table>

Table D-6 Integration Tab and Quantitation Wizard Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Set parameters from Background Region</td>
<td>Uses the selected peak.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Select Peak</td>
<td>Uses the selected background.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Manual Integration Mode</td>
<td>Manually integrates peaks.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Show or Hide Parameters</td>
<td>Toggles the peak-finding parameters between shown and hidden.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Show Active Graph</td>
<td>Shows the analyte chromatogram only.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Show Both Analyte and IS</td>
<td>Shows the analyte and its associated chromatogram (available only when an associated internal standard exists).</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Use Default View for Graph</td>
<td>Returns to the preset (view all data) view (if, for example, the user has zoomed in on a chromatogram).</td>
</tr>
</tbody>
</table>
## Table D-7 Results Table Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Sort Ascending by Selection" /></td>
<td>Sort Ascending by Selection</td>
<td>Sorts the selected column by ascending values.</td>
</tr>
<tr>
<td><img src="image" alt="Sort Descending by Selection" /></td>
<td>Sort Descending by selection</td>
<td>Sorts the selected column by descending values.</td>
</tr>
<tr>
<td><img src="image" alt="Lock Or Unlock Column" /></td>
<td>Lock Or Unlock Column</td>
<td>Locks or unlocks the selected column. A locked column cannot be moved.</td>
</tr>
<tr>
<td><img src="image" alt="Metric Plot By Selection" /></td>
<td>Metric Plot By Selection</td>
<td>Creates a metric plot from the selected column.</td>
</tr>
<tr>
<td><img src="image" alt="Show all Samples" /></td>
<td>Show all Samples</td>
<td>Shows all the samples in the <strong>Results Table</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="Delete Formula Column" /></td>
<td>Delete Formula Column</td>
<td>Deletes formula columns.</td>
</tr>
<tr>
<td><img src="image" alt="Report Generator" /></td>
<td>Report Generator</td>
<td>Opens the Reporter software.</td>
</tr>
</tbody>
</table>

## Table D-8 Icon Quick Reference: Quantitate Mode

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add/Remove Samples" /></td>
<td>Add/Remove Samples</td>
<td>Adds or removes samples from the <strong>Results Table</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="Export as Text" /></td>
<td>Export as Text</td>
<td>Saves the <strong>Results Table</strong> as a text file.</td>
</tr>
<tr>
<td><img src="image" alt="Modify Method" /></td>
<td>Modify Method</td>
<td>Opens a .wiff file.</td>
</tr>
<tr>
<td><img src="image" alt="Peak Review - Pane" /></td>
<td>Peak Review - Pane</td>
<td>Opens peaks in a pane.</td>
</tr>
<tr>
<td><img src="image" alt="Peak Review - Window" /></td>
<td>Peak Review - Window</td>
<td>Opens peaks in a window.</td>
</tr>
<tr>
<td><img src="image" alt="Calibration - Pane" /></td>
<td>Calibration - Pane</td>
<td>Opens the calibration curve in a pane.</td>
</tr>
</tbody>
</table>
### Table D-8 Icon Quick Reference: Quantitate Mode (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Calibration - Window</td>
<td>Opens the calibration curve in a window.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Show First Peak</td>
<td>Shows the first peak in the pane or window.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Show Last Peak</td>
<td>Shows the last peak in the pane or window.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Show Audit Trail</td>
<td>Shows the audit trail for the <strong>Results Table</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Clear Audit Trail</td>
<td>Clears the audit trail for the <strong>Results Table</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Statistics</td>
<td>Opens the <strong>Statistics</strong> window.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Report Generator</td>
<td>Opens the <strong>Reporter</strong> software.</td>
</tr>
</tbody>
</table>
## Revision History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Reason for Change</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>First release of document.</td>
<td>August 2015</td>
</tr>
</tbody>
</table>
Index

A
acids, list of 13
Acquire mode, icons 166
Acquiring state, described 97
acquisition method editor, icons 165
acquisition methods
  changing from the Batch Editor 89
  compound IDs and quantitation methods 102
  creating 81
  defined 81
  experimental conditions 118
acquisition, stopping 94
activating
  hardware profiles 57
  troubleshooting hardware profile activation 59
ADC data, generating 121
adding
  devices 58
  experiments 82
  periods 82
  records 130
  samples to batches 87
Adjust Performance Screen, described 65
adjusting
  position of integrated syringe pump 47
  threshold 128
air filter
  frequency of maintenance 139
API Instrument folder
  backing up 63
  contents of 62
  recovering 63
applying
  parameter changes, peak review 107
  quantitation methods 90
automatic optimization
  compound optimization 67
  described 67
  equipment and solutions 67
  prerequisites 67
B
base peak chromatograms, generating 126
bases, list of 13
Batch Editor
  acquisition methods, changing 89
  quantitation details, defined 93
  right-click menu 95
  tips 89
batches
  adding sets and samples 87
  changing column values 89
  comparing results 116
  creating from text files 94
  described 86
  importing 95
  quantitation methods 100
  submitting 90
BPC base peak chromatograms
buffers, list of 12
Build Quantitation Method
  creating 101
  described 101

C
CAD Gas parameter, defined 36
calculated concentration field 113
calibration curves
  described 112
  overlaying 114
  points 115
  regression 113
  Regression Options dialog 113
  right-click menu 114
viewing 113
CEM parameter, defined 38
centroid, spectral data acquisition 85
changing
  acquisition methods in the Batch Editor 89
  sample order 91
chemical precautions, protective equipment 12
chromatograms
described 122
extracting ions by selecting masses 125
generating base beak chromatograms 126
icons 168
panes, right-click menu 129
save explore history 129
spectrum from a TIC, showing 123
subtract range locked 129
TICs from spectrum, showing 123
XICs, generating 123
cleaning
  best practices 142
curtain plate 144
  front end 140
  front of orifice plate 145
  preparing for 143
  reasons for 140
  recommended maintenance schedule 138
  required materials 141
  surfaces 140
Collision Cell Exit Potential parameter
defined 37
optimizing 156
collision energy parameter
defined 36
optimizing 155
Collision Energy Spread parameter
defined 36
columns
  add custom column 107
  add formula column 107
  changing values in the Batch Editor 89
compound optimization
  optimizing analytes automatically 67
  optimizing analytes manually 151
compounds, confirm presence of 68, 152
configuring
diverter valve 57
  syringe pump 56, 82
confirming, presence of compounds 68, 152
connections
  mass spectrometer 26
contamination, troubleshooting tips 149
contour plots, showing 129
copying
  experiments into a period 82
  experiments within a period 83
  graphs to a new window 131
  subprojects 61
corona discharge needle
  frequency of maintenance 139
creating
  acquisition methods 81
  batches 87
  batches from text files 94
  hardware profiles 54
  projects and subprojects 60
  quantitation methods 101
  Results Tables 103
  standard queries 104
  subprojects 61
cross-contamination, avoiding 142
Curtain Gas parameter, defined 34
curtain plate
  frequency of maintenance 138
D
DAD  diode array detector
data files
  ADC data 121
  adjusting the threshold 128
  generating DAD data 127
  generating TWCs 128
  go to a previous sample 118
  moving panes 132
  navigating between samples 118
  opening 117
  panes, deleting 132
  panes, hiding 132
  panes, locking 132
  panes, maximizing 133
panes, tiling 133
processing graphical data 130
quantitative data, showing 121
rescaling graphs 131
show data in tables 119
show experimental conditions 118
skip to a non-sequential sample 118
skip to next sample 118
samples
data handling, described 30
Declustering Potential parameter, defined 35
Decontamination Forms and system returns 16
Default folder, contents 62
deleting
custom columns 96
panes 132
samples from batches 96
devices
adding to hardware profiles 58
Ethernet 59
GPIB Board 59
serial ports 59
hardware profiles
diode array detector
generating data 127
generating TWCs 128
diverter valve
configuring 57
plumbing 50
drain bottle
emptying 146
Dynamic Fill Time parameter, defined 38
E
Edit Ramp function, manual optimization 151
electrode tube
frequency of maintenance 139
emptying, source exhaust drain bottle 146
Entrance Potential parameter, defined 35
environmental conditions, required 14
environmental health and safety regulations 8
Example folder, contents of 62
experiments
adding 82
copying into a period 82
copying within a period 83
extracted ion chromatograms
extracting ions by selecting masses 125
generating 123
generating using selected ranges 124
XICs, generating using base peak masses 124
XICs, generating using maximum peaks 124
F
FIA
Acquisition Methods folder 68
described 68
Fixed LIT Fill Time parameter, defined 37
flow injection analysis
Acquisition Methods folder 68
described 68
G
gas parameters
optimizing 157
generating
ADC data 121
base peak chromatograms 126
calibration curves 113
DAD data 127
reports 137
spectrum from a TIC 123
statistics 115
TICs from spectrum 123
TWCs 128
XICs, overview 123
showing
graphical data, processing 130
graphs
comparing 131
copying to a new window 131
described 131
icons 131
options 131
overlaying calibration curves 114
rescaling 131
zooming 131
GS1 parameter
defined 34
GS2 parameter
defined 34

H
hardware profiles
activating 57
adding devices 58
creating 54
described 54
failed activation 59
hazard symbols 18
hiding, panes 132

I
icons
Acquire mode icons 166
acquisition method icons 165
chromatograms and spectra 168
integration tab 170
Quantitate mode 171
Quantitation Wizard 170
Results Table 171
tool bar 165
Tune and Calibrate mode icons 167
importing
batches as text files 95
infusion
described 68
MS/MS optimization 68
instrument performance
prerequisites 64
required materials 64
verifying 64
integration tab icons 170
Interface Heater Temperature parameter, defined 34
ion optics path, parameters 32
ion source
optimizing ion source and gas parameters 157
preparing for compound optimization 157
IonSpray Voltage parameter, defined 33

L
LEDs, described 25
library
search with constraints 130
searching 130
linking panes 132
LIT mode, described 30
locking panes 132

M
maintenance
and performance 138
backing up API Instrument folder 63
personnel requirements 16
schedule for 138
system verification, frequency of 64
tasks, described 138
manual integration, described 107
manual optimization
described 151
prerequisites 150
mass spectrometer
access to mains supply connector 11
cleaning the surfaces 140
connections 26
disconnecting power 148
LEDs 25
panel symbols 25
parts of 24–25
returning to manufacturer 16
shutting down 46
standby mode 46
storing or shipping, preparing for 148
theory of operation 28
verifying performance 64
system
maximizing, panes 133
modes
LIT 30
modifying the system 16
moving, panes 132
MS-specific parameters, optimizing 153
MS/MS scan types, defined 83
Index

MS/MS/MS Fragmentation Time parameter, defined 37  
MS/MS/MS scan types, defined 83  
Multi-Charge Separation Barrier parameter, defined 37

N
Nebulizer Current parameter, defined 33  
Not Ready state, described 97

O
opening, data files 117  
optimizing  
MS-specific parameters 153  
optimization  
amazonic 67  
manual 151  
optimizing  
and product ions 155  
parameters, ion source 157  
the mass spectrometer 64  
organic solutions, storing 142  
organic solvents, list of 12  
orifice plate  
cleaning 145  
frequency of maintenance 139  
overlaying calibration curves 114

P
panel symbols, described 25  
panes  
deleting 132  
hiding 132  
linking 132  
links, removing 132  
locking 132  
maximizing 133  
moving 132  
tiling 133  
parameters  
instrument, ranges 159  
ion optics path, defined 32  
ion source, optimizing 157  
optimizing ion source and gas parameters 157

Paused state, described 97  
peak hopping, spectral data acquisition 85  
peak review  
calibration curves, overlaying 114  
described 107  
manually integrating peaks 111  
options dialog, opening 112  
right-click menu 112  
slide show 112  
peak review options, setting 108  
peaks  
manual integration, defined 107  
manually integrating 111  
peak review right-click menu 112  
reviewing 107  
periods  
adding 82  
generating XICs 123  
personal protective equipment, precautions 12  
plumbing  
diverter valve 50, 52  
points, excluding from a calibration curve 115  
PreRun state, described 97  
processing  
graphical data 130  
product ions, optimizing 155  
profile, spectral data acquisition 85  
projects  
API Instrument folder 62  
copying subprojects 61  
creating subprojects 61  
Default folder 62  
Example folder 62  
installed folders 62  
project list 61  
switching between projects and subprojects 61

Q
Q0 and IQ1 lens  
frequency of maintenance 139  
Q0 parameter, defined 35  
Q0 region  
cleaning 139  
Q3 Empty Time parameter, defined 37  
Q3 Entry Barrier parameter, defined 37
QJet ion guide and IQ0 lens
  frequency of maintenance 139
Quantitate mode, icons 171
quantitation methods
  applying 90
  creating 101
  defining details in the Batch Editor 93
  described 100
  revert to method 112
  tools 100
  uses 100
Quantitation Wizard
  described 100
  icons 170
  Results Tables, creating 103
quantitative analysis, described 100
quantitative data, showing 121
queries
  standard queries 104
  standard queries, creating 104
queue
  described 86
Queue Manager
  described 96
  right-click menu 98
queue options, setting 86
Queue states, described 96
Quick Quant
  described 101
rescaling graphs 131
resting the system 46
Results Summary, described 65
Results Tables
  Add Custom Column option 107
  Add Formula Column option 107
  calibration curves, generating 113
  creating 103
  described 101
  Fill Down option 107
  icons 171
  manually integrating peaks 111
  peaks, reviewing 107
  Record Modified column 111
  reports, generating 137
  right-click menu 106
reviewing
  manually integrating peaks 111
  peaks 107
roughing pump
  on/off switch 45
S
Safety Data Sheets 11
sample introduction, types of 68
samples
  changing order of 91
  navigating between samples 118
  stopping 94
  submitting 90
data files
scan techniques
  defined 83
  LIT-mode scan types 84
  quadrupole-mode scan types 83
scan types
  described 151
  LIT-mode 84
  quadrupole-mode 83
searching
  library 130
  search with constraints 130
selecting
  vial locations 92
Index

vials 90
sensitivity loss, troubleshooting 149
sensitivity, and maintenance 139
setting
  peak review options 108
  threshold options 128
Show File Information pane, right-click menu 118
Show or Hide Parameters icon 102
showing
  quantitative data 121
showing: generating
slide show peak review 112
software, status icons 98
solvents
  curtain plate staining 144
  orifice plate staining 145
source exhaust
  drain bottle, emptying 146
source exhaust drain
  frequency of maintenance 139
spectra
  extracting ions by selecting masses 125
  icons 168
  library, searching 130
  records, adding 130
  right-click menu 130
  save explore history 130
  show from a TIC 123
  XICs, generating using base peak masses 124
  XICs, generating using maximum peaks 124
  XICs, generating using selected ranges 124
Spectra Peak list, right-click menu 120
spectral data acquisition, described 85
Stand By state, described 97
standards
  statistics, generating 115
starting
  acquisition 90
  the system 45
statistics
  comparing results between batches 116
  generating 115
Statistics window, described 115
stopping, samples 94
submitting
samples 90
sets 90
subprojects
  copying 61
  creating 61
surfaces
  mass spectrometer, cleaning 140
  switch, roughing pump, location of 45
syringe pump
  adjusting the position of 47
  configuring 56, 82
system
  cleaning the surfaces 140
  connections 26
  data handling 30
  description of 24
  maintenance personnel requirements 16
  parts of 24–25
  put back into service 145
  resetting 46
  returning to manufacturer 16
  shutting down 46
  starting up 45
  status icons 98
  theory of operation 28
  troubleshooting tips 149
  use and modification 16
mass spectrometer
technical support requirements
TEM parameter, defined 34
text files
  creating from text files 94
  importing batches 95
thresholds
  adjusting 128
TIC total ion chromatograms
tiling panes 133
tips
  Batch Editor 89
  troubleshooting 149
tool bar icons 165
total ion chromatograms

6500 and 6500+ Series of Instruments
180 of 181
generating BPCs 126  y-axis 133
generating from a spectrum 123
total wavelength chromatograms, generating data 128
troubleshooting
  hardware profiles 59
  system 149
Tune and Calibrate mode, icons 167
TWC  total wavelength chromatograms

V

vacuum pressure, troubleshooting tips 149
vacuum, routine cleaning 140
ventilation requirements 13
verifying
  instrument performance 64
  mass spectrometer 64
vials
  selecting in a batch 90
  selecting positions 92
viewing
  calibration curves 113
  statistics 115

W

Waiting state, described 97
Warming up state, described 97
water, and cleaning the system 143
windows  panes
wipes, how to fold for cleaning 142

X

x-axis, zooming 133
XIC  extracted ion chromatograms
XWC  extracted wavelength chromatograms

Y

y-axis, zooming 133

Z

zooming
  graphs 131
  x-axis 133